1099 Pro, Inc.—a leader in information reporting and compliance solutions—proudly offers advanced, user-friendly software products. CRS Pro software allows a Filer/Reporting FI (defined as the unique combination of the Jurisdiction being reported to AND the associated Reporting Financial Institution) to report Account Holder information to a Reporting Country in an XML schema format to fulfill their CRS obligation. With CRS Pro users can quickly import or manually enter data, create XML files and package/encrypt files as necessary.

This help manual provides comprehensive instructions on the utilities and features of CRS Pro software.
# Table of Contents

## Ch. 1 Getting Started
- About 1099 Pro, Inc. ................................................................. 3
- Disclaimer .................................................................................. 6
- Registration & Upgrades ........................................................... 6
  - Demo Mode .............................................................................. 8
- SOC I Type II ............................................................................. 8
- System Requirements ............................................................... 8
  - Language Settings ................................................................ 8
  - Number Settings ................................................................... 9
  - Browser Requirements ......................................................... 10

## Ch. 2 Getting Help
- Quick Tour ................................................................................ 11
- Special Help ............................................................................. 12
- Support Options ....................................................................... 13
- Keyboard Shortcuts ................................................................... 14
- Tag Records ............................................................................... 14
- Software Installations ............................................................. 15
  - Single-User Installation ......................................................... 15
  - Multi-User Installations .......................................................... 16
  - Multi-User Considerations ..................................................... 17
  - Switch Users ........................................................................ 18
- Update Software ....................................................................... 18
- Uninstall Software ................................................................... 20
- Data Files .................................................................................. 20
  - Backup Data .......................................................................... 21
  - Restore Data ......................................................................... 22
  - Roll Forward Utility .............................................................. 23

## Ch. 3 Menu Bar Items
- File ............................................................................................ 24
  - Filers/Reporting FIs ................................................................. 24
    - Browse Filers ..................................................................... 24
    - Add a Filer ......................................................................... 25
    - Contact Information ......................................................... 25
    - Duplicate Filers ............................................................... 25
    - Change a Filer ..................................................................... 26
    - Delete a Filer ...................................................................... 27
    - Filer Record Details .......................................................... 27
    - GIIN Composition ............................................................ 29
  - Global Notes ........................................................................... 31
    - Update Notes ...................................................................... 31
  - Security & Administration .................................................... 32
    - Security Groups .............................................................. 33
    - Security—Step 1: Password Requirements ......................... 33

© 2018 1099 Pro, Inc.
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passwords</td>
<td>34</td>
</tr>
<tr>
<td>Security—Step 2: Access Groups</td>
<td>35</td>
</tr>
<tr>
<td>Access Rights</td>
<td>36</td>
</tr>
<tr>
<td>Tag Access Groups</td>
<td>36</td>
</tr>
<tr>
<td>Security—Step 3: Manage Profiles</td>
<td>37</td>
</tr>
<tr>
<td>Security—Step 4: Add/Update Individual Users</td>
<td>38</td>
</tr>
<tr>
<td>Security—Step 5: Add Users to a Profile</td>
<td>39</td>
</tr>
<tr>
<td>Turn On/Off Security</td>
<td>39</td>
</tr>
<tr>
<td>Security Reports</td>
<td>39</td>
</tr>
<tr>
<td>Security Access Log</td>
<td>40</td>
</tr>
<tr>
<td>Audit Trails &amp; Logging</td>
<td>40</td>
</tr>
<tr>
<td>Audit Trails Activity Report</td>
<td>40</td>
</tr>
<tr>
<td>Master Audit Trail Browser</td>
<td>41</td>
</tr>
<tr>
<td>Purge Audit Trails</td>
<td>42</td>
</tr>
<tr>
<td>Audit Trail Report Filters</td>
<td>42</td>
</tr>
<tr>
<td>Program Options</td>
<td>43</td>
</tr>
<tr>
<td>Preferences/Options</td>
<td>43</td>
</tr>
<tr>
<td>Tax Form Validations</td>
<td>44</td>
</tr>
<tr>
<td>Customize Business Rules</td>
<td>45</td>
</tr>
<tr>
<td>Reports</td>
<td>45</td>
</tr>
<tr>
<td>Unfiled Forms Summary Report</td>
<td>45</td>
</tr>
<tr>
<td>Print Preview</td>
<td>46</td>
</tr>
<tr>
<td>Form Control Totals</td>
<td>47</td>
</tr>
<tr>
<td>Troubleshooting Control Totals</td>
<td>48</td>
</tr>
<tr>
<td>Form Counts</td>
<td>48</td>
</tr>
<tr>
<td>Forms Issued By Filer</td>
<td>48</td>
</tr>
<tr>
<td>XML to Excel Report</td>
<td>49</td>
</tr>
<tr>
<td>Filer Listing Report</td>
<td>50</td>
</tr>
<tr>
<td>Forms</td>
<td>51</td>
</tr>
<tr>
<td>Create, Edit &amp; View</td>
<td>51</td>
</tr>
<tr>
<td>CRS Reference Materials</td>
<td>52</td>
</tr>
<tr>
<td>Filing</td>
<td>53</td>
</tr>
<tr>
<td>Create XML OECD</td>
<td>53</td>
</tr>
<tr>
<td>About Corrections &amp; Deletions</td>
<td>54</td>
</tr>
<tr>
<td>Utilities</td>
<td>55</td>
</tr>
<tr>
<td>Import Overview</td>
<td>55</td>
</tr>
<tr>
<td>Check/Update Error Status</td>
<td>56</td>
</tr>
<tr>
<td>Warnings and Errors Scan</td>
<td>58</td>
</tr>
<tr>
<td>Ch. 4 Task Panel</td>
<td>59</td>
</tr>
<tr>
<td>Select Filer</td>
<td>59</td>
</tr>
<tr>
<td>Reporting FI</td>
<td>59</td>
</tr>
<tr>
<td>My Filer List</td>
<td>59</td>
</tr>
<tr>
<td>Preparing My Forms</td>
<td>60</td>
</tr>
<tr>
<td>Work With My Tax Forms</td>
<td>60</td>
</tr>
<tr>
<td>Browse By Form</td>
<td>62</td>
</tr>
<tr>
<td>Entry Form</td>
<td>62</td>
</tr>
<tr>
<td>Audit Trails</td>
<td>64</td>
</tr>
<tr>
<td>Notes</td>
<td>64</td>
</tr>
<tr>
<td>Update Notes</td>
<td>65</td>
</tr>
<tr>
<td>Data Entry Preferences</td>
<td>65</td>
</tr>
</tbody>
</table>
Options for Tax Form Data Entry ........................................................................................................... 65
Protected Forms Options .......................................................................................................................... 66
Optional Field Filters ............................................................................................................................... 66
Current Sort/View ...................................................................................................................................... 67
Custom Screen View .................................................................................................................................. 67
Add/Change/Delete a Record .................................................................................................................... 68
Correct a Record ....................................................................................................................................... 69
About Corrections & Deletions .................................................................................................................... 69
Group Actions .......................................................................................................................................... 70
Query Wizard ............................................................................................................................................ 71
Form Status Values ................................................................................................................................. 71
GIIN Validation ........................................................................................................................................... 72
GIIN Composition ..................................................................................................................................... 72
Cascading Changes ................................................................................................................................. 74
Print/View Reports .................................................................................................................................... 75
Search ....................................................................................................................................................... 75
Tagging Records ....................................................................................................................................... 75

Import New CRS Forms ........................................................................................................................ 76
Import Wizard Overview .......................................................................................................................... 77
Step 1: Import Data or Filers .................................................................................................................... 78
Step 2: Validate Data .................................................................................................................................. 80
Update Import Record ............................................................................................................................. 82
Country Alias ......................................................................................................................................... 82
Step 3: Final Import - Post Results ........................................................................................................ 83
Optimize Post ........................................................................................................................................... 84

Import Files ............................................................................................................................................ 84
* SAMPLE IMPORT FILES * ....................................................................................................................... 84
Import File Conventions .......................................................................................................................... 85
Delimiters .................................................................................................................................................. 89
Error & Validation Checking .................................................................................................................... 90
Manage Maps .......................................................................................................................................... 91
Delimited or Excel Import Map Wizard .................................................................................................. 92
Map by Name Method ............................................................................................................................... 94
Drag & Drop Method ............................................................................................................................... 94
Customize Delimited Fields ................................................................................................................... 95
Maps: Import/Export ............................................................................................................................... 95
Import Map Report .................................................................................................................................... 96
Import Session Report ............................................................................................................................. 96
Reset/Void Import Session ..................................................................................................................... 96

Form Totals Report .................................................................................................................................. 97
Print Preview ............................................................................................................................................ 98

Create XML ............................................................................................................................................... 99
XML Overview .......................................................................................................................................... 99
XML File Session Window ....................................................................................................................... 99
XML Wizard .............................................................................................................................................. 100
XML Record Limits ............................................................................................................................... 101
XML to Excel ........................................................................................................................................... 102
XML Envelopes & Additional Specs .................................................................................................... 103
Reset XML Session ............................................................................................................................... 105

CRS Packager .......................................................................................................................................... 105
NIL Reports .............................................................................................................................................. 106
Country Specific Formats ....................................................................................................................... 107
Andorra Reporting Format .................................................................................................................... 107
British Virgin Islands Reporting Format ............................................................................................... 108
Ch. 5 Error Messages

Error Code 0002:0005 ................................................................. 116
Invalid Record Declaration (47) .................................................. 116
Unable to Open Required File (ProTips): 2—File Not Found .................. 116
Unable to Open Required File (ProTips): 3—Path Not Found .................. 117
Unable to Open SystemID: 2—File Not Found .............................. 117
Unable to Open SystemID: 3—Path Not Found .............................. 118
Unable to Open SystemID: 5—Access Denied ................................ 118
Unable to Open SystemID File: 53—Invalid Clarion File ...................... 118
EC002—Unable to Open Files! .................................................... 119
Error Code 0008—Can't Find Stub Locator ................................. 119
File Not Found: Information Request ......................................... 119
Could Not Load DLL Library \USER32.DLL .................................. 120
Clarion Trappable Runtime Errors ............................................. 120
Single User Version Error ....................................................... 122
Software Not Responding ...................................................... 122

Ch. 6 Additional Services

Managed Services ...................................................................... 123

Index ..................................................................................... 124
Ch. 1 Getting Started

Welcome to 1099 Pro, Inc., an industry leader in business tax software solutions!

1099 Pro, Inc. proudly offers CRS Pro to aid users in complying with the Common Reporting Standard's XML schema. The CRS was developed by the G20 and approved by the Organisation for Economic Co-operation and Development (OECD) to initiate a "global model of automatic exchange of financial account information" between jurisdictions to help regulate offshore tax evasion. CRS Pro is developed in accordance with the OECD's *Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition* and the current *Common Reporting Standard Status Message XML Schema: User Guide for Tax Administrations* (online).

**Getting Started**
We encourage users to get started now—prior to the onset of filing season. Take a [Quick-Tour](#) and familiarize yourself with the CRS Pro software interface. Download a [sample import file](#) and review [Import File Conventions](#). Stay current on OECD documentation on avoidance schemes; see [Preventing Abuse of Residence by Investment Schemes to Circumvent the CRS](#) (online).

**Getting Help**
This season CRS Pro software features improved context-sensitive help files. Click the "Help" button or <F1> key at any screen for detailed instructions. Need more help? Learn about our online video tutorials, WIKI site, fast & friendly LiveChat support and additional [support options](#) too.

**Basic Software Functionality**
- Add a Filer
- Add a Record
- Import Data
- Sample Import Files
- XML Overview
- CRS Packager
- Corrections & Deletions
- Roll Forward Data
- XML Envelopes & Additional Specifications
- Language Settings
- Number Settings
- XML Failed Schema Validation

**Addendum—READ ME**
**Corrections & Deletions**
In the course of the Automatic Exchange of Information (AEOI), users may need to correct or delete XML information previously sent to a jurisdiction. CRS Pro currently allows users to create individual corrections and deletions. An update to allow the importing of corrections/deletions and process corrections of a correction is slated for release in April 2019. See [About Corrections & Deletions](#).

**Failed Schema Log**
CRS Pro® generates an XML file even if required data is missing; however in such case, it will alert you that the generated file Failed Schema Validation. To determine why it failed, refer to the XML file and FailedSchemaLog_FilerName/Date/Time.txt file both located in your MagFiles folder. Users are encouraged to immediately reset/void the Failed XML Session and Log ID located at the XML Session Window. After resetting the sessions, users can make individual changes to forms at the Work With My Tax Forms screen and add in the missing required elements such as currCode, Individual information, Issued by, Address Info, etc.

See XML Failed Schema Validation for further details.

**How To Limit File Size**
Some receiving countries have a maximum file size they will accept; for example, Japan has a 19MB limit. CRS Pro allows users to limit the number of XML records in a file to effectively constrain the file size. Each record typically requires 0.006 MB. Thus if Japan has a 19MB limit, set the Record Limit for Japan to 3,000 records (wherein 19MB / .006MB = ~ 3,000 records). It is the user's responsibility to verify that an XML file created does not exceed the limits imposed by the Receiving Country. In some instances it may be necessary to lower the Record Limit further if files contain large volumes of Payments, Account Holders, Controlling Persons or Children.

Edit file size limits via the menu bar > File > Security & Administration > Program Options > Set XML Record Limits.

**British Virgin Islands (BVI) Specific Changes**
The BVI requires a separate XML file for each ResidentialCountryCode for the Account Holder. CRS Pro splits the XML file into separate XML files for each reportable jurisdiction. See VG Special Handling.

**Andorra Specific Changes**
Per the Andorra domestic reporting format, the Element Tags are revised as "<crs:" to "<crsad:". Additional changes are required, see Andorra Reporting Format.

**Hong Kong Considerations**
*Support for the AEOI ID for Hong Kong*
Users are prompted to enter the 7 character code when generating their XML files. NOTE: HK requires that users use their own digital certificate and the HK encryption tool to encrypt the resulting XML file. The tool requires JAVA and can be downloaded from: Download Encryption Tool (requires JAVA) https://aeoi2.ird.gov.hk/portal/tool/download/.

**Japan Considerations**
*Filer INtype*
Japan has added "JPCN" as a type of Filer Tax Identification to the INtype. CRS Pro allows users to add/create their own INtype when creating a Filer.

*Japan Formatting Requirements*
Japan XML formatting rules kick in based on the Receiving Country. Japan requires special formatting of the MessageRefID depending on the Filer INtype.
If INtype is "JPCN" (a 13 digit corporate TIN in Japan) and the Receiving Country is JP (as per the above) then the MessageRefID is constructed as per the Japanese FAQ's.

- If reporting sending/receiving country is JP, the MessageRefID must be formatted as JP+Year+JPCN +Corporation#13digits+3digitSerial#.
- If the JPCN is not available, CRS Pro reverts to the following with a GUID of 36 digits: JP+2017 +GUID(globally unique identifier of 36 alphanumeric characters)+3digitSerial#.

**Exceed Record Limits**

A standard license of CRS Pro has a 1,000 record limitation. If the limit is exceeded, a 30 second countdown is automatically triggered. The countdown increases in length with continued usage of CRS Pro and is likewise triggered when switching between different functionality within the software application. To remove the countdown please contact 1099 Pro Sales at (888) 776-1099 or go to www.1099pro.com and purchase a Bump Code to increase the number of records (or transactions) allowed in the software. Bump Codes cost $100 per 1,000 additional records.

**Additional Notes**

- To prevent duplicate filings, any record with a "Filed" status cannot be filed again. However, a filed record can be corrected and the correction can then be filed.
- If CRS Pro XML is not performing as per a country's XML special schema/specification, please contact Michael Stewart at ms@1099pro.com with the XML specification and problem.

**V. 1/17/2019**

**About 1099 Pro, Inc.**

**1099 Pro, Inc.**

Founded in 1989, 1099 Pro, Inc. is a market-leading provider of information-reporting solutions and services for 1099, W-2, 1042-S, ACA, 8966 and CRS Filers. 1099 Pro develops and markets a comprehensive range of products that enable any size business or institution to effectively manage and be compliant with IRS requirements. 1099 Pro products range from Client Server / ASP applications (capable of filing 100+ million records) utilizing an MS SQL back end with a multi-year presentation of forms via Internet Explorer, to desktop software products for filing from 20 – 100,000 forms, to eFileMyForms.com for Internet filing of < 20 forms. Adjunct products include secure Hosting and Services for information processing, printing, filing and penalty abatement. With the ever-changing IRS laws and regulations, 1099 Pro develops new services, solutions, and software enhancements, remaining ahead of the curve of the industry. 1099 Pro is a Microsoft Certified Partner; MBE certified and has received SOC I Type II certification.

**1099 Pro Software Products**

**1099 PRO PROFESSIONAL**

Professional edition offers a streamlined, cost-effective answer to your tax season. Prepares printing and paper filing for all forms in the 1098, 1099, 3921, 3922, 5498 and W-2G series. For an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

**1099 PRO ENTERPRISE**
Enterprise software is a powerful information reporting solution designed with simplicity in mind. Enterprise supports the processing, printing, and paper or electronic filing of forms from series 1098, 1099, 3921, 3922, 5498, and W-2G. Through the software users may generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1099 PRO CORPORATE SUITE
The 1099 Pro, Inc. Corporate Suite software combines the power of our Professional and Enterprise software with the speed, performance, and security of Microsoft’s SQL Server technology, making it the ultimate solution for businesses. Corporate Suite supports the processing, printing, and paper or electronic filing of forms from series 1095 (ACA Compliance), 1097, 1098, 1099, 3921, 3922, 5498, 592-B*, W-2, W-2G, 1042-S and Puerto Rico. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1042-S PRO
Prepares form 1042-S on plain paper and allows users to print recipient copies B, C, and D on one page with instructions on a separate page. Through the software users can generate a formatted transmittal file for the IRS Fire site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS.

W-2 PRO
Prepares forms W-2, W-2C, W-3 and W-3C transmittals. Supports printing to blank or preprinted forms. Through the software users can generate SSA electronic files in the EFW2 format, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

FATCA 8966 REPORTING
1099 Pro’s intuitive 8966 Pro software was designed for tax form management and IRS XML reporting. The IRS requires Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966—the FATCA report—directly to the IRS. FFIs from Model 1 countries must report to their host country who in turn transmits to the IRS. Includes the FATCA 8966 IDES Packager™.

FATCA 8966 IDES PACKAGER™
1099 Pro’s FATCA IDES Packager allows you to take a plain text Form 8966 XML file generated by 8966 Pro or any other source and compile it into an IDES compatible data archive. The IDES Packager will sign, compress and encrypt your data and save it to the directory of your choice. The FATCA IDES data preparation utility provides drag & drop functionality, certificate verification, and an output log for saving results. The FATCA IDES encrypting and packaging utility will create the sender payload file, encrypt the AES key file, create the metadata file and create the transmission data packet. The process assumes an HCTA or FFI has an IRS issued Global Intermediary Identification Number (GIIN) or FATCA Entity ID.

CRS PRO
CRS Pro® 2018

CRS Pro allows users to enter an unlimited number of Reporting Financial Institutions (Reporting FIs) into the software. Each Reporting FI can be setup to transmit to a specific receiving country (e.g., Cayman Islands) and has drop-down menus to help users select the proper CRS codes for:

- Identification Number Type (i.e., TIN / US GIIN / EIN)
- Reporting FI Name Type (e.g., OECD207 - Legal)
- Legal Address Type (e.g., OECD303 - Business)

**eFileViewer® UTILITY**
eFileViewer allows users to easily view and edit Electronic Files generated per specifications from Publications 1220, 1187, EFW2 plus most Puerto Rico filings. eFileViewer is an add-on utility and is sold and run separately from 1099 Pro software products.

**1099 Pro Service Bureau**
The 1099 Pro, Inc. Service Bureau* helps companies ease successfully through the tax season. The Service Bureau features a highly secure SOC I Type II and PCI Compliant environment, configured to process an unlimited volume of records and form types. The Service Bureau can print and mail records to your Recipients, display records online securely via the Web Presentment service, and electronically file your records with the IRS—all at highly competitive rates.

Continue reading to learn more about the services that the 1099 Pro Service Bureau offers. Using the simple upload wizard and secure FTP agent available in most 1099 Pro software products, users can easily transmit records for printing, mailing, or filing. To make sure users are taking full advantage of our information reporting solutions, we provide extensive support options.

Services include:

**IRS FILING**
We can handle any volume of records for electronic filing. An upload feature, to securely send your files directly to our Service Bureau, is built-in to every version of our software.

**PRINT + MAIL SERVICES**
Printing, mailing, and electronic delivery services are available! Our SOC I Type II Service Bureau offers a secure, efficient, and user-friendly solution.

**BULK TIN MATCHING**
The Service Bureau can transmit your file to the IRS Bulk TIN Matching Program. A transmission of up to 100,000 records is simple via the 1099 Pro software’s upload wizard and secure FTP agent.

**HOSTING**
Our hosted service provides unparalleled speed, security, and bandwidth in which to run 1099 Pro software. Learn more about our Managed Services (online).

**ELECTRONIC DELIVERY**
Give your Recipients the option to access their forms from a secure Internet site instead of receiving a mailed form. The electronic delivery option significantly reduces costs.
PRINT + MAIL PLUS WEB PRESENTMENT
The Service Bureau can make your forms available for online viewing and reprinting via our secure Internet site.

WEB PRESENTMENT ONLY
Print and mail your forms in-house and have them available to view via our secure Internet site.

PRESSURE SEAL PRINTING
Our pressure seal paper stock, for customers uploading forms for printing and mailing, adds additional security for Recipients. This eliminates the possibility for information to be viewed through an envelope window.

FULL SERVICE
Throughout the year, our regulatory team can work with your team to process your payee and payment information, imports, and balances, as well as reconcile posted information to your business areas. Additionally, we can produce all federal/state returns, act as a transmitter on your company’s behalf, and generate payee statement files, B Notices, and management reports for you.

* The Service Bureau does not print, mail or electronically file Forms 592-B, CRS or FATCA 8966.

Disclaimer

The 1099 Pro, Inc. methodology of flagging errors and warnings is merely a tool to help detect some of the possible inconsistencies or omissions in your data.

1099 Pro, Inc. does not assert that our system of detecting Errors and Warnings matches that of the IRS/SSA or that our system will detect any or all errors in your data. You may in fact have records that flag no Errors or Warnings and the IRS/SSA or other institution or agency may both reject your files and or records and assess significant penalties on the data or lack of data that you submitted or did not submit. 1099 Pro, Inc. assumes no responsibility or liability for the detection of errors, omissions, inconsistencies, warnings, formatting, accuracy or complete filing or processing of your data. This software application identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this application. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

Registration & Upgrades

Software Activation
To activate a demo version of this software, users must enter their 14-character Authorization code. Activating a demo provides access to all software features and retains existing data. Purchase the software online or contact Sales to obtain your code.

Activate Software

© 2018 1099 Pro, Inc.
1. On the menu bar select Utilities > Registration And Upgrades.
2. At the Product Registration/Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct version of the purchased software is installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation.

### Purchase an Authorization Code

<table>
<thead>
<tr>
<th></th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>New customers can go to <a href="https://www.1099pro.com/products.asp">https://www.1099pro.com/products.asp</a> to purchase software. Renewal customers can go to <a href="https://www.1099pro.com/prodRenewals.asp">https://www.1099pro.com/prodRenewals.asp</a> to renew software.</td>
</tr>
<tr>
<td>Phone</td>
<td>Call Sales toll-free at (888) 776-1099, Monday to Friday, 7AM to 5PM PST. International customers can call Sales at (818) 876-0200.</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:Sales@1099pro.com">Sales@1099pro.com</a></td>
</tr>
</tbody>
</table>

### Transaction Limits (Bump Codes)
Transactions are the number of actual tax forms that can be entered or imported—regardless of record status—into CRS Pro. A standard installation allows for 1,000 transactions. To enter additional transactions users must upgrade their software installation with a bump code. Bump codes can be purchased online at [www.1099pro.com](http://www.1099pro.com) or by contacting Sales at (888) 776-1099.

In multi-user environments, the Bump Code must be entered at the Admin or Web Update work station; this option may not be available at individual work stations (depending on access rights).

### Upgrade Transactions
1. On the menu bar select Utilities > Registration And Upgrades.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.

### How Many Transactions Do I Have?
To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. On the menu bar select Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.

---

**CRS Pro**

**OECD Edition**

Registered Copy for Tax Year 2017

**Registration:**

- **A Single User**

**Current Record Limit:** 1,000  
**Current Record Total:** 6

*In this example 6 of the 1,000 records have been used.*
Demo Mode
This software allows single-user testing in demo mode. Certain features including XML filing and packaging are only available to registered users of this product. Please purchase and register this software to activate all features; data entered in demo mode is retained when software is activated.

SOC 1 Type II
1099 Pro, Inc. prioritizes the security of customer data. Every year 1099 Pro goes through an independent SOC 1 Type II audit from an independent third party, as well as third party AVS compliance scans, to assure protection of all Personally Identifiable Information (PII). The successful confirmation and documentation of those audits and scans are available online at Independent 3rd Party Audit Results on the 1099 Pro, Inc. website. The Service Bureau does not process or file forms for CRS Pro software.

For further information please contact 1099 Pro Sales at sales@1099pro.com or the Service Bureau at sb@1099pro.com.

System Requirements

CRS Pro Software Minimum System Requirements
- Windows 7/8/8.1/10
- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 512MB RAM or more preferred
- 500+MB free hard drive space
- Video display settings of 800 x 600 (minimum) and small fonts to properly display windows and type.
- For use with ANY Windows compatible printer
- Windows compatible network (optional)
- Review Browser Requirements

Video Display & Data Input Issues
CRS Pro requires specific Language Settings and possibly Number Settings or users may experience display or data input issues. If the data on the CRS entry form continues to appear distorted or out of alignment please visit our WIKI at CRS Pro Windows Region Settings for further details on how correct your resolution and font settings.

Language Settings
This version of CRS Pro REQUIRES the following settings on your Windows® Computer:

- Control Panel > Clock, Language, and Region Set Format to English (United States) and Date and Time Formats to M/D/YYYY.
- Control Panel > Clock, Language, and Region Set Language to English (United States) for keyboard input.

Users who do not edit these settings may experience display or data input issues.
Web

Likewise edit Language to English (United States)

See CRS Pro Windows Region Settings on the WIKI.

**Number Settings**

CRS Pro users using European money formats may need to customize number settings on their Windows® Computer. **Users who do not edit these settings may experience errors in their**
XML file with overstated payments and balances by 100 times too much; for example, "123.45" may be reported as "12345".

To Edit Numbers
1. In Windows 10 go to Control Panel > Region.
2. At the Format screen select "Additional Settings" to display the Customize Format screen (see image).
3. Users must edit fields in the Numbers tab to reflect a period, ".", for the Decimal symbol and a comma, ",", for the Digit grouping symbol.

See CRS Pro Windows Region Settings on our WIKI for more information.

Browser Requirements
Increased User Security
Effective 6/15/2018, www.1099pro.com exclusively supports TLS 1.1 or higher enabled Internet browsers.

What is TLS?
Transport Layer Security (TLS) is a protocol that provides privacy and data integrity between two applications.
Why This Is Good For You
This change strengthens the 1099 Pro Service Bureau and software products by requiring that a more secure method of encryption is used to transmit your credit card, account information and tax form data between your computer, the 1099 Pro website, and 1099 Pro Service Bureau.

TLS V1.1 Compatible Browsers
Google Chrome—V22 or higher
Mozilla Firefox—V27 or higher
Microsoft Internet Explorer—V11 or higher
Microsoft Internet Explorer Mobile—V11 or higher
Microsoft Edge—All Versions
Opera—V12.18 or higher
Apple Safari—V7 or higher
Apple Safari (mobile)—V6
Click here to see which browser and version number you are currently using: https://www.whatismybrowser.com.

What If You Are NOT Using a Compatible Browser?
You must use a TLS V1.1 compatible browser to access the 1099 Pro website and/or transmit files to the 1099 Pro Service Bureau via our software or FTP. If you are using an older, incompatible browser we strongly encourage you to contact your IT team and upgrade ASAP!

More information on TLS is available from the PCI Security Standards Council.

Ch. 2 Getting Help

Quick Tour
All 1099 Pro software products feature an intuitive, user-friendly interface. Context-sensitive help is available at any screen via the <F1> key.

User Interface
Menu Bar
The menu bar is located horizontally at the top of the screen, underneath the software title bar. The menu bar contains drop-down menus for File, Reports, Forms, IRS, Utilities and Help. Use the <Alt> key and the underlined letter of any menu bar item to access a drop menu, e.g., ALT + U to access "Utilities".

Task Panel
The task panel is the vertical blue bar on the left side of the software screen which provides quick access to common tasks. The task panel is composed of expandable sections including: Reporting FI, Preparing My Forms, Create XML, Utilities and Help & Extras.

Current Filer
The currently selected Filer is displayed above the task panel; use the "Select Another Filer" button to change selections.

Special Help
Some wizard screens include a "?" button for quick access to special help topics. This button typically offers more detailed information than what is available via the standard "Help" button or <F1> key.
Support Options

All 1099 Pro, Inc. software products include context-sensitive help screens—accessible via the "Help" button and/or <F1> key—at every screen. Additional support including immediate, email and phone options are available. Technical support is limited to questions regarding 1099 Pro, Inc.’s software products. We are NOT authorized to provide accounting, tax or legal advice. Please direct such questions to your accountant or attorney.

Immediate Support Options

- Online Video Tutorials including CRS Imports (3 minutes) and CRS Tutorial (12 minutes) and more!
- Review User Error Messages
- TLS Browser Security Requirements
- WIKI Documentation:
  - Software Downloads and Updates, too!
  - Import Field Specifications

Email Support Options

Email support is available during Office Hours. Corporate Suite users should directly email their designated Account Manager. Please ensure that our emails are white-listed and go to your inbox.

- Online LiveChat Support
- Software Technical Support: support@1099pro.com
- Sales Support: sales@1099pro.com

Phone Support Options

If the above options do not resolve your issues, contact Technical Support by phone during Office Hours. Calls are limited during tax season.

In order for us to best assist you please:
- Provide your Customer ID number (located on your invoice) or company name.
- Be seated at your computer with software open.
- Have a list of steps taken prior to the issue or question.
- Provide any error messages that you have encountered.

<table>
<thead>
<tr>
<th>Technical Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>(888) 776-1099 (toll-free)</td>
</tr>
<tr>
<td>(818) 876-0200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1099 Pro, Inc. Office Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regular Hours</strong></td>
</tr>
<tr>
<td>Monday to Friday: 7AM to 5PM PST</td>
</tr>
<tr>
<td>Saturday: Closed</td>
</tr>
<tr>
<td>Sunday: Closed</td>
</tr>
</tbody>
</table>

IRS Telephone Assistance: Information Reporting Support
For IRS specific questions about Forms 1096, 1098, 1099, 5498, W-2G and W-3, please call the IRS at (866) 455-7438 (toll-free) or (304) 263-8700 (not toll-free). For TTY/TDD equipment, call (304) 267-3367. The call site can also be reached via email at mccirp@irs.gov.

**IRS General Support**

For other tax information related to business returns or accounts, call (800) 829-4933 or visit the IRS website.

**Keyboard Shortcuts**

CRS Pro software includes keyboard shortcuts to increase user efficiency.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ALT&gt;</td>
<td>At any screen or drop menu hold and press the &lt;ALT&gt; key to view underlined characters indicating a shortcut. Then use &lt;ALT&gt; and the underlined letter to access the screen or menu. For example, on the menu bar use &lt;ALT&gt; + F to access &quot;File&quot; or &lt;ALT&gt; + U to access &quot;Utilities&quot;.</td>
</tr>
<tr>
<td>&lt;F1&gt;</td>
<td>Access context-sensitive help topics at any screen.</td>
</tr>
<tr>
<td>&lt;F2&gt; or right-click mouse</td>
<td>With your cursor in the appropriate box, use the &lt;F2&gt; key or right-click your mouse to access box specific data.</td>
</tr>
<tr>
<td>Incremental Index (or Search)</td>
<td>Access any Filer via the Search Name field.</td>
</tr>
<tr>
<td>Drop Menus</td>
<td>Right-click your mouse to view additional record options. This is available at the Filers List and Work With My Tax Forms screens only.</td>
</tr>
</tbody>
</table>

**Tag Records**

All 1099 Pro software products include "tag" buttons to select individual records or ALL records. The "tag" buttons are available at various screens. An item is tagged or selected when a red or green check appears to the left of the item as illustrated below.
Tag Key Functions

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>&lt;ALT&gt; + T</td>
<td>Select individual records.</td>
</tr>
<tr>
<td>Tag All</td>
<td>&lt;ALT&gt; + A</td>
<td>Select ALL records.</td>
</tr>
<tr>
<td>Untag</td>
<td>&lt;ALT&gt; + U</td>
<td>Deselect individual records.</td>
</tr>
<tr>
<td>Untag All</td>
<td>---</td>
<td>Deselect ALL records.</td>
</tr>
<tr>
<td>Flip</td>
<td>&lt;ALT&gt; + F</td>
<td>Reverse the selection of individual records.</td>
</tr>
<tr>
<td>Flip All</td>
<td>&lt;ALT&gt; + L</td>
<td>Reverse the selection of ALL records.</td>
</tr>
<tr>
<td>Prev Tag</td>
<td>&lt;ALT&gt; + P</td>
<td>Scroll backwards through selected records.</td>
</tr>
<tr>
<td>Next Tag</td>
<td>&lt;ALT&gt; + N</td>
<td>Scroll forwards through selected records.</td>
</tr>
</tbody>
</table>

Software Installations

All 1099 Pro, Inc. software products are available in single, multi-user or unlimited-user licenses. The algorithm of your Authorization Code indicates the edition, user license and number of transactions purchased.

See Single-User Installations, Multi-User Installations, Multi-User Considerations and Demo Mode.

Single-User Installation

Download any 1099 Pro, Inc. software product at http://host.1099pro.com. All software installations are two-step and require both the Full Install and the most recent Update.
Caution—AV Programs
Users are encourage to disable all anti-virus programs (e.g., Norton, McAfee, ViruScan, Sophos, etc.) prior to software download and installation to avoid potential corruption. Random software errors are typically due to the installation of software while running an AV program. After a successful installation, re-enable the virus checker.

Install Single-User (or Demo) via Internet Download
2. The executable file will auto-run after download.
3. Click "Next" to start the setup program.
4. Follow the instructions provided by the setup program. The Roll Forward Utility initiates if prior year data is located on your system.

Install Single-User (or Demo) via CD-ROM
1. Insert the CD-ROM into your computer’s CD-ROM drive.
2. On your Windows desktop click the "Start" button and select "Run".
3. In the Open field, type $x:\setup.exe$, where $x$ is the name of the CD-ROM drive and setup.exe is the name of the executable.
4. Click "OK" to start the setup program.
5. Follow the instructions provided by the setup program. The Roll Forward Utility initiates if prior year data is located on your system.

Multi-User Installations
For Multi-user installations, CRS Pro® software requires that one machine be designated as a Server and all others as Workstations. The Server can be any Windows® machine on the network or having a local or remote drive accessible by all computers that will function as Workstations. The Server installation must be performed prior to any Workstation installation.

Server Installation:
1. Determine the network computer, drive and folder in which to install your software. All Workstations must have full rights to this folder.
2. Install your software on the network computer to be designated as the Server. Enter your Multi-User Activation Code when prompted. Select Server Installation as the Install Type. Allow the program files to reside on the local or remote drive.
3. After successfully installing your software to the network, click on the CRS Pro® icon on your desktop. The Getting Started Wizard will walk you through setting up the software. By default, Audit Trails are enabled and Security is disabled.*
4. After completing the Getting Started Wizard, re-launch your software.
5. Administrator Password — For their intial logon, Administrators should enable Security* and use "Administrator" for their User ID and the Password "NEW" (must be in all caps).
6. The Administrator should create Users and assign rights prior to installing CRS Pro® on Workstations.

*Administrators are encouraged to enable Security. If Security is disabled, ANY USER on ANY WORKSTATION can access your software and View/Modify Administrator settings and all data. This
includes the potential for ANYONE to create himself as Administrator and lock you out of the software.

**Workstation Installation:**
1. Open the Server installation and set security On or Off before proceeding.
2. Complete Server installation prior to installing Workstation(s).
3. Locate the Server installation drive and folder from the Workstation. To map the Server installation’s network drive from a Workstation, open Windows Explorer from each Workstation. Locate the network drive, right click your mouse and select Map Network Drive. Each installation will refer to this drive as the Global Data Path.
5. Select Workstation Installation as the Install Type. Browse for the network drive and folder of the Server installation (e.g., X:\1099 Pro\ProCRST18\ where “X” is the mapped Network Drive). Allow the program files to reside on the local drive (e.g., C:\1099 Pro\ProCRST18).
6. If the Administrator enabled Security, then the Workstation is deemed a “user.”
7. **New User Password**— The first time a new User opens the software at their Workstation, they must enter their User ID (as assigned by the Administrator) and the Password “NEW” (must be in all caps). The User is then required to create a unique password.

**INI Files**
CRS Pro software uses a local .INI file to store the data path of your remote data. If your software install was done under a different account with a drive letter mapping, then that same path will need to be mapped with the same drive letter. For example: If the Administrator of the computer has the remote drive as "L:" and the User has the mapped drive as "K:" then the user will be unable to access the data.

See [Multi-User Considerations](#)

**Multi-User Considerations**
When running a multi-user version of CRS Pro software, some tasks require exclusive control of certain files. These tasks are detailed below.

**Record Locking**
The multi-user version of this software utilizes record locking when two or more users concurrently open the same record. This allows users to simultaneously view the same record but prevents them from overriding each other's changes. For example, Users A and B open the same record. User A changes an amount and saves the record. User B then changes an amount and attempts to save the record. User B receives a "Record Was Not Updated" warning and the record is automatically updated with User A's changes. User B may then select a field to restore and use the <F4> key to re-populate the originally entered value.

**Import Locking**
During the final step of the Import Wizard—Post Import Session—the software attempts to gain control of all records. If the software is unable to gain control of a record (because someone else has
Unlock Records
1. On the menu bar go File > Security and Administration.
2. In the "Business Rules and Options" section, click on "Browse System Process Locks".
3. Highlight User and click "Delete/Remove the Selected Lock".

Switch Users
Logging in as a Different User
When running CRS Pro software in a multi-user configuration, it is possible to switch users without fully closing the software. Follow the steps below to log in as a different user.

IMPORTANT: First close all top level screens in CRS Pro; "Logon as Different User" is only available when the following window is displayed at the main screen:

Switch User Logon
1. On the menu bar select File > Logon as Different User.
2. At the CRS Pro logon screen, enter the User ID and Password.
3. Click "OK".

Verify the currently signed in user by referring to the bottom right corner of the screen.

Update Software
1099 Pro, Inc. regularly publishes software updates to keep up with the evolving rules and regulations of the IRS, SSA, state agencies and other appropriate entities. To ensure your compliance, frequently check for software updates. By default, the software checks for updates occasionally during the summer, more frequently as tax season approaches and every day at the height of tax
Users are strongly encouraged to take advantage of this process; an active Internet connection is required.

Users can verify they are running the most up-to-date version of our software:
- When starting any version of the software, a pop-up prompts to run a software update, OR
- Perform a Manual Update (as discussed below), OR
- Visit our WIKI download site at host.1099pro.com

**Perform Updates**
There are two methods to manually check for software updates.

**Method 1**
1. On the menu bar select Help > Check for Updates.
2. Use the "Check for Updates" button to run an update. Your computer must have an active Internet connection.

**Method 2**
1. Close the CRS Pro software.
2. Use the Windows Start button to locate your CRS Pro software product and select "Check for Updates" to initiate the Web Update Wizard.
3. Follow the prompts by clicking "Next". If there is a new version, a message displays the version number and provides a brief summary of items included in the update. Download the update and allow the update to install. This process should begin automatically.
4. After the process is finished, confirm that the new version number of the software corresponds with the version number of the update by opening your CRS Pro software product and on the menu bar select Help > About.

Users experiencing issues downloading updates may have a firewall on their network or local machine preventing them from retrieving updates. Check with your Administrator, IT personnel or temporarily disable the firewall.

All updates are available for download at the 1099 Pro WIKI site host.1099pro.com.

**Update Options**
Users can modify the frequency and/or type of software updates performed. To edit these settings see Preferences.

**Considerations:**
- If an installation of this software has Security enabled, the User must have Administrator level access to modify the Checking for Updates options.
- For multi-user installations only the Server (not the Workstations) can view and modify the Checking for Updates option.
- **Workstations cannot run the actual web update process;** they can only check for new versions. Once your Server has been updated, each workstation automatically updates itself the next time this software is run on that machine.
Uninstall Software
The Select Uninstall Method screen offers two options for removing CRS Pro from your hard drive:
- "Custom" allows the user to select files individually (recommended).
- "Automatic" initiates a default uninstall routine.

Uninstall CRS Pro (Custom)
1. Close all applications including CRS Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "CRS Pro 2018" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Custom" and then click the "Next" button to start the uninstall program.
6. Files are categorized for deletion. Users may "Select All" (recommended), "Select None" or use their mouse to select specific files. Categories include:
   - System Files
   - Directories
   - INI Files
   - INI Entries
   - Registration Database Keys
7. After selecting appropriate files click "Finish" to complete the uninstall.

Uninstall CRS Pro (Automatic)
The Automatic uninstall process retains your current data files under the main program directory in the Data folder and miscellaneous .DLL files are left in the Program root directory used by the software. In addition the .INI file is also preserved in the Admin or Windows directory.

1. Close all applications including CRS Pro.
2. On your Windows desktop click the "Start" button.
3. Go to "Settings", "Control Panel" and select "Add/Remove Programs".
4. Select "CRS Pro" and click the "Add/Remove" button.
5. At the Select Uninstall Method screen choose "Automatic" and then click the "Next" button to start the uninstall program.
6. CRS Pro prompts you through the remainder of the uninstall routine.

NOTE: Users who uninstall CRS Pro and then reinstall it may get an “Invalid Record Declaration (47) Accessing TAXDATA.TPS [or FILERS.TPS]. Press OK to end this application” warning. This error occurs because some files were not deleted during the automatic uninstall. Users must perform a custom uninstall of CRS Pro (and select all files for deletion) and then reinstall the software.

Data Files
CRS Pro software data files are suffixed with ".TPS" and are logically named. For example, "Filers.tps" contains Filer data and "Country.tps" contains country specific data. These files are located in the Data folder and in a typical installation can be found at C:\1099 Pro\ProCRST18\Data. See Backup Data

INI File
The ProCRST18.INI file contains information specific to your installation such as data paths and version. For example:

NetPath=C:\1099 Pro\ProCRST18
LocalPath=C:\1099 Pro\ProCRST18
InstallVersion=2018.08.16
CurrentVersion=2018.16.05

**INI File Folder Locations**

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default INI File Location</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS Pro</td>
<td>C:\1099 Pro\ProCRST18\Admin</td>
<td>ProCRST18.INI</td>
</tr>
<tr>
<td>Corporate Suite</td>
<td>Contact your in-house Administrator or assigned CS Account Manager for assistance.</td>
<td></td>
</tr>
</tbody>
</table>

The ProCRST18.INI file may or may not be deleted during a custom uninstall. This file can be manually deleted to totally remove software from your system or to perform a clean re-installation. This file can remain if a user wants to reinstall the software but retain their settings.

**The ProNTS.INI File**

Do not edit this file unless directed to do so by Tech Support.

**Backup Data**

CRS Pro backups can automatically copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. **It is smart to backup your data on a regular basis.** If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense! See [Restore Data](#).

**Modify Backup**

1. On the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their in-house software Administrator.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.

3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
   - Deselect the checkbox to disable backup prompts (not recommended).

**Backup Data**

Access the Backup Wizard as automatically prompted by CRS Pro software (see Modify Backup above). The Backup Wizard application, **Backup18.EXE**, can also be accessed directly through File Explorer. Prior to running the backup all users must exit the software.
1. At the Backup Wizard screen click "Next" to proceed.

2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file or use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name. Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. Backup twice to the same file name and the existing backup file will be overwritten!

3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.

4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at www.winzip.com.

### Data Backup Folder Locations

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default Data Backup Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS Pro</td>
<td>C:\1099 Pro\ProCRST18\Data Backups</td>
</tr>
<tr>
<td>Corporate Suite</td>
<td>Contact your in-house Administrator or assigned CS Account Manager for assistance.</td>
</tr>
</tbody>
</table>

### Restore Data

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. Restoring a data file means losing ALL changes made since the last backup. See Backup Wizard.

#### Restore Data

1. Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the [1099 Pro Wiki](http://1099prowiki.com). Download the appropriate Tax Year. Contact Technical Support with questions.

2. Locate your .ZIP backup file (e.g., "CRS Pro Backup 9-AUG-2017 9-38AM.ZIP") which in a standard installation is located in the Data Backups folder (i.e., C:\1099 Pro\ProCRST18\Data Backups). in your Data Backups folder.

3. Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file — .TPS (data) files—to your Data folder. Learn more about WinZip.

4. Open your software and run a Form Counts by Filer report to verify accuracy of restored data.

5. After successfully restoring your data, update your software to its most recent version.
Roll Forward Utility

CRS Pro software allows users to roll forward prior year Filer/Reporting FI information (including name, TIN and address) and optionally Security settings and customized Import Maps. Rolled forward Filer data is available at the Filer Master List screen for viewing or changes.

NOTE: The roll forward utility does not copy 2017 tax form specific information such as dollar amounts into the new 2018 installation. For example, a 2017 tax form can only be accessed in the 2017 version of our software. The exception is Corporate Suite—a multi-year software product.

Select Filers AFTER Roll Forward

- Select Filers: Use the "Select Another Filer" button, located at the top of the task panel, to switch between Filers.

How To Roll Forward Data

Users can roll forward their prior year data during the Installation Wizard or from the Windows Start Menu > CRS Pro> Roll 2017 Data to 2018 Software. The roll forward utility is unavailable if any Filer data has already been added into the 2018 software; perform the roll forward PRIOR to entering or importing any data into the software. To perform a roll forward AFTER adding data, users must uninstall the 2018 software and then perform a fresh installation.

Roll Forward data option available through initial Installation Wizard. Available roll forward options vary by software product.
Ch. 3 Menu Bar Items

File

Filers/Reporting FIs

Browse Filers

*Did you know?* The terms Filer and Reporting Financial Institution (FI) are sometimes used interchangeably. Use the Filer Master List screen to add, change, delete and view Filers. Use the Select Filer button to quickly jump between existing Filers.

**Filer/Reporting FI Overview**

Access the Filer Master List screen via the menu bar > Filer List. This screen displays ALL Filers OR sort them by default options or create a custom query.

- Unlimited Filers are allowed.
- All CRS Pro software products accept multiple Filers with one TIN. This is useful for companies issuing forms from multiple departments or for batch processors. See [Create a Duplicate Filer](#).
- CRS Pro software allows US, Canadian and foreign Filers.
- [Filer Record Details](#) provides a thorough explanation on each Filer specific field.

**Viewing Options**

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort Filers by Filer Name, TIN or PCode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all Filers are displayed. Users can display a subset of Filers via the &quot;Current Query&quot; drop menu and select a readymade query or create their own custom query, e.g. &quot;Address Type Code = Other Foreign&quot;, etc.</td>
</tr>
</tbody>
</table>

**Onscreen Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual Filers. Unlimited Filers are allowed. See <a href="#">Add a Filer</a></td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit a Filer. Cascading updates are applied to all existing records in the software with a &quot;Pending&quot; status; records with any other status are locked and will not reflect Filer updates. See <a href="#">Change a Filer</a> and Cascading Updates</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Use to delete any Filer with no associated records; if any records are associated with the Filer (including deleted records) the Filer is locked and cannot be deleted. See <a href="#">Delete a Filer</a></td>
</tr>
<tr>
<td>&quot;Run Filer Report&quot;</td>
<td>This report provides detailed information on a selected Filer including Name, TIN, Contact Information, Country Codes and a history of any</td>
</tr>
</tbody>
</table>

See [File Not Found: Information Request Error](#)
Add a Filer

CRS Pro allows users to create XML in the Common Reporting Standard for an Entity (sometimes referred to as a Reporting FI) for transmission to a Country (sometimes called a Jurisdiction). CRS Pro refers to the combination of a Reporting FI and the Country to report to as a FILER. CRS Pro allows unlimited Filers.

ALL data in each FILER is reported to only one Country/Jurisdiction in the XML Report. When submitting an XML file for one Reporting FI for a Jurisdiction, the information in your XML file may be shared appropriately with other countries as per the Automatic Exchange Portal's Activated Exchange Relationships.

Add a Filer/Reporting FI

1. From the menu bar select File > Filers.
2. At the Filer Master List screen click "Add".
   - Review detailed Payer Code specifications. Users typically enter an abbreviated, descriptive Filer name in this field. For example, use "DE_ABC" to represent the German branch of ABC Bank and "FR_ABC" to represent the French branch. Use the Receiving Country Code as the first two characters of the Payer Code to make the XML reporting process more organized.
3. At the Adding a Filer Record screen complete all fields and click "OK" to save the Filer.

See Filer Record Details for a thorough explanation on all entry fields.

Contact Information

At the Filer Record screen add or edit a Contact Person, Department and Phone Number. This contact information documents who has responsibility for this Filer / Reporting FI. At least one contact is required.

Add/Edit Contacts

1. On the menu bar select File > Filers List.
2. At the Filer Master List screen highlight a Filer and click the "Change" button.
3. At the Filer Record screen (General tab) use the "Add", "Change" or "Delete" buttons as appropriate.
   - Dept. Code—The Filer's internal reference such as AP, Sales, HR, LA Office, NY Office, etc. A maximum of 15 characters is allowed.
   - Default—Only one contact may be selected as default.
   - Use the "Save" button to save changes or "Cancel" to abort changes and exit.

Duplicate Filers

Users can duplicate a Filer to isolate data by Region, Department, Date, User, etc. Some users may need to isolate revised data as directed by 1099 Pro Technical Support. Use the Payer Code (PCodes) field to differentiate—and thus isolate—otherwise identical Filer data. Payer Codes (PCodes) are internal reference values, visible in the software only. See Filer Record Details.
Create a Duplicate Filer
1. On the menu bar select File > Filers List.
2. At the Filer Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields identically to the original Filer.
4. Payer Code (PCode) field: Users typically enter an abbreviated, descriptive Filer name in this field. For example, use "DE_ABC" to represent the German branch of ABC Bank and "FR_ABC" to represent the French branch. Users are encouraged to always use the Receiving Country Code as the first two characters of the Payer Code to make the XML reporting process more organized.
   - When creating a duplicate Filer, amend the newly created payer code with "REV" (revisions), "CORR" (corrections), "JOHN" (user), etc. to make it easier to sort Filer data; for example, "DE_ABC_REV", "DE_ABC_CORR" or "DE_ABC_JOHN".
   - The payer code field accepts a maximum of 15 alpha numeric characters.
5. Click "OK" to save the Filer.

When importing or uploading data users have the ability to view and select Filers by Payer Code (see Image).

Change a Filer
Changes made to a Filer only apply to records with a Pending status. To switch between existing Filers use the Select Another Filer button.

Change a Filer
1. From the menu bar select File > Filers.
2. At the Filer Master List screen click "Change".
3. At the Changing a Filer Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new filer information. Click "Yes" to update filer or "Cancel" to abort changes and exit the screen.

See Filer Record Details for a thorough explanation of each entry field.
Delete a Filer
A Filer can only be deleted if it is NOT associated with any CRS records.

Delete a Filer
1. From the menu bar select File > Filers List.
2. At the Filer Master List screen highlight the filer and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the Filer or "No" to cancel.

Filer Record Details
A "Filer" is the unique combination of the Jurisdiction (or country) being reported to AND the associated Reporting Financial Institution (or entity). A Filer contains information for only one Jurisdiction and one Reporting FI. For example, if ABC Bank has physical branches in Germany (DE) and France (FR), create one Filer ABC Bank to report DE based accounts to DE and a second Filer ABC Bank to report FR based accounts to FR. **The key to differentiating Filers is the required Payer Code field.**

Access the Filer Record Details screen via the menu bar > File > Filers List > highlight Filer and select the "Add" or "Change" buttons.

Fields in **RED** are required.

**General Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiving Country</td>
<td>The country (or Jurisdiction) receiving the account holder data.</td>
<td></td>
</tr>
<tr>
<td>Transmitting Country</td>
<td>The country (or Jurisdiction) sending the account holder data.</td>
<td></td>
</tr>
<tr>
<td>Filer Identification Numbers (INs)</td>
<td>The Filer/Reporting FI's (Financial Institution) identification number can be a US GIIN, TIN, company registration number, Global Entity Identification Number or other similar identifying number specified by the tax administration. Additional identification numbers can be added if necessary.</td>
<td>11</td>
</tr>
<tr>
<td>Payer Code</td>
<td>Users typically enter an abbreviated, descriptive Filer name in this field. For example, use &quot;DE_ABC&quot; to represent the German branch of ABC Bank and &quot;FR_ABC&quot; to represent the French branch. <strong>Use the Receiving Country Code as the first two characters of the Payer Code to make the XML reporting process more organized.</strong>&lt;br&gt;- PCodes must be unique, if an already in use PCode is entered, the software prompts to create a new one.&lt;br&gt;- If the PCode contains any of the following characters, /:*&quot;&lt;&gt;</td>
<td>#, they are stripped from the XML file name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Max Characters</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• PCodes are alpha-numeric and visible in the software only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Typically, security and the return address settings are unique for each PCode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• See Duplicate Filers.</td>
<td></td>
</tr>
</tbody>
</table>

| Filer Name                | The Filer/Reporting FI’s legal name.                                                                                                                                                                            | 40             |
| Name Type Code            | The Name Type code corresponds with the Filer and is an optional field.                                                                                                                                         | 40             |

<table>
<thead>
<tr>
<th><strong>Contact Information</strong></th>
<th><strong>Description</strong></th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Use the &quot;Add&quot; button to add a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records (change contacts at the Adding a Form Record screen via the &quot;Dept&quot; button). <strong>At least one contact is required.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Department</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Contact Title</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Contact Name: The individual to contact with questions regarding the generated XML files.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Phone: The phone number to call for questions regarding the XML file.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>This information is passed through in the <code>&lt;crs:Contact&gt;</code> XML element.</em></td>
<td></td>
</tr>
</tbody>
</table>

| Prefix Override           | The default prefix for a Filer’s XML file name is composed of the Sending Country Code + Year for the Data + Receiving Country Code. Thus, if France sends data to Germany for TY 2016, the default prefix would be FR2016DE. |                |
|                           | Some jurisdictions may have unique XML specifications such as requiring the FI Identification Number in the file name field. If an XML file name must start with a different character string enter it in this field and indicate if it should be used for the FileName, MessageRefID and/or DocRefID fields. |                |

| NIL Reporting Only        | Select the "Filer is used ONLY for NIL reporting" box for those Filers who have reviewed their client data and determined there is no data to report. For details see "Subparagraph C(17) Excluded Account" in the OECD's Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition. **Only NIL Filers can create a NIL Report.** | 1              |
|                           | This box is not available for selection when editing a Filer with existing data.                                                                                                                              |                |
CRS Pro® 2018

Field | Description | Max Characters
--- | --- | ---
Notes / Has Notes | Enter notes specific to a Filer/Pcode for reference purposes. Indicates if notes are present for this Filer. | 512

### Address Information Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>ResCountry Code(s)</td>
<td></td>
<td>40</td>
</tr>
</tbody>
</table>

**Filer Address Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Country Code</strong></td>
<td>Select 2 character code.</td>
</tr>
<tr>
<td>Legal Address Type</td>
<td>Options include Residential or Business, Residential, Business, Registered Office and Unspecified</td>
</tr>
<tr>
<td>Street</td>
<td></td>
</tr>
<tr>
<td>Building ID / Suite ID / Floor ID</td>
<td></td>
</tr>
<tr>
<td>District Name</td>
<td></td>
</tr>
<tr>
<td>POB</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>Country Sub Entity</td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td>15</td>
</tr>
</tbody>
</table>

### GIIN Composition

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI’s jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI’s FATCA Registration is submitted and approved.

Enter a Filer/Reporting FI's GIIN at the Add a Filer screen, also see Select a GIIN screen.

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI’s online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly
generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI’s FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN.

The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

**Global Intermediary Identification Number (GIIN) Composition Format:**

**XXXXXX.XXXXX.XX.XXX**

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>Characters</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>FATCA ID (first six characters)</td>
<td>6</td>
<td>1-6</td>
<td>Alphanumeric upper case only. For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID, for members; this is just the first six characters. <em>Note: The first six characters of any Financial Institution’s FATCA ID are randomly generated and will never use the letter “O”.</em></td>
</tr>
<tr>
<td>Separator 1</td>
<td>1</td>
<td>7</td>
<td>Period = .</td>
</tr>
<tr>
<td>Financial Institution Type</td>
<td>5</td>
<td>8-12</td>
<td>Alphanumeric upper case only. Lead = 00000 Sponsoring Entity = 00000 Single = 99999 Member = Same as the last 5 characters of the Member’s FATCA ID (sequential, starting from 00001 and going to 99998, then A0000 – ZZZZZ; will never use the letter “O”)*</td>
</tr>
<tr>
<td>Separator 2</td>
<td>1</td>
<td>13</td>
<td>Period = .</td>
</tr>
<tr>
<td>Category Code</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only. Based on Financial Institution or Branch category LE = Lead SL = Single ME = Member</td>
</tr>
<tr>
<td>Character Representation</td>
<td>Characters</td>
<td>Position</td>
<td>Description / Rules</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------</td>
<td>----------</td>
<td>---------------------</td>
</tr>
<tr>
<td>BR = Branch (the first thirteen characters of a branch’s GIIN will match the first thirteen characters of the GIIN of the Financial Institution with which the branch is associated)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SP = Sponsoring Entity</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Separator 3</td>
<td>1</td>
<td>16</td>
<td>Period = .</td>
</tr>
<tr>
<td>XXX Country Identifier</td>
<td>3</td>
<td>17-19</td>
<td>Numeric ISO 3166-1 numeric standard country code of the Financial Institution or branch. Note: Use 999 for country code “Other”.</td>
</tr>
</tbody>
</table>

**Global Notes**

Users can add notes to individual CRS forms and Filer records. Notes can contain up to 512 characters and unlimited notes are allowed. Every time a note is created or updated, the note displays the date and time of the action and either the User ID of the person who made the change (assuming Security is enabled) or the network name/ID of the machine where the change was made.

Depending on the type of note, users can view and update them from multiple places within the software. At a CRS data entry screen, if there are any notes associated with the Filer or the specific tax form the "Notes" button changes to "Has Notes".

**Global Notes**

Global notes are visible everywhere within the program, these notes can be viewed and updated from every Notes browse. Users can also enter these notes directly from the main File menu via the "Global Notes" option.

**Filer Notes**

Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Filer, you can also view/update all Global notes.

**Tax Form Notes**

This type of note is attached to one specific CRS record. When entering notes for a record, you can also view/update the notes for the Filer of the form, as well as view/update all Global notes.

**Update Notes**

This screen allows users to add or modify notes. Please see [Browse Notes/Attachments](#) for all available note types.
Security & Administration
Access the Global Administrative Options screen via the menu bar > File > Security and Administration. Only Administrators and select Users can access these options.

Security Options
Through the use of settings and rights Administrators can restrict Users and thereby help protect sensitive company data. See Security Overview. Use the "Security Groups" button to access the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn Security On/Off</td>
<td>CRS Pro offers two levels of security; on and off. If security is enabled, access to CRS Pro is limited to Users with valid User ID/Password combinations. These Users are restricted to specific tasks assigned by the Administrator. This provides a twofold method of protecting sensitive company data.</td>
</tr>
<tr>
<td>Add/Update Individual Users</td>
<td>Administrators can use the Add/Update Individual Users screen to create Users and assign them to specific tasks.</td>
</tr>
<tr>
<td>Access Groups and User Profiles</td>
<td>Create new Access Groups and User Profiles based on the user’s custom settings. Your groups will be available when adding or changing a User and are included in all security reports.</td>
</tr>
<tr>
<td>Passwords</td>
<td>Passwords can help protect sensitive company data.</td>
</tr>
<tr>
<td>Security Access Logs</td>
<td>The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all logon attempts.</td>
</tr>
<tr>
<td>Security Reports</td>
<td>CRS Pro offers numerous reports to track users and access groups. These security reports are available only to Administrators or Users with administrative rights.</td>
</tr>
</tbody>
</table>

Tax Form Audit Trail and Action Logging Options
Audit trails allow Administrators or Users with administrative access to track changes and actions taken on tax forms. Use the "Audit Trails & Logging" button to access the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Audit Trail Records</td>
<td>Use this button to access the Master Audit Trail Browser and view both manual and cascading updates to all tax forms. Use the Record History screen to view audit trails for individual tax forms.</td>
</tr>
<tr>
<td>Print TINCheck Activity Report</td>
<td>Use to view a report of all TINCheck requests and results associated with an individual record. This utility is not available in CRS Pro, W-2 Pro and 8966 Pro software products.</td>
</tr>
<tr>
<td>Purge Excess Log Records</td>
<td>The Audit Trail Record Log is invaluable for tracking tax forms changes. If the log becomes so large that the performance of this software is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.</td>
</tr>
</tbody>
</table>
**Business Rules and Options**

Review and modify overall program options and settings. Use the "Program Options" button to access the following items.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preference, Update and</td>
<td>Configure many of the software general settings such as date range warning, update checking and backup reminders.</td>
</tr>
<tr>
<td>Program Options</td>
<td></td>
</tr>
<tr>
<td>Tax Form Validation</td>
<td>Adjust settings to configure the warning and error messages displayed when importing or manually entering forms.</td>
</tr>
<tr>
<td>Configure TINCheck Account</td>
<td>Users with active TINCheck accounts can associate their account with this software and perform instant TIN Validations when adding or changing a tax form. <em>This utility is not available in CRS Pro, W-2 Pro and 8966 Pro software products.</em></td>
</tr>
<tr>
<td>Set XML Record Limits</td>
<td>Limit the number of XML records in a file to effectively constrain the file size.</td>
</tr>
</tbody>
</table>

**Security Groups**

Administrators and select Users can access Security settings via the menu bar > File > Security and Administration > "Security Groups" button. See [Global Administrative Options](#).

**Security Overview**

Step 1: Password Requirements  
Step 2: Access Groups  
Step 3: Manage Profiles  
Step 4: Add/Update Individual Users  
Step 5: Add Users to a Profile

**Security—Step 1: Password Requirements**

The Security Preferences/Password requirements area allows Administrators to configure details regarding User passwords including: password length, lockout settings, expiration and password format. Learn about [First Time Login Password](#).

**Set Password Requirements**

1. To configure password and login requirements click the "Set Password Requirements" button.

2. At the Modify System Security Settings window, configure the following settings:
   a. Login Type: (Corporate Suite Only)
   b. Minimum Password Length: Defines the minimum character length the password can be; range is from 5-15 characters
c. Lock a User ID after this many invalid login attempts: Sets the maximum number of times a User can fail to login before needing to have their account unlocked by an Administrator.
d. Days before a password expires: Sets the length of time a User’s password is valid before they must choose a new one.
e. Days to warn a user before their password expires: Defines when the software will start notifying the User that their password is going to expire.
f. Times before a password can be used again: Defines how many different passwords must be used before a User can use the same password again.
g. Ignore case when validating Passwords ['e' = 'E']: Determines whether or not case matters when a User is entering their password. (Corporate Suite Only)
h. Require at least One (1) Uppercase Character: Determines whether or not there must be at least one uppercase character in a User’s password.
i. Require at least One (1) Lowercase Character: Determines whether or not there must be at least one lowercase character in a User’s password.
j. Require at least One (1) Numeric Character: Determines whether or not there must be at least one numeric character in a User’s password.
k. Require Special Characters in Password: Determines whether or not special characters (i.e., !, @, #, $, %, ^, etc.) are required in a User’s password. Admin must specify which special characters are allowed before enabling this option (see "l" below).
l. Special Characters (Up to 15): Define special characters which may be used during password creation.


Passwords
Passwords help protect sensitive data. Learn about Setting Password Requirements.

First Time Login
If security is enabled via the Welcome Wizard, the Administrator must create a new password the first time they log into CRS Pro.

1. In the User ID field enter Administrator; in the Password field enter NEW (must be all caps).
2. Click "OK".
3. The Login screen requires the Admin to enter a new password.
   - Passwords must be at least 6 characters.
   - Passwords are case sensitive.
   - Password cannot be "NEW"
4. After successfully creating a password, Administrators are encouraged to create Users.

Reset User Password
I lost my password! If a User forgets their password the Administrator can reset it.

1. On the menu bar select File > Security & Administration.
2. At the Administration screen click "Security Groups" and "Add/Update individual Users".
3. At the Browse & Update the List of Users screen select the User whose password needs to be reset and click "Change".
4. At the Changing a User screen click the "Reset" button. The password is automatically reset to **NEW** (must be all caps). The next time the User logs into CRS Pro they are required to change the password.

If the Administrator forgets their password they must contact Technical Support. The purchaser of 1099 Pro must send a request on company letterhead stating that the Administrator password is lost and an unlock code is required. Upon receipt of this request, Technical Support can provide an unlock code good for that day only.

**Security—Step 2: Access Groups**

Access Groups allow an Administrator to define the Program Areas and Form types that a User will have access to, as well as their level of access. Users only have the rights specifically assigned to them; any rights not assigned are denied by default. The rights available within CRS Pro software include: View/Access area, Create, Modify, Delete, Report, Correct, Print, and Reset/Void where applicable.

**Assign Access Groups**


2. At the Security Options screen click the "Create and Manage Access Groups" button to access the Access Groups screen.

3. Click “Add” to open the Update Access Groups screen and create a new access group. Admin can also select “Change” or “Delete” to modify any existing access groups or to view the contents of a built in Access Group.
   - This software includes multiple built-in access groups (indicated in **BLUE**) that cannot be modified or deleted.

4. At the Update Access Groups screen enter a Group Name.

5. Use the "Tag" button to select the Program Areas to include in this group.

6. After selecting each item, use the "Modify Highlighted Record" button to assign rights within this area. If a Program Area is selected (or "tagged") but no rights are assigned to it, a “View Only” access rule is created. This allows assigned users to enter/view an area only; they will NOT be allowed to edit or save changes.

7. After selecting all Forms and/or Program Areas AND assigning rights, Administrators can add detailed Notes for the Access Group. Click “Save Changes to Group” to return to the Update Access Groups screen.

8. At this point the Admin can "Add", "Change" or "Delete" other Access Groups as necessary; excluding 1099 Pro's built-in access groups. When finished click “Close” to return to the Security Options screen.

9. Continue to [Security—Step 3: Manage Profiles](#)
Access Rights
When creating or modifying an Access Group, Administrators select the Form(s) and/or Program Area(s) to include and must also assign a level of access rights. By default, NO access rights are preset. If a Program Area or Form type is selected (or “tagged”) but no rights are assigned to it, a “View Only” access rule is created. This allows assigned users to enter/view an area or form only; they will NOT be allowed to edit or save changes.

Assign Access Rights
1. At the Update Access Groups screen, highlight any selected Form or Program Area and click the “Modify Highlighted Record” button.
2. At the Modify Access Rights screen Admin can "Select ALL Rights" or individually select rights. Options include:
   - Create new items or initiate processes
   - Modify exiting items
   - Delete existing items
   - Run Reports in this area
   - Items that are grayed out are unavailable for selection.
3. Click "Save" to return to Update Access Groups.

Tag Access Groups
At the Tag Access Groups screen, Administrators can assign access groups to Users; thus restricting a User’s access to a selected Filer(s) and permissions within that Filer. For example, an Administrator may assign to User "John Doe", access to Filers "ABC Company" and "123 Company", but only for select tasks. User "Jane Doe" however, has access to the same Filers but with "Tax Forms (Full Rights)".


Assign Access Groups
1. On the menu bar select Filers > Security and Administration.
2. At the Global Administrative Options screen select "Security Groups".
3. At the Security Options screen select "Create and Manage User Profiles for Filers and Access Groups".
4. At the User Profiles screen click the "Add" button.
5. At the Update User Profile screen enter a Profile Name for the user.
   - Profile names must be unique and contain a minimum of four characters.
6. Tag (or select) the Filer(s) this user can access. Highlight Filers individually and click the "Assign Access Group(s) to Highlighted Record" button.
7. At the Tag Access Groups screen tag access groups to assign to the user profiles (see Step 2: Creating and Managing Access Groups). Click the "Save" button to save changes and exit this screen.
   - Use the "Show Tagged" button to display only the Access Groups assigned to this user profile.
   - **If there are multiple Filers assigned to the user profile, the above steps 5 - 6 must be repeated separately for each Filer.**

8. After assigning Access Group rights to all Filers associated with the User Profile, click the "Save Changes To Group" button at the Update User Profile Screen. This newly created User Profile is displayed at the User Profile screen and is available for future changes, deletion or cloning.

**Security—Step 3: Manage Profiles**

User Profiles allow Administrators to apply Access Groups to specific Filers/Departments. When assigning a User to this profile (Step 4), the User only has the specific rights granted by that Access Group to the specified Filers. CRS Pro’s built-in User Profiles are applied to ALL Filers. In order to access the CRS Pro system, a User must have rights to AT LEAST one Filer, in other words, they must be assigned to at least one User Profile.

The below diagram illustrates the components comprising a User Profile. In Step 4 the users are assigned to the profiles.

---

**Set User Profiles**

1. To create or manage a User Profile click "Create and Manage User Profiles for Filers and Access Groups" from within the Security Options window. CRS Pro includes built-in User Profiles. Built-in groups are indicated in **BLUE** and cannot be modified or edited. **By default, all built-in User Profiles have access to ALL current and future Filers.**

2. Click "Add" to create a new user profile or select "Change" to modify any existing User Profiles. The "Quick Assign" button walks users through these steps in a wizard. Use the "Clone Profile" button to clone a previously created profile and then edit the Filers and Access Groups assigned to it.
3. After clicking "Add", "Change" or "Clone Profile" the Update User Profile screen opens. At this screen assign Access groups to Filers.

4. Create or update a User profile:
   A. Create a name for the User profile.
   B. Tag (or select) the Filers to allow access to.
   C. Highlight the Filer to configure and click the "Assign Access Groups" button to attach Access Groups that were previously created to the profiles.
   D. At the Tag Access Group screen select the previously created profiles (Step 2).
   E. After selecting profiles click "Save" to exit. Repeat Steps C, D and E for each Filer in this profile.

5. Upon exiting the Update User Profile screen return to the User Profiles screen where Admin can continue to add, change or delete profiles. After updating profiles click "Close" to return to the Security Options window.


Security—Step 4: Add/Update Individual Users
There is typically one assigned User for each physical user of the software. This section assists in the creating, updating, and deleting of Users. Remember, built-in accounts cannot be modified or deleted; however they can be copied and then modified.

Set Individual Users
1. To configure Users, click on "Add/Update Individual Users" at the Security Options screen.

2. The Users screen displays all current users in the software. Use the "Add User" button to add a new user and the "Change" button to modify an existing User or view their associated profiles. The "Delete" button removes Users from the system.

3. Click the "Add User" button to open the Adding a User window where Admin creates the login information required for the new User to access the software (or Change User in the case of clicking the "Change" button). Define User Login Settings:
   - **User ID**—Enter a User ID (User Name) for software login.
   - **Password**—By default, all new Users are assigned NEW (all caps) as their password—this cannot be changed at this screen. To set the user requirements for password see Security Password Requirements.
   - **Lock Status**—Indicates if a user account is locked due to login failures. Click "Change" to lock or unlock an account. The Admin can reset the password as necessary.
   - **Pre-W2K Domain (Corporate Suite only)**—This is only used when Active Directory Login type is selected by clicking “Set Security Preferences” on the “Security Options” screen.
   - **Optional Information includes:**
     - User Name—User's full name; this information does not impact login credentials.
     - Phone—User’s contact phone number.
     - Other Info—Add other information such as user’s department, e-mail address, location, etc.
User Profile Membership—This field displays all of the User Profiles associated with the User.

4. Continue to Security—Step 5: Add Users to a Profile

**Security—Step 5: Add Users to a Profile**

This final step in configuring security guides Admin through the process of assigning a User to a profile created during Step 3: Manage Profiles.

**Assign Users to Profiles**

1. Click on the "Add/Remove Users from Profiles" button located on the Security Options window.

2. At the Security—Assign Users screen assign newly created Users to a profile.

3. Select the profile to add Users to via the “Available User Profiles” drop menu.

4. Tag the Users to apply to the selected profile. Click "Save" prior to adding Users to another profile.
   - To tag a User highlight the user and click the “Tag” button or click in the column to the left of their UserID.

**Turn On/Off Security**

**Activate Security**


2. At the Security Options screen the Security status is displayed as ON or OFF.

3. If security is OFF (or not enabled) click the "Activate Security" button to enable it.

4. Restart the program for settings to take effect.

**Security Reports**

CRS Pro software includes reports to track Users, User Profiles, and Access Groups. These security reports are available only to Administrators or Users with administrative rights.

**Security Reports**

1. On the menu bar select File > Security and Administration.

2. At the Administration screen click the "View/Print Security Reports" button. Available reports include:
   - Print Users by Name: Lists all users sorted by User ID.
   - Users and Attached Profiles: Lists all access users and all of their associated User Profiles.
   - Access Group Detail: Lists Access Groups and all of the permissions assigned to them.
   - Detailed Security Report: Summarizes the User Profiles and Access Groups selected Users are assigned to.
   - Security Log: Generates a report based on the security audit trail.

3. All reports offer a print preview option.
Security Access Log
The Security Access Log tracks every instance that Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all log-on attempts.

Browse & Manage the Security Access Log
1099 Pro includes predefined queries for sorting access log records including:
- All Records: Default selection that displays all records.
- Access for One Date: Select this query and then enter the date for which you want to show logs.
- Access for One User: Select this query and then click "Select User to Show" to pick a user, or click "Show Records with No Users" for any records with an unknown user.

Export Log-on Records to Excel Spreadsheet
The Security Access Log tracks all attempts to open CRS Pro. This log can be exported for review in an Excel document.

1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. Click on "Export to XML" located near the bottom left.
4. Select your destination folder and click "OK"

Purge Log-on Records
The Security Access Log tracks all attempts to open CRS Pro. If the log becomes so big that the performance of CRS Pro is compromised, older records may be purged. When purging records ONLY successful logons are deleted.

Purge Records
1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. At the Browse & Manage the Security Access Log screen click the "Purge Log-on Records" button.
4. The Purge Audit History screen allows the user to indicate the date PRIOR to which log-on records are purged. Modify this date as necessary.
5. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort. All purge attempts are permanently recorded in the log.

Audit Trails & Logging

Audit Trails Activity Report
Audit trails track certain activities related to a Tax Form or Filer Record including Created, Viewed, Deleted and any Quick-Prints or ASCII Exports. Audit trails detail the Date/Time and User ID associated with the activity.

Run Audit Trails Report
Administrators and Users with permissions can generate reports of all audit trail activity related to one or more areas in CRS Pro software.
2. At the Tax Form Audit Trail and Action Logging Options screen click the "View/Print Audit Changes Report" button.
3. Set Audit Trail Filters and click "OK" to generate report.

Run Record Specific Audit Trails Report
Users with permissions can view all activity related to a specific record; for example, all activity on a TY 2018 record issued to Account Holder ABC.

1. At the Work With My Tax Forms screen select the record to review.
2. Click the "Change" button to open the Changing a Form screen.
   • If record has a Filed status, click the "View the Form" button at the Protected Form Update screen to continue to the Viewing a Form screen.
3. Click the "History" button to view the record history.
4. Click the "Print Current Changes Report" button and select "Yes" to preview the report.

Audit Trails Report Legend
• T = TIN (Tax ID Number)
• N = Name
• A = Account
• D = Filer Department
• Subtype: Audit report tool doesn’t know what was done with the record.
• TransType: Audit report tool doesn’t know what was changed on any transactions.

Master Audit Trail Browser
Audit Trails track certain activities related to a Tax Form, Recipient Record or Filer Record including Created, Viewed, Deleted and any Quick-Prints or ASCII Exports and more. Audit trails detail the Date/Time and User ID associated with the activity. Audit trails do NOT track cascading updates.

Master Audit Trail Browser
The Master Audit Trail Browser is available only to Administrators or Users with permissions. Use it to view all manual changes to ALL tax forms (the Record History screen allows the viewing of individual tax forms only). From this browse screen users can run an Audit Trails Activity Report and view highly detailed audit trail information.

2. At the Tax Form Audit Trail and Action Logging Options screen click the "View Audit Trail Records" button.
3. Specify Audit Trail Filters otherwise the report can be very large and slow to generate. Click "OK" to continue.

About Record History
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record; cascading updates are not reflected. See Record History for more information.
**Purging Audit Trail Logs**

The Audit Trail Record Log is invaluable should you need to track tax forms changes. If the log becomes so big that the performance of this software is compromised, older records can be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system. See Purging Audit Trail Logs[42] for more information.

**Disable Audit Trails**

Only Corporate Suite allows the disabling of Audit Trails.

**Purge Audit Trails**

The Audit Trail Record Log is an invaluable tool for tracking tax forms changes. If the log becomes so big that the performance of CRS Pro is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.

*Purging is not available in CRS Pro software.*

**Audit Trail Report Filters**

It is important to set Audit Trail Filters, otherwise generated reports and/or the Master Audit Trail Browse screen can be very large and slow to generate.

**Set Filters**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit Report to Changes for Form Type:</td>
<td>N/A</td>
</tr>
</tbody>
</table>
| Limit Report to Changes for one PCode (payer code) | All Filers
· One Filer |
| Limit Report to Changes from one User ID or Workstation | All Users
· One User
· One Workstation |
| Limit Reports to a Date Range | None
· Today or Yesterday
· Last 7 Days, Last 14 Days or Last 30 Days
· Specify Other Range—Set the date range for this report. If the range is too large, the report may be *very slow to generate.* |
| Record Activity Options | All Activity
· All But Views
· Only Deleted |
Program Options
Preferences/Options
CRS Pro software allows Users to customize the program via Preferences. Any User with access to Security and Administration can modify these settings. Changes made at the Preferences screen are UNIVERSAL to the program; they are not user-specific. In multi-user environments Administrators can restrict user access to this area by setting permissions within Access Groups.

Modify Preferences
1. On the menu bar select File > Security & Administration > Program Options.

2. At the Business Rules & Options screen click the "Preference, Update and Program Options" button to access the Preferences screen.

3. The Preferences screen includes General and Checking for Updates tabs. Many items are checked "on" by default with the objective of safeguarding user data. Functions can be set ON/OFF at the user's discretion by inserting or removing a check in the corresponding box.

4. Changes go into effect AFTER clicking "OK" and then exiting and re-opening the software.

Preference Settings
Many Preference settings are "ON" by default with the objective of safeguarding user data.

GENERAL/GENERAL MORE Tabs

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Options</td>
<td>Auto capitalize names, addresses and localities during manual entry.</td>
</tr>
<tr>
<td>Backing Up Data Files</td>
<td>Remind me to backup every X days. Users are strongly encouraged to backup data on a regular basis. To backup once per day enter &quot;1&quot;, every two days enter &quot;2&quot;, etc. Set to zero to backup every time the program is exited. Administrators are strongly encouraged to create backup copies of data on a regular, if not daily, basis. IRS regulations require tax data to be maintained by Filers for five years.</td>
</tr>
</tbody>
</table>
| Global Date Range Checking* | Warn if dates entered on forms are outside of this range. Set dates are within the respective tax year. Dates may be modified by clicking the ellipses buttons.  
- Date is before 1/01/2018 (default entry), OR  
- Date is after 12/31/2018 (default entry) |
| Options for Manually DELETED Tax Forms | Allow previously deleted tax forms to be visible at the Work With My Tax Form screen.  
- Allow users to undelete previously deleted tax forms. Available in Corporate Suite only. |
| Recipient Address ZIP Code/City Options | Convert City to UPPER case during manual entry ZIP lookups  
- Always convert Recipient City to UPPER case during printing |
<p>| Other Options | Automatically reselect the last Filer at program start |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Show a reminder when using &quot;Add Recipient&quot;</td>
</tr>
<tr>
<td>Task Menu Display</td>
<td>• N/A</td>
</tr>
</tbody>
</table>

**CHECKING FOR UPDATES Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask for Confirmation Every Time Checkbox</td>
<td>• Ask for confirmation every time before checking for updates. Only deselect this box if your Internet connection is always on. When an update is available, users are always prompted prior to download/installation, regardless of the status of this box.</td>
</tr>
</tbody>
</table>
| How Often Should Program Check for Updates? | • Automatic Adjustment (recommended)—The program will check for updates occasionally during summer, more frequently as tax season approaches and every day at the height of tax season.  
• Specified Interval (1 - 45 days) Throughout the Year—Checks will occur at the interval specified here.  
• Manual Checking Only—Not recommended. |

See [Software Updates](#) 18

**Tax Form Validations**

CRS Pro software includes standard rules for detecting errors and/or warnings on tax forms such as invalid TINs, ZIP codes plus OECD/FATCA rules that govern how boxes should be completed. Users can change existing validation rules as outlined below and create custom validation rules at any time.

**IMPORTANT:** Business rules are in place to provide Users with the highest likelihood of their data being accepted by OECD associated government entities. Users who disable a rule to process their forms have a higher risk of their data being rejected.

**Deactivate (Turn-Off) Rules**

1. On the menu bar go to File > Security and Administration > Program Options > Tax Form Validation for Import and Entry to access the Manage Business Rules/Validation screen.

2. The Manage Business Rules/Validation screen summarizes the rules for a particular form and indicates if the rule is active, where the rule is applied and the severity.
   - Column "DT/Imp/Web" indicates where the rule is applied. **DT** = Manual Data Entry, **Imp** = Imports and **Web** = Web/Internet Module Users.
   - Error message severity is indicated by **W** = Warning (non-fatal), **E** = Error (may be error) and **R** = Reject (form will not be imported or saved).

3. To disable a rule, uncheck the "Rule is active/applied" box and click the "Save" button. Rules can be reactivated at any time.
   - To customize or edit a rule highlight it and click "Change" to access the [Rule Will Be Changed](#) screen.
Customize Business Rules

See Business Rules/Validations

Customize/Override Default Business Rule Messages
1. On the menu bar go to File > Security and Administration > Program Options > Tax Form Validation for Import and Entry to access the Manage Business Rules/Validation screen.

2. The Manage Business Rules/Validation screen summarizes the rules for a particular form and indicates if the rule is active, where the rule is active and the severity.
   - Column "DT/Imp/Web" indicates where the rule is applied. **DT** = Manual Data Entry, **Imp** = Imports and **Web** = Web/Internet Module Users.
   - Error message severity is indicated by **W** = Warning (non-fatal), **E** = Error (may be error) and **R** = Reject (form will not be imported or saved).

3. Highlight a rule and click "Change" to access the The Rule Will Be Changed screen.

4. Refer to the Customize/Override the Default Messages windows. Options include:
   - Change Manual Entry Severity and Import Severity to either "Use Default", "OK", "Warning", "Error", or "Reject".
   - Add a short error message to display when records with this forms particular rules are broken
   - Add a long message to display when records with this forms particular rules are broken. If necessary add a longer error message in the "Full error message" text box.
   - Use the "Suggestion How to Fix" field to provide guidance to your internal users.

5. Click "Save" to apply changes and return to the Manage Business Rules/Validation screen.
   - To apply Business Rules/Validation changes to existing forms, go to the menu bar > Utilities > Check/Update Error Status for all forms.

Reports

Unfiled Forms Summary Report

New for TY 2018 — The Unfiled Forms Summary report details "Filed" or "Not Filed" status for all records. This report is a great resource to ensure that no records are accidentally overlooked during the filing season. See Filing Status—Am I Done?

Unfiled Forms Summary Report
1. On the menu bar select Reports > Unfiled Forms Summary Report.
2. Click "Yes" to preview the report.
Print Preview

The Preview screen allows users to view a report and check it for accuracy before printing.

Print Preview Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print this page only.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>View the previous page.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>View the next page.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Toggle stay after printing.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Search for characters within a report.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Access the &quot;Print Setup&quot; screen to print the entire report.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Exit the preview report without printing.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>View the preview report in full width view.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>View the preview report in full height view.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Save report in PDF format.</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| ![148](icon) | Set zoom percentage; range is 25 to 250%.

**Duplex Printing**

All 1099 Pro software products support duplex printing. Not all printers or print drivers offer this feature; review the printer manual for specifications.

**Duplex Print**

1. At the Print Preview screen initiate a print session via the "Printer" icon.
2. At the Select Printer Screen, click the "Properties" button for your printer.
3. Click the Finishing tab, then locate the area "Document Options" on this screen.
4. Place a check in the box to "Print on both sides".
5. Click "OK" and proceed to print the job.

**Form Control Totals**

The Control Totals report is an invaluable tool for reviewing Account Holder records and pinpointing Errors and Warnings. Information contained in this report includes:

- Filer/Reporting FI's Name, TIN and PCode
- Account Holder's Name, TIN, Account Number and Address
- Individual record print status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

**Run Control Totals Report**

1. Use the "Select Another Filer" button to choose the Filer/Reporting FI to generate report for.
2. On the menu bar select Reports > Form Control Totals.
3. At the View/Print Control Totals Report screen select a printer. Consider printing to PDF to save paper.
4. Report Filter and Form Selection Options—Choose a method for selecting records:
   - All Pending Originals for this Filer
   - All forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)
5. Error and Warning Messages—Choose how to print warnings and/or errors. This option is only available if Extended Version is selected under Report Format Options, below.
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors
6. Report Record Ordering Options—Choose how to sort the records:
   - By Last Name
   - By TIN
   - By Account Number, then Last Name

7. Report Format Options—Choose a report format:
   - Summary Version (amounts only, no address, text or error/warning detail)
   - Extended Version (all form details including address and errors/warnings)
   - Additional options include:
     - Add custom notes for this report run
     - Print totals only (suppress individual form details)
     - Print preview

8. To generate report click "Print Now".
   - At the preview screen go to the last page to view box-by-box totals.

**Troubleshooting Control Totals**

On occasion users may experience difficulty generating a Control Totals report due to setting incorrect parameters. Verify the following:
- The correct Filer/Reporting FI is selected.
- A valid Report Filter and Form Selection Option was chosen. For example, if "All Pending Forms" is selected and there are no pending forms, then no report will generate.

If no information matches the set parameters the Control Totals Report will not generate.

**Form Counts**

The Form Counts Report generates a listing of all forms sorted by Filer/Reporting FI, detailed by Status. The end of the report tallies form totals for errors and/or warnings, original and corrected forms. This report is very useful for tracking the status of forms and determining if records contain any errors or warnings.

**Run Form Counts Report**
1. On the menu bar select Reports > Form Counts.
2. Click "Yes" to preview the report.

**Forms Issued By Filer**

The Summary of Forms Issued by Filer provides detailed Account Holder information for all forms issued by the selected Filer(s).

**Run Report**
1. On the menu bar select Reports > All Forms Issued by Selected Filer.
2. Click "Yes" to preview the report.
3. At the Browse the Filers File screen click the "Tag" button to select Filers. A red check appears beside each tagged Filer. To sort Filers prior to tagging, use the View drop menu.
   - Review **Tag Key Shortcuts**
4. After tagging appropriate Filers click "Proceed" to run the summary.

**XML to Excel Report**

Use Microsoft Excel® to analyze Test or Production XML files created in CRS Pro. See [Generate XML Files](#).

**Review ALL Information**

To view ALL of the information in your XML file in an Excel® spreadsheet, open a blank spreadsheet in Excel and drag the .XML file onto the blank spreadsheet. Wait a few seconds until the Open XML popup displays (as shown below) and choose to open the file "As an XML Table".

The spreadsheet with your XML data will include a lot of duplicate information; consider deleting all of the columns to the left of Column AD (DocRefid3) EXCEPT Columns C, D and N which (i.e., TransmittingCountry, ReceivingCountry and FilerName). In the Column AccountNumber are many blank rows. All of the data associated with this AccountNumber is located to the right of the AccountNumber column on this row and the following blank rows. Data for the next account number starts when you see a new AccountNumber similar to the below image.

**Review Balance and Payment Information**

Customized Excel file for opening an XML file to review balance and payment information.
1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST18\Maps) open CRS_Pro_TY2018_Payments_And_Balance.xlsx.
2. From the Excel menu bar click Developer > Import. If the Developer tab is not visible see Show Developer Tab below.
3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST18\MagFiles). Double-click on the .XML file.
4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.

Comprehensive XML Review
Customized Excel file for opening an XML file to review detailed, comprehensive information.

1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST18\Maps) open CRS_Pro_TY2018_Comprehensive.xlsx.
2. From the Excel menu bar click Developer > Import. If the Developer tab is not visible see Show Developer Tab below.
3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST18\MagFiles). Double-click on the .XML file.
4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.

Show Excel Developer Tab (If Not Visible)
If the Developer tab is not displayed in the top ribbon of Excel, use the following instructions from the Microsoft Support website.

In Excel 2010, 2013 and 2016:
1. Click File > Options.
2. Click the Customize Ribbon category.
3. Under Main Tabs, check the Developer box, and click "OK".

In Excel 2007:
1. Click the Microsoft Office Button > Excel Options.
2. Click the Popular category.
3. Under Top options for working with Excel, check the Show Developer tab in the Ribbon box, and click "OK".

Filer Listing Report
The Filer/Reporting FI Listing provides detailed Filer specific information including Name, TIN, Contact Information, Country ID Numbers and a history of any address changes. All Filers are automatically included in the report. To view a report of all records issued to individual account holders see Summary of Forms Issued by Filer

Filer Listing Report
1. On the menu bar select File > Filers List.
2. At the Filer/Employer/Payer Master List screen select "Run Filer Report".
3. The Administrator prompts to "Print One Filer Per Page" and preview the report. Select as appropriate.

Forms
Create, Edit & View
The Work With My Tax Forms screen serves as the primary place to view, edit and track Account Holder records. Users are encouraged to familiarize themselves with it now—prior to the onset of filing season.

Work With My Tax Forms Overview
Access the Work With My Tax Forms screen via the Preparing My Forms task panel > Work With My Tax Forms. The Work With My Tax Forms screen allows users to view ALL CRS records, sort them by default options or create a custom query. From this screen users can Add, Change and Delete individual records plus initiate Group Actions.

Viewing Options

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort forms by Last Name/Company, TIN, Account or by creating a custom view [67] See Current Sort/View Order [67] for further details. Scroll through results with the mouse or the keyboard UP/DOWN arrow keys.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all forms—regardless of status—are displayed. Users can display a subset of the forms via the &quot;Current Query&quot; drop menu and select a prebuilt query, e.g. &quot;Pending Original Forms Only&quot; or &quot;Corrections (Not Filed)&quot; or create their own custom query, e.g. &quot;Country Code is equal to ES&quot;, etc. See Custom Query Wizard [77] Note: The &quot;Status&quot; of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported—one with a Pending status and the other a Filed XML status—the displayed forms can be limited by their respective status.</td>
</tr>
<tr>
<td>Status Column</td>
<td>This column indicates an individual record's position in the filing cycle and is an invaluable reference tool. A record’s Status is directly tied to its position in the filing cycle. See Status Overview Please see Filing Status—Am I Done? [100] An asterisk appended to a status indicates that the record contains errors and/or warnings [56]. For example, Pending* or Mag Filed*.</td>
</tr>
</tbody>
</table>

Onscreen Buttons

| "Add" | Use to manually add individual records; most users prefer to import their records. CRS Pro software allows records to be added (either manually or via import) up to the user's current transaction limit. Transactions range from 1,000 in a standard purchase to an unlimited number of transactions. |
### Menu Bar Items

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit any record with a Pending status; records with any other status are &quot;protected&quot; (locked) and cannot be changed. See Protected Forms Options screen and Correct a Record. Cascading updates are changes made to a Filer’s information globally throughout all tax forms.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Forms with a Filed Mag status are available for deletion. Records must be individually deleted. Previously filed, deleted records, must be submitted to the appropriate agency as a &quot;Deletion of Data&quot; XML file.</td>
</tr>
<tr>
<td>&quot;Browse by Form&quot;</td>
<td>The &quot;Browse by Form&quot; button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as when using the standard browse. For example, if when viewing the list of forms in Last Name/Company order, with a Query to only show forms that contain Notes, those settings remain in effect when switching to Browse by Form mode.</td>
</tr>
<tr>
<td>&quot;Group Actions&quot;</td>
<td>Use to tag (or select) a number of records and perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of Pending forms allows you to manually select any number of Pending forms for removal. All associated notes for the forms are likewise deleted.</td>
</tr>
<tr>
<td>&quot;Print/View Report&quot;</td>
<td>This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).</td>
</tr>
<tr>
<td>&quot;Custom Report&quot;</td>
<td>Use to create and save Custom Query reports. Visibility to these reports can be limited by User by the Administrator.</td>
</tr>
</tbody>
</table>

### CRS Reference Materials

Direct links to the below documents are accessible via the menu bar > Forms > CRS Reference Materials. An active Internet connection is required.

#### Publications

- [FAQ's Collection Efforts, Account Holder Research and Definitions](#)
- [Foreign Tax Identification Numbers (TINs)](#)
- [High Level Overview of Common Reporting Standards (CRS)](#)
- [OECDActivated Exchange Relationships for CRS Information](#)
Filing

Create XML OECD

This wizard simplifies the process of creating Original, Corrected, Deleted and Test XML files.

**IMPORTANT:** Special characters are prohibited in XML file generation. The apostrophe (’), double dash (---), quotation mark ("), and hash (#) symbols are prohibited as they can be used in security threats and will cause the transmission to be rejected with a failed threat detection error notification. Replacing the characters with an entity reference will still cause a rejection.

Generate XML Files

1. On the task panel select Create XML > XML OECD.
2. At the Create the OECD XML File screen click the "Create an OECD XML File" button.
3. At the XML Wizard screen review important onscreen information and click "Next" to continue. Click "Back" at any time to go back a step.
4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Select Filer/Reporting FIs to include via the "Tag" buttons or manually select the Filers to include in this XML file.
6. Specify the File Type and Transmission Medium:
   - New Data
   - New TEST Data: Select test data (not production data) under a dummy Filer. Test data is marked as "filed".
   - Corrected Data: Select records with a Corr/Pending status
   - Corrected TEST Data
   - Deletion of Data: Select records with a Del/Pending status
   - Deletion of TEST Data
7. Select the destination folder. Default location is C:\1099 Pro\ProCRST18\MagFiles.
   - File naming convention is TransmittingCC:YYYY:ReceivingCC:_PayerCode_TypeOfData_SessionID_TimeStamp.XML.
   - If the Filer/Reporting FI’s PCode contains any of the following characters, \\ : * " < > |#, they are stripped from the XML file name.
   - Some Jurisdictions have specific naming conventions.
8. Set Reporting Period: The default period is the last day of the tax year being reported. Any date within the Tax Year installation of CRS Pro can be selected. For example, in a CRS Pro 2018 installation, only 2018 Reporting Periods are allowed. Click "Next" to continue.
9. At the Ready to Generate XML File(s) screen review settings and if satisfied click "Finish" to start the XML file generation.
10. The Progress screen tracks your Electronic File Generation Process and indicates total files created. Click "OK" to exit this screen.
11. Return to the Completed XML screen and view XML file specific information.
   - If the XML failed schema the file name is prefixed with "FailedSchema", see XML Failed Schema Validation Wizard.
• the Filer/Reporting FI's PCode contains any of the following characters, / : * " < > | #, they are stripped from the XML file name.
• Click the "Visit the OECD Site" button for direct access to the Automatic Exchange Portal (AEP).

About Corrections & Deletions
In the course of the Automatic Exchange of Information (AEOI), users may need to correct or delete XML information previously sent to a jurisdiction. The AEOI format allows users to send Original, Corrected or Deleted data, but always as separate XML files.

NOTE: Data can only be corrected or deleted if it was originally generated from CRS Pro as the corrected/deleted data requires reference to the original DocRefId of the account report being changed.

What is a Correction?
CRS Pro allows users to correct previously filed data ASSUMING the original XML data was submitted via CRS Pro. New data that was overlooked in prior filings is not a correction (it is considered a late original).

What is a Deletion?
CRS Pro allows users to delete previously filed data ASSUMING the original XML data was submitted via CRS Pro.

How Does It Work?
At the Work With My Tax Forms screen double-click on any form with a "Filed Mag" status to access the Protected Form Update screen. Then click on the "Correct or Delete" button.
• Deletions—Click in the "DELETE FORM" box at the top of the previously filed form and then save the form.
• Corrections—Click in the "CORRECTED" box at the top of the previously filed form and then make any necessary changes. Remember certain fields as shown in the red font on the XLS templates are required and should not be left blank such as LastName. Update the data on the form to create a correction and then click on the "Save" button. When all corrections for all forms and Filers are complete, generate corrected XML file(s) for each Reporting FI.

Corrections, Deletions and Originals cannot be commingled in the same XML file. The XML process must be performed individually for Corrected Data, Deleted/Void Data and Original Data.

Import Corrections and Deletions
This feature is slated for future release. Every record in CRS Pro has a unique Record ID such as 1, 2, 3 and so on. Your import must contain this Record ID (in a column named MatchID) for a successful import. An export of data will accompany this feature to allow an .XLS or delimited file with this Record ID.

Correction of a Correction of a Correction
This feature is slated for future release.

Can I correct data that was NOT originally filed by CRS Pro?
No. Each record filed by CRS Pro is associated with unique identifiers. When a Correction or Deletion is created we reference the original unique transmission ID and the unique record ID(s) to identify the specific record(s) being corrected.

**About Corrections Screen**
The About Corrections screen displays an overview of the correction process.

**View About Corrections Screen**
On the Help & Extras task panel select the Correcting Filed Forms link. A red check appears beside any form type containing corrected records.

**Utilities**

**Import Overview**
The Import Sessions screen provides direct access to the Import Wizard. CRS Pro software features a powerful, intuitive wizard to simplify the process of importing your data. If you can access your data in Excel (or a similar product), you can import it into our software! Additionally, users can view upload sessions, reset/void uploads, complete pending uploads and view reports. Access this screen via the task panel > Preparing My Forms > Import New Tax Forms.

- See [Sample Import Files](#) and [Import File Conventions](#) — Review prior to creating your import file or using the Import Wizard.
- See [Import Wizard](#)

**Import Session Considerations**
- Import sessions are Filer specific. If an import session is not displayed, verify the correct Filer is selected.
- The "Imported" column indicates the number of records successfully imported into the CRS Pro software database.
- The "Import Source File" column details the name of the import file.
- All import sessions are assigned a "Status" as detailed below.

**Import Session Statuses**
Every import session is assigned an "import status" to indicate its position in the import process. The import status is different than the "filing status" assigned during the Import Wizard. The filing status (e.g., Pending or Filed Mag) indicates an individual record’s availability for filing tasks at the Work With My Tax Forms screen.

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imported*</td>
<td>All records in import file have been posted and processing is complete.</td>
</tr>
<tr>
<td></td>
<td>Records are available at the Work With My Tax Forms screen to view, edit, file or delete.</td>
</tr>
<tr>
<td>Loaded</td>
<td>The import file has been loaded, but not fully imported into the software. To complete the import process highlight the session and click the &quot;Continue with Session&quot; button.</td>
</tr>
</tbody>
</table>
### Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated</td>
<td>This import file has been imported and at least one of the records has been opened and saved (edits to the form). Re-applying validation, etc., also triggers this status.</td>
</tr>
<tr>
<td>Partial</td>
<td>Some records in the import file have been imported and some are still in a loaded status.</td>
</tr>
<tr>
<td>Imp/Disc</td>
<td>Some records in the import file have been Imported, others were deleted during the Post.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>All records for the log were abandoned, none imported.</td>
</tr>
<tr>
<td>Reset/Void</td>
<td>A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Filed) are NOT removed.</td>
</tr>
</tbody>
</table>

---

**Reset (Void) Session**

Highlight the import session to void. Only import sessions with an "Imported" status can be reset. A voided session cannot be un-voided. See [Reset/Void Import Session](#).

**Continue With Session**

Highlight the session to import and select the "Continue with Session" button. To complete a pending import the user must validate and post their data. If import data contains errors and/or warnings, the user has the option to include or exclude those records in the post process. After successfully uploading the file, the "Status" column updates to "Imported" or "Partial" if only some of the records were imported. If some records in the import session are posted and other are abandoned, the "Status" column updates to "Imp/Disc" to indicate some records imported and some records discarded.

**Amount/Totals Report**

Also referred to as the Import Session Summary, this report generates a log specific detail of an import file. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Undocumented Accounts, Closed/Deleted Accounts and Account Balance.

**Run Report**

1. Click the "Amount/Totals Report" button.
2. User is prompted to select a printer; consider printing to PDF to save paper.
3. Select the Sort Order; by Last Name/First Name or By TIN
4. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors and Warnings only

**Check/Update Error Status**

CRS Pro software performs validation checks on your data. This helps users find and fix potential tax form errors (see [Disclaimer](#)) prior to submission to any government entities. Error and validation
checks occur whether data is manually entered or imported. It also occurs when generating an XML file. If a problem is detected, the software flags the record with a Warning, Error or Reject Error. Users are encouraged—but not required—to fix warnings and errors prior to submitting their XML filings.

**Quick Error Scan**
Use to quickly scan all records in the CRS Pro software database; on the menu bar select Utilities > Check/Update Error Status For All Forms.

**Warnings & Errors Defined**
Whether importing or manually entering data, CRS software flags any records with Warnings, Errors or Reject Errors. Any record containing a warning or error has an asterisk (*) prefixed to its status at the Work with My Tax Forms screen (e.g., *Pending or *Filed).

<table>
<thead>
<tr>
<th>Type</th>
<th>Defined</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Warnings        | Possible inconsistency or omission in the data that may result in the record failing XML schema validation. | • Invalid or missing Country Code  
• Missing TIN  
• Invalid Box Code |
| Errors          | Serious flaws in the data which will most likely result in failing XML schema validation. | • Missing name for Controlling Person (CP) or Account Holder (AH).  
• Missing IN/TIN Information for CP or AH.  
• Missing address information for CP or AH.  
• Missing ResCountryCode for CP or AH. |
| Reject Errors   | Data has not been entered correctly and will result in automatic XML schema failure. | • Missing data in the AH_Type field  
• Field contains non-allowed negative amounts |

**Find Problem Records**
CRS Pro software includes multiple means to locate problem records including:

- **Form Counts Report** View a concise listing of all Filers including number of warnings and/or errors.
- **Control Totals Report** View errors and/or warnings in detail by Account Holder and Controlling Person. Users must select the "Extended Version—Errors and Warnings Messages" to access this information.
- **Review Import Records**: Prior to posting import data into the software, users can edit or delete individual records, or abandon an entire import session, during the Import Wizard—Step 2: Validate Data.
- **Error Queries**: Sort records by "Errors Only" or "Errors & Warnings Only" at the Work With My Tax Forms screen.

**Run Error Queries**
1. On the task panel select Preparing My Forms > Work With My Tax Forms.
2. At the Enter, Update and View screen use the Current Query drop menu to select "Errors and Warnings Only" or "Errors Only".

3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no problem records for the selected Filer and associated records.
   - Any record containing an error or warning can be fixed provided it has a Pending status.
   - After fixing a problem record it immediately disappears from this list.
   - After fixing all problem records reset the Current Query to "All Records".

**Business Rules/Validation Changes**

CRS Pro software includes standard business rules—based on OECD Common Reporting Standard specifications—for detecting errors and/or warnings on tax forms. At their discretion, Administrators can change default validation rules. **Caution: Disabling a business rule does not guarantee acceptance of your XML files**. See [Custom Tax Form Validation Rules](44)

**DISCLAIMER**

CRS Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

**Feedback**

Users who encounter a situation that should possibly generate an Error or Warning in the software are encourage to discuss the situation with 1099 Pro, Inc. at compliance@1099pro.com. Please indicate the form type, data set and IRS regulations in your correspondence.

**Warnings and Errors Scan**

Users can scan their records for errors and warnings prior to generating an XML file. If errors or warnings are found in XML files, users can choose whether or not to process those records.

**Processing Records with Errors/Warnings**

Errors and Warnings typically indicate missing or incorrect information. Account Holder Last Name, Birth Town or City and Account Balance are required fields that will generate errors if data is missing.

Users are encouraged to make every effort to fix missing or invalid data but if they are unable to do so, file the records anyway. A good way to identify errors and warnings is to run a [Control Totals Report](47) with "Extended Version—Errors and Warnings Messages" selected. Users are encouraged to fix errors or warnings prior to transmitting an XML file.

See [Error & Validation Checking](54)
Ch. 4 Task Panel

Select Filer
The currently selected Filer—including Name and PCode—is always displayed at the top of the Select Filer box. Use the "Select Another Filer" button, located at the top left of the task panel, to quickly switch Filers.

Select a Filer
1. On the task panel click the "Select Another Filer" button.
2. At the Browse the Filers File screen highlight a Filer and click "Select".

Reporting FI
My Filers List
Did you know? The terms Filer and Reporting Financial Institution (FI) are sometimes used interchangeably. Use the Filer Master List screen to add, change, delete and view Filers. Use the Select Filer button to quickly jump between existing Filers.

Filer/Reporting FI Overview
Access the Filer Master List screen via the menu bar > Filers List. This screen displays ALL Filers OR sort them by default options or create a custom query.

- Unlimited Filers are allowed.
- All CRS Pro software products accept multiple Filers with one TIN. This is useful for companies issuing forms from multiple departments or for batch processors. See Create a Duplicate Filer.
- CRS Pro software allows US, Canadian and foreign Filers.
- Filer Record Details provides a thorough explanation on each Filer specific field.

Viewing Options

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort Filers by Filer Name, TIN or PCode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all Filers are displayed. Users can display a subset of Filers via the &quot;Current Query&quot; drop menu and select a readymade query or create their own custom query, e.g. &quot;Address Type Code = Other Foreign&quot;, etc.</td>
</tr>
</tbody>
</table>

Onscreen Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual Filers. Unlimited Filers are allowed. See Add a Filer.</td>
</tr>
<tr>
<td>Button</td>
<td>Function</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit a Filer. Cascading updates are applied to all existing records in the software with a &quot;Pending&quot; status; records with any other status are locked and will not reflect Filer updates. See Change a Filer and Cascading Updates.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Use to delete any Filer with no associated records; if any records are associated with the Filer (including deleted records) the Filer is locked and cannot be deleted. See Delete a Filer.</td>
</tr>
<tr>
<td>&quot;Run Filer Report&quot;</td>
<td>This report provides detailed information on a selected Filer including Name, TIN, Contact Information, Country Codes and a history of any address changes. See Filer Listing Report.</td>
</tr>
</tbody>
</table>

**Preparing My Forms**

**Work With My Tax Forms**

The Work With My Tax Forms screen serves as the primary place to view, edit and track Account Holder records. Users are encouraged to familiarize themselves with it now—prior to the onset of filing season.

**Work With My Tax Forms Overview**

Access the Work With My Tax Forms screen via the Preparing My Forms task panel > Work With My Tax Forms. The Work With My Tax Forms screen allows users to view ALL CRS records, sort them by default options or create a custom query. From this screen users can Add, Change and Delete individual records plus initiate Group Actions.

**Viewing Options**

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort forms by Last Name/Company, TIN, Account or by creating a custom view. See Current Sort/View Order for further details. Scroll through results with the mouse or the keyboard UP/DOWN arrow keys.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all forms—regardless of status—are displayed. Users can display a subset of the forms via the &quot;Current Query&quot; drop menu and select a prebuilt query, e.g. &quot;Pending Original Forms Only&quot; or &quot;Corrections (Not Filed)&quot; or create their own custom query, e.g. &quot;Country Code is equal to ES&quot;, etc. See Custom Query Wizard. Note: The &quot;Status&quot; of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported—one with a Pending status and the other a Filed XML status—the displayed forms can be limited by their respective status.</td>
</tr>
<tr>
<td>Status Column</td>
<td>This column indicates an individual record’s position in the filing cycle and is an invaluable reference tool. A record’s Status is directly tied to its position in the filing cycle. See Status Overview. Please see Filing Status—Am I Done?</td>
</tr>
</tbody>
</table>

© 2018 1099 Pro, Inc.
Onscreen Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual records; most users prefer to import their records. CRS Pro software allows records to be added (either manually or via import) up to the user's current transaction limit. Transactions range from 1,000 in a standard purchase to an unlimited number of transactions. See <a href="#">CRS Forms</a> and <a href="#">Registration &amp; Upgrades</a> for more information.</td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit any record with a Pending status; records with any other status are &quot;protected&quot; (locked) and cannot be changed. See <a href="#">Protected Forms Options</a> screen and <a href="#">Correct a Record</a>. Cascading updates are changes made to a Filer's information globally throughout all tax forms.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Forms with a Filed Mag status are available for deletion. Records must be individually deleted. Previously filed, deleted records, must be submitted to the appropriate agency as a &quot;Deletion of Data&quot; XML file. See <a href="#">About Corrections &amp; Deletions</a>.</td>
</tr>
<tr>
<td>&quot;Browse by Form&quot;</td>
<td>The &quot;Browse by Form&quot; button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as when using the standard browse. For example, if when viewing the list of forms in Last Name/Company order, with a Query to only show forms that contain Notes, those settings remain in effect when switching to Browse by Form mode. See <a href="#">Browse by Form</a> for further instructions.</td>
</tr>
<tr>
<td>&quot;Group Actions&quot;</td>
<td>Use to tag (or select) a number of records and perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of Pending forms allows you to manually select any number of Pending forms for removal. All associated notes for the forms are likewise deleted. See <a href="#">Group Actions</a>.</td>
</tr>
<tr>
<td>&quot;Print/View Report&quot;</td>
<td>This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report). See Print/View Report</td>
</tr>
<tr>
<td>&quot;Custom Report&quot;</td>
<td>Use to create and save Custom Query reports. Visibility to these reports can be limited by User by the Administrator.</td>
</tr>
</tbody>
</table>
Browse By Form
The Work With My Tax Forms screen offers the ability to browse records (by the same Filer) using the update form. This allows the user to quickly move from record-to-record and view data.

**Browse By Form**
1. On the task panel select Preparing My Forms > Work With My Tax Forms.
2. At the Enter, Update and View screen select the individual form to start browsing.
3. Click the "Browse By Form" button located at the bottom center of the screen.
   - Use the PageUp ("pgup") and PageDown ("pgdn") keys to move forwards/backwards through the forms.
   - If a form has a protected status (XML Filed, etc.) users may only VIEW the form.
   - Forms with a Pending status are available for EDITS. To continue browsing forms after making changes to a Pending form, simply press the PageUp/PageDown keys to continue.
4. To exit the Browse By Form feature use the Escape ("esc") key on your keyboard or click the "Cancel" button on the tax form.

**NOTE:** When using Browse by Form, the current View and Query settings remain in effect, just as when using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when switching to Browse by Form mode.

Entry Form
The Form Entry screen is used to view, add or edit CRS form information.

**Account Holder Section**
The top section of the Form Entry screen displays the Filer/PCode and specific Account Holder information. At a minimum, **the Account Number Type and Account Holder Type fields are REQUIRED**. Acceptable Account Holder Type codes are specified in the Import File Conventions.

<table>
<thead>
<tr>
<th>Account Holder for Filer: FR_ABC reporting to FR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Number: 123-ABC</td>
</tr>
<tr>
<td>Account Number Type: OECD01</td>
</tr>
<tr>
<td>Undocumented Account: Yes No</td>
</tr>
<tr>
<td>Account Balance: 100000.00</td>
</tr>
<tr>
<td>Account Holder Type: CRS007</td>
</tr>
</tbody>
</table>

**Additional Fields**
The bottom section of the Form Entry screen is composed of five tabs including Name and Address, TIN/IN and Country, Birth Information, Payments and Controlling Person.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name and Address</td>
<td>Numerous names and addresses are allowed as illustrated in the above image.</td>
</tr>
</tbody>
</table>
### Tab Description

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIN/IN and Country</td>
<td>A person can have multiple TIN's and an Entity/Organisation can have several IN's (Identification Numbers).</td>
</tr>
<tr>
<td>Birth Information</td>
<td></td>
</tr>
<tr>
<td>Payments</td>
<td></td>
</tr>
<tr>
<td>Controlling Person</td>
<td>Multiple controlling persons are allowed and each controlling person can have multiple Names/Addresses/TINs/Countries associated with them.</td>
</tr>
</tbody>
</table>

### Data Entry Overview

<table>
<thead>
<tr>
<th>Function / Button Descriptions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigating Fields / Filling In Boxes</td>
<td>Use the &lt;TAB&gt; key to move forward through fields. Use the &lt;TAB&gt; + &lt;SHIFT&gt; keys to move backwards through fields. Select or deselect a checkbox via the spacebar, then &lt;TAB&gt; to the next field.</td>
</tr>
<tr>
<td>Edit Fields</td>
<td>Make necessary changes, additions or deletions to the form and click the &quot;Save&quot; button to exit and return to the Work With My Tax Forms screen. Edit TIN Type—To change an SSN to an EIN or an EIN to an SSN, highlight the entire TIN and select the &lt;DELETE&gt; key on your keyboard. Then enter the new TIN with the appropriately placed dashes.</td>
</tr>
<tr>
<td>Correct Fields</td>
<td>Only records with a Mag (XML) Filed status are available to correct. Any changed values or amounts turn blue to distinguish between original and corrected information. The &quot;Correction&quot; box is only available when a formal correction is created. See <a href="#">Correct a record</a></td>
</tr>
<tr>
<td>Data Lookups</td>
<td>Data lookups are available via the &lt;F2&gt; key in the Country Code and other select fields.</td>
</tr>
<tr>
<td>Protected Forms</td>
<td>A form with any status other than Pending is protected or locked to prevent any mismatch of data from the original record that has been transmitted via an XML file. This includes forms with a status of &quot;XML Filed&quot;. If forms are imported in a status other than Pending, they are likewise protected until or unless they are Reset (VOIDED). Only forms with a Pending status can be edited or deleted.</td>
</tr>
<tr>
<td>&quot;History&quot; Button</td>
<td>View all prior changes made to a form via the &quot;History&quot; button. This screen tracks all manual changes made directly to a record.</td>
</tr>
<tr>
<td>&quot;Notes / Has Notes&quot; Button</td>
<td>View/add notes associated with this CRS form. See <a href="#">Browse Notes</a></td>
</tr>
<tr>
<td>&quot;Check&quot; Form Button</td>
<td>Use to check form for common errors or warnings</td>
</tr>
<tr>
<td>&quot;Save / Cancel&quot; Buttons</td>
<td>Use the &quot;Save&quot; button to immediately save form changes or use the &quot;Cancel&quot; button to abandon changes and exit the screen.</td>
</tr>
</tbody>
</table>

**Save Button Unavailable:**
<table>
<thead>
<tr>
<th>Function / Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error checks are...</td>
<td>Error checks are automatically performed on saved forms; <strong>forms cannot be saved if minimum elements required for XML schema validation are missing.</strong> Some of CRS Pro's errors come from validations against the OECD XML Schema, such as an &quot;Account Balance or Payment Amount also require a Currency Code&quot;. Other errors come from the <em>Standard for Automatic Exchange of Financial Account Information in Tax Matters, 2nd Edition.</em> If your accounting or legal department indicates a condition is NOT an error for the jurisdiction being reported to, users can disable the error at the Business Rules Validation screen. Changes at this screen are global to the software and impact all data for all Filers.</td>
</tr>
<tr>
<td>Correction / Deleted / Void Boxes</td>
<td>Users cannot manually check these boxes at this screen. They are only available for selection when a formal correction or deletion is created.</td>
</tr>
<tr>
<td>Optional Grouping/Filtering Fields</td>
<td>Users can populate these optional fields at their discretion and then use the Custom Query wizard to sort records.</td>
</tr>
</tbody>
</table>
| Groups of Forms           | **Group Actions** allows users to select any number of existing Account Holders, and then loop through the list creating new CRS forms for them. The program automatically populates the Account Holder information on each new form. For additional flexibility, users can add the forms by name, TIN, State or ZIP sort order.  
1. On the Work With My Tax Forms screen select the "Group Actions" button.  
2. Select the Add tab, then click the "Proceed With This Action" button.  
3. On the next screen, select (or tag) all of the Account Holders you want to add blank forms.  
4. Next select the "Sort" order in how these form will be placed.  
5. Finish by filling out all information for each form and clicking "Save".  
**This feature is not currently available in CRS Pro.**                                                                 |

### Audit Trails

The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected. 

Use the spyglass icon in the upper-right corner to view any Notes associated with this record.

### Notes

Users can add notes to individual CRS forms and Filer records. Notes can contain up to 512 characters and unlimited notes are allowed. Every time a note is created or updated, the note displays the date and time of the action and either the User ID of the person who made the...
change (assuming Security is enabled) or the network name/ID of the machine where the change was made.

Depending on the type of note, users can view and update them from multiple places within the software. At a CRS data entry screen, if there are any notes associated with the Filer or the specific tax form the "Notes" button changes to "Has Notes".

**Global Notes**
Global notes are visible everywhere within the program, these notes can be viewed and updated from every Notes browse. Users can also enter these notes directly from the main File menu via the "Global Notes" option.

**Filer Notes**
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Filer, you can also view/update all Global notes.

**Tax Form Notes**
This type of note is attached to one specific CRS record. When entering notes for a record, you can also view/update the notes for the Filer of the form, as well as view/update all Global notes.

This screen allows users to add or modify notes. Please see Browse Notes/Attachments for all available note types.

**Data Entry Preferences**
Users can set their own data entry preferences via the "Preferences" button.

**Date entry options include:**
- First Name, then Last Name/Company (default) OR Last Name/Company, then First Name.
- Delivery/Street, then Apt/Suite/Location OR Apt/Suite/Location, then Delivery/Suite. Please note that the USPS requests the Apt/Suite line in US addresses prints above the Street Address line. Accordingly, all US addresses are formatted to print in that order, regardless of the data entry option selected here.

**Options for Tax Form Data Entry**
CRS Pro contains data entry options accessible at the Form Entry screen. Inactive buttons in this list indicate the form is not available for edits.

- **History:** This screen displays record history information for the selected tax form
Notes: Allows users to View, Add, Update and Delete Notes for this tax form. After entering Notes the button changes to "Has Notes" with BOLD text to indicate that notes now exist for this form. For more help on Notes, See Browse Notes.

Check Form: Check form against existing business rule validations.

OECD CRS Instructions: Access general instructions.

Help: Provides help with the current screen.

Protected Forms Options
Use the Protected Forms Options screen to view "protected" records and initiate corrections. Records with a Filed XML status or any other status besides Pending are "protected" from edits.

Initiate Correction
Any record with a Filed XML status can be corrected or deleted. See About Corrections—An Overview.

1. At the Work With My Tax Forms screen highlight the record and click the "Change" button.
2. At the Protected Form Update Options screen click the "Correct or Delete" button. At the Adding a Form CRS screen manually check the "Corrected" or "Deleted" box at the top of the screen. See Correct a Record.
3. Return to the Protected Form Update Options screen after completing and saving the correction. Use the "Close" button to exit the screen and return to the Work With My Tax Forms screen where the Original, Corr/Pending, Zero/Pending (if applicable) and Del/Pending records can be readily viewed.

Protected Form Update Options screen
Use this screen to access protected records for viewing, reprints or initiating corrections.

1. At the Work With My Tax Forms screen highlight any "protected" record (i.e., effectively any record except those with a Pending status).
2. Click the "Change" button to access the Protected Form Update Options screen.

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Available Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>These forms are ready to generate XML files. Users can view, change, delete the form or include it in an XML file.</td>
</tr>
<tr>
<td>Deleted</td>
<td>These forms have been deleted and cannot be un-deleted. Users can view the form.</td>
</tr>
<tr>
<td>Filed XML</td>
<td>This record has been included in an XML file. This form can be corrected, if required.</td>
</tr>
<tr>
<td>Corr/XML</td>
<td>This record has been corrected and included in an XML file</td>
</tr>
</tbody>
</table>

Optional Field Filters
CRS Pro software allows users the ability to query records by optional field filters. All sample import files and data entry screens include the optional Source, Category and Batch ID fields. Users can populate these fields at their discretion and then use the Custom Query wizard to sort records.
Current Sort/View

CRS Pro software includes built-in views that are tied directly to the "Search" field. To search for records by TIN the view must be set to "By TIN". Likewise, to search for records by name the view must be set to "By Last Name/Company" or "By Filer Name" as appropriate. Failure to properly set the view results in a failed search attempt. Views are available at select browse screens.

Search Field

1. Set view, for example, to "By TIN" and in the Search field enter at least the first digit of a TIN. Enter only the TIN digits, do NOT enter the TIN dashes.
2. Click the <TAB> key on your keyboard.
3. Scroll through results with your mouse or with the UP/DOWN arrow keys on your keyboard.

Custom Screen View

Users can create a customized view at the Work With My Tax Forms screen.

Define a Custom View

1. At the Work With My Tax Forms screen refer to the Current Sort/View drop menu and select "Custom View".

2. Select from the available fields on the left column and organize them in the column on the right. Available fields vary by software product and form type. Sophisticated users can click the "Advanced" button to rename column headers.

3. Move the position of these items in the order in which they appear by highlighting them individually via the UP/DOWN arrows to adjust it’s position accordingly.

1042-S Pro available fields; available fields vary by tax form and software product.
4. To save these changes click "Apply" or "Next" to define a sort order for the custom view. The software displays the "Select a sort order for the view" screen. At this point users can:
   - Use the default sort order.
   - Select a predefined sort order (fastest) which tells the software to use the built in predefined list; for example: Filer ID, Last Name/Company, First Names or by Filer ID, Recipient TIN, then Last Name/Company.
   - Define your own custom sort order (slowest) which allows the user to indicate what custom sort order the software should follow based on the custom field selections.

**Add/Change/Delete a Record**

A standard installation of CRS Pro allows up to 1,000 records; bump codes can be purchased at any time.

**Add a Form**

Please visit [https://www.1099pro.com/videos.asp](https://www.1099pro.com/videos.asp) and select the "How to Add a Form" video for a brief tutorial on the process.

1. At the Preparing My Forms task panel select > Work With My Tax Forms.
2. At the Enter, Update and View screen click "Add" to access the Adding a Form CRS Record screen.
3. After completing all fields click "Save". The record is saved and a blank screen is presented for your next record. Click "Cancel" to exit the Adding a Form Record screen.

**Change a Form**

Only forms with a Pending status are available for modification.

1. At the Preparing My Forms task panel select > Work With My Tax Forms.
2. At the Enter, Update and View screen highlight the appropriate form and click "Change" (or double-click) to access the Changing a Form screen.
3. Make necessary changes and click "Save".

**Delete a "Pending" Form**

Only forms with a Pending status can be deleted. Deleted forms can be viewed at the Work With My Tax Form screen (see View Deleted Records below). See [Delete "Filed" Status Forms](#).

1. At the Enter, Update and View screen highlight the record and click "Delete".
2. The Administrator prompts to confirm the deletion. Click "Yes" to delete the record or "No" to cancel.

**View Deleted Forms**

Deleted forms are available for audit trail purposes and can be viewed only. Deleted forms cannot be un-deleted.

1. At the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen select Program Options > Preference, Update and Program Options.
3. At the Preferences screen, General tab, under Options for Manually DELETED Tax Forms check the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" box.
4. Click "OK" to save changes.
5. Return to the Enter, Update and View screen to view deleted CRS records.

**Correct a Record**

CRS Pro only corrects records that were originally generated from CRS Pro as the corrected data requires reference to the original **DocRefId** of the account report being changed.

Only forms with a Filed XML status are available for corrections; prior to filing it is only necessary to change (or update) the form. See [About Corrections](#).

**Correct or Delete a Record**

1. At the Work With My Tax Forms screen double-click on the appropriate record to access the Protected Form Update Options screen.
2. Click the "Correct or Delete" button.
3. The Changing a Form CRS Correction screen displays. Check the CORRECTED or DELETED box at the top of the previously filed form and then make any necessary changes.

Remember to use the CRS Packager and then transmit your corrected XML file(s) to IDES.

**About Corrections & Deletions**

In the course of the Automatic Exchange of Information (AEOI), users may need to correct or delete XML information previously sent to a jurisdiction. The AEOI format allows users to send Original, Corrected or Deleted data, but always as separate XML files.

**NOTE:** Data can only be corrected or deleted if it was originally generated from CRS Pro as the corrected/deleted data requires reference to the original **DocRefId** of the account report being changed.

**What is a Correction?**

CRS Pro allows users to correct previously filed data **ASSUMING** the original XML data was submitted via CRS Pro. New data that was overlooked in prior filings is not a correction (it is considered a late original).

**What is a Deletion?**

CRS Pro allows users to delete previously filed data **ASSUMING** the original XML data was submitted via CRS Pro.

**How Does It Work?**

At the Work With My Tax Forms screen double-click on any form with a "Filed Mag" status to access the Protected Form Update screen. Then click on the "Correct or Delete" button.

- **Deletions**—Click in the "DELETE FORM" box at the top of the previously filed form and then save the form.
- **Corrections**—Click in the "CORRECTED" box at the top of the previously filed form and then make any necessary changes. Remember certain fields as shown in the red font on the XLS templates are...
required and should not be left blank such as LastName. Update the data on the form to create a correction and then click on the "Save" button. When all corrections for all forms and Filers are complete, generate corrected XML file(s) for each Reporting FI.

*Corrections, Deletions and Originals cannot be commingled in the same XML file. The XML process must be performed individually for Corrected Data, Deleted/Void Data and Original Data.*

**Import Corrections and Deletions**
This feature is slated for future release. Every record in CRS Pro has a unique Record ID such as 1, 2, 3 and so on. Your import must contain this Record ID (in a column named MatchID) for a successful import. An export of data will accompany this feature to allow an .XLS or delimited file with this Record ID.

**Correction of a Correction of a Correction**
This feature is slated for future release.

**Can I correct data that was NOT originally filed by CRS Pro?**
No. Each record filed by CRS Pro is associated with unique identifiers. When a Correction or Deletion is created we reference the original unique transmission ID and the unique record ID(s) to identify the specific record(s) being corrected.

**About Corrections Screen**
The About Corrections screen displays an overview of the correction process.

**View About Corrections Screen**
On the Help & Extras task panel select the Correcting Filed Forms link. A red check appears beside any form type containing corrected records.

**Group Actions**
The "Group Actions" button is located at the bottom center of the Work With My Tax Forms screen and provides direct access to the following options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td><em>This feature is not available in CRS Pro.</em></td>
</tr>
<tr>
<td>Reprint</td>
<td><em>This feature is not available in CRS Pro.</em></td>
</tr>
<tr>
<td>Add</td>
<td><em>This feature is not available in CRS Pro.</em></td>
</tr>
<tr>
<td>Delete Pending Tax Forms</td>
<td>Tag Pending forms and delete them with one operation. All notes associated with the form(s) are also deleted.</td>
</tr>
<tr>
<td>RESET Printed Tax Forms Back to Pending</td>
<td><em>This feature is pending in CRS Pro</em></td>
</tr>
</tbody>
</table>
Query Wizard

CRS Pro software includes pre-built queries to filter user data. The Current Query drop menu is available at the Work with My Tax Forms and Filer Master List screens.

Work With My Tax Forms Screen:
- Corrections (Filed)
- Corrections (Not Filed)
- Errors & Warnings Only
- Errors Only
- Filed Original Forms
- Forms with Notes
- Pending Original Forms
- Printed Original Forms
- Voided Original Forms

Filer List Screen:
- Has Notes
- TIN is an SSN
- TIN is an EIN
- TIN is NOT EIN or SSN

Form Status Values

Database values are useful for generating Custom Queries in CRS Pro software or in an SQL database. Not all values are applicable to all software products.

Form Status Values—Original Records
In the Query Wizard Fields to Evaluate select “Form Status Code”, the Operation Selection and the Value Entry. For example, the query "FORM STATUS CODE IS EQUAL TO 8" returns all Original Service Bureau Printed and eFiled forms.

Form Status Values—Corrected Records
Run this query like an original record query; the returned results include only the latest corrected record. For 1099 forms this includes both parts of a 2-part correction; the zero correction and the new record. The original or new corrected values can be requested and both parts are returned.

<table>
<thead>
<tr>
<th>ORIGINAL RECORDS</th>
<th>CORRECTION ZERO FORM (2-PART)</th>
<th>Correction (1-Part) / New Form (2-Part)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0: Original Pending</td>
<td>10: Corrected Pending</td>
<td>20: Correction Pending</td>
</tr>
<tr>
<td>1: Original Printed</td>
<td>11: Corrected Printed</td>
<td>21: Correction Printed</td>
</tr>
<tr>
<td>2: Original Printed and Voided</td>
<td>12: Corrected Printed and Voided</td>
<td>22: Correction Printed and Voided</td>
</tr>
<tr>
<td>3: Original Printed and Filed Paper</td>
<td>13: Corrected Printed and Filed Paper</td>
<td>23: Correction Printed and Filed Paper</td>
</tr>
<tr>
<td>4: Original Printed and e-Filed</td>
<td>14: Corrected Printed and e-Filed</td>
<td>24: Correction Printed and e-Filed</td>
</tr>
<tr>
<td>5: Original SB Printed</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**ORIGINAL RECORDS**

| 6: Original Not Printed and e-Filed |
| 7: Original Not Printed and SB e-Filed |
| 8: Original SB Printed and SB e-Filed |

**CORRECTION ZERO FORM (2-PART)**

| 15: Corrected SB Printed |
| 16: Corrected Not Printed and e-Filed |
| 17: Corrected Not Printed and SB e-Filed |
| 18: Corrected SB Printed and SB e-Filed |

**Correction (1-Part) / New Form (2-Part)**

| 25: Correction SB Printed |
| 26: Correction Not Printed and e-Filed |
| 27: Correction Not Printed and SB e-Filed |
| 28: Correction SB Printed and SB e-Filed |


**Error Status Values**

In the Query Wizard Fields to Evaluate select "Error Status", the Operation Selection and the Value Entry. For example, the query, "ERROR STATUS IS EQUAL TO 3" returns all forms containing Warnings + Errors.

0: No Errors
1: Warnings
2: Errors
3: Warnings + Errors
4: Fatal / Major Errors

**GIIN Validation**

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FIs jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FIs FATCA Registration is submitted and approved.

The Internal Revenue Service (IRS) Automatically validates a Global Intermediary Identification Number (GIIN) against the most up to date IRS information. A GIIN is a 19 digit identification number that is instrumental in the United States' new FATCA legislation. Any Foreign Financial Institution (FFI) will undoubtedly need to validate all GIIN information before reporting the upcoming FATCA Form 8966.

See [GIIN Composition & Formatting](#)

**GIIN Composition**

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI’s jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It
is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI’s FATCA Registration is submitted and approved.

Enter a Filer/Reporting FI’s GIIN at the Add a Filer screen, also see Select a GIIN.

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI’s online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI’s FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN.

The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question 3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

**Global Intermediary Identification Number (GIIN) Composition Format:**

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>Characters</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xxxxxxx. Xxxxx.XX.XXX</td>
<td>19</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Xxxxxxx                  | 6          | 1-6      | Alphanumeric upper case only. For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID, for members; this is just the first six characters. Note: The first six characters of any Financial Institution’s FATCA ID are randomly generated and will never use the letter “O”.
| Separator 1              | 1          | 7        | Period = .          |
| Xxxxxx                   | 5          | 8-12     | Alphanumeric upper case only. |
Cascading Changes

What are Cascading changes?
When making manual changes to the Filer Master List in CRS Pro, those changes are then cascaded or (updated) throughout all tax forms with a Pending status. Cascading updates help ensure that ALL Filer and Account Holder information, regardless of the tax form, is quickly and uniformly synchronized.

When does the cascading of those changes take place?
After making changes to a Filer, click the "Save" button. The Administrator prompts to "Update all Pending forms with the new information?" Click "Yes" to update all pending forms associated with the Filer, or "No" to update only the selected Filer.

To update Filer information for tax forms with any status other than Pending (i.e., XML Filed.), the user must manually reset the form’s status back to Pending. The cascading changes automatically and immediately take effect.

I made prior changes to a tax form and now I am being prompted with a window "Account Holder may need updating" or "Possible Account Holder Information Mismatch." What do I do now?
CRS Pro prompts the user to update or synchronize changes if it sees that the existing account holder information does not correspond with the master database. It will continue to do this for all consecutive tax forms that require updating. Click "Yes" to apply the changes or "No" to not make any changes. The same applies to changes made to Filer and contact information.

Print/View Reports

How to Print/View Reports

1. At the "Work with My Tax Forms" screen click the "Print/View Report" button.
2. The Administrator prompts to use the current query if one is selected at the Work With My Tax Forms screen. If a query is not selected, the Administrator asks "Which Forms To Include?" Options include:
   - (1) All—Generates a standard Control Totals report
   - (2) Query—Allows the user to select a previously saved query or create a new query
   - (3) Selected—Generates a report for the highlighted record at the Work With My Tax Forms screen
   - Cancel—Cancel and exit the report

See Control Totals Report

Search

Use the Search field to quickly locate a Filer.

Search (AKA Incremental Index)

1. Set the Current View to the correct sort order criteria (i.e. By TIN).
2. At the Browse the Filers screen, place your cursor in the Search field.
3. Enter the first few characters of your search criteria and hit the TAB key.
   - The browse screen highlights the record matching your entry. If multiple records match your entry the screen highlights the first match. Use the ARROW keys to scroll through the matches.
   - The Search results are governed according to the column sort order. (i.e. If searching by Last Name/Company, and you search the last name of Charlie Tuna in ascending order by typing in the letters "T" then "U"... in the search field then hit the TAB key, the search results listed are displayed with Charlie Tuna's last name.) If searching by Recipient TIN and you're sort order is set in ascending order then your search results are going to be listed in numeric order from beginning to end for this column only. This same method and result applies to all respective columns.

Note: For a quick form lookup without using you mouse, type the first few numbers of the TIN (assumes the sort order is by TIN) and you will drop down to that particular record, if your sort order is by another field (Last Name or Account ) then type the first few characters you of the field to drop down to that record. To use the "Search " box you must click in the box, type your characters and hit the Tab key.

Tagging Records

CRS Pro allows users to manually tag (or select) records for inclusion various processes.

Tag Key Shortcuts
• **Tag**: Use this button (or ALT + T) to tag individual records.
• **Tag All**: Use this button (or ALT + A) to tag all records.
• **Untag**: Use this button (or ALT + U) to untag an individual record.
• **Untag All**: Use this button to untag all records.
• **Flip**: Use this button (or ALT + F) to reverse the tag status of an individual record.
• **Flip All**: Use this button (or ALT + L) to reverse the tag status of all records. For example, if there are three records and only one record is tagged, the Flip All button will tag the two previously untagged records and untag the original record.
• **Prev Tag**: Use this button (or ALT + P) to scroll backwards through tagged records.
• **Next Tag**: Use this button (or ALT + N) to scroll forwards through tagged records.

**Import New CRS Forms**

The Import Sessions screen provides direct access to the Import Wizard. CRS Pro software features a powerful, intuitive wizard to simplify the process of importing your data. If you can access your data in Excel (or a similar product), you can import it into our software! Additionally, users can view upload sessions, reset/void uploads, complete pending uploads and view reports. Access this screen via the task panel > Preparing My Forms > Import New Tax Forms.

- See [Sample Import Files](#84) and [Import File Conventions](#85) — Review prior to creating your import file or using the Import Wizard.
- See [Import Wizard](#77)

**Import Session Considerations**

- Import sessions are Filer specific. If an import session is not displayed, verify the correct Filer is selected.
- The "Imported" column indicates the number of records successfully imported into the CRS Pro software database.
- The "Import Source File" column details the name of the import file.
- All import sessions are assigned a "Status" as detailed below.

**Import Session Statuses**

Every import session is assigned an "import status" to indicate its position in the import process. The import status is different than the "filing status" assigned during the Import Wizard. The filing status (e.g., Pending or Filed Mag) indicates an individual record’s availability for filing tasks at the Work With My Tax Forms screen.

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imported*</td>
<td>All records in import file have been posted and processing is complete. Records are available at the Work With My Tax Forms screen to view, edit, file or delete.</td>
</tr>
<tr>
<td>Loaded</td>
<td>The import file has been loaded, but not fully imported into the software. To complete the import process highlight the session and click the &quot;Continue with Session&quot; button.</td>
</tr>
</tbody>
</table>
### Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated</td>
<td>This import file has been imported and at least one of the records has been opened and saved (edits to the form). Re-applying validation, etc., also triggers this status.</td>
</tr>
<tr>
<td>Partial</td>
<td>Some records in the import file have been imported and some are still in a loaded status.</td>
</tr>
<tr>
<td>Imp/Disc</td>
<td>Some records in the import file have been Imported, others were deleted during the Post.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>All records for the log were abandoned, none imported.</td>
</tr>
<tr>
<td>Reset/Void</td>
<td>A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Filed) are NOT removed.</td>
</tr>
</tbody>
</table>

### Reset (Void) Session

Highlight the import session to void. Only import sessions with an "Imported" status can be reset. A voided session cannot be un-voided. See [Reset/Void Import Session](#).

### Continue With Session

Highlight the session to import and select the "Continue with Session" button. To complete a pending import the user must validate and post their data. If import data contains errors and/or warnings, the user has the option to include or exclude those records in the post process. After successfully uploading the file, the "Status" column updates to "Imported" or "Partial" if only some of the records were imported. If some records in the import session are posted and other are abandoned, the "Status" column updates to "Imp/Disc" to indicate some records imported and some records discarded.

### Amount/Totals Report

Also referred to as the Import Session Summary, this report generates a log specific detail of an import file. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Undocumented Accounts, Closed/Deleted Accounts and Account Balance.

### Run Report

1. Click the "Amount/Totals Report" button.
2. User is prompted to select a printer; consider printing to PDF to save paper.
3. Select the Sort Order; by Last Name/First Name or By TIN
4. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors and Warnings only

### Import Wizard Overview

CRS Pro software includes an Import Wizard to streamline the import process. The Import Wizard consists of three simple steps that can be quickly completed at one time or, complete the import at
your leisure. Your data is not imported into the software until all three steps are successfully completed.

- See **Sample Import Files**—Review prior to initiating the Import Wizard.
- See **Import Session Summary Report**
- **Error and Validation Checking** is automatically performed on all imports; thereby allowing users the opportunity to find and fix any problem records before importing into the software.

**Import Wizard Overview**

**Step 1: Import Data**—Begin the import process.

**Step 2: Validate Data**—Review your data for errors and warnings.

**Step 3: Post Results**—Post your imported data into the software, for access at the Work With My Tax Forms screen and other areas.

**Step 1: Import Data or Filers**

*Welcome to Step 1 of the Import Wizard!* Users can import Filer and Account Holder Data into the program. Imports eliminate the need to manually enter data, reduce data entry errors and save valuable time.

**Import Guidelines**

- This software installation includes **sample import files**.
- Prior to starting your import review **Import File Conventions**.
- Save your Excel data file in **Text Tab Delimited .TXT** format to preserve formatting.

**Import Wizard—Step 1: Import Data**

Please watch our online video, **Importing Using Standard Maps**, for a brief tutorial on this process.

1. On the task panel go to Preparing My Forms > Import New CRS Tax Forms.

2. At the Start a New Import Process screen select the "Import Records From Excel or a Delimited Text File" button.

3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time.

4. Select the CRS form. If working in a multi-user or network environment see Troubleshooting Import Issues below.
   - Indicate the Import File Format: Excel or Delimited
   - If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See **Manage Import Maps** and the **Delimited Import Map Wizard**.

5. The Tax Forms Revisions Notice appears if form contains any new tax year changes. Check the "I understand and agree" box to cancel the reminder for future imports to this form type. Click "Next" to continue.

6. At the Select the File To Import screen browse for your import file and click "Next" to continue.
• Your selected import file should appear in the display box; the data may appear slightly offset.
• **Data may NOT appear if** 1) the original Header Records were modified or renamed, 2) there is a blank row at the top of the import file or 3) there is a blank row between the Header Row and the start of your import data. Users should cancel the import and fix their import file. See [Import File Conventions](#).
• If data is based on a sample import file and any columns or fields were manually deleted, users may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

7. Select the Filer for the Import. By default the forms import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

8. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapping. Use the "View Next" button to sort through actual records and see live data. If your data contains strange characters; see [Import File Conventions](#). Users can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next" to continue.

9. Specify import status and click "Next" to continue. **Most users select Pending status; only records imported with a Pending status are available for edits or filing.**
• **Pending**—Default status allows users to edit, print, file or delete records.
• **XML Filed**—Indicates records have been XML filed (mag media). *This option is not currently available.*

10. At the Confirm, Test and/or Begin Import Process screen users can test their import file for potential [errors or warnings](#). If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. User cannot edit errors and save changes at this screen — this screen is a TEST MODE version of the Edit, Post and Abandon Records screen. Click "Finish" if satisfied with the import file and are ready to proceed to Step 2: Validate Data.

11. The Administrator prompts, "What do you want to do?".
• **1—Report**: Select to review any [errors or warnings](#) in your import data and generate a report or correct them interactively.
• **2—Continue**: Select to proceed directly to [Import Wizard—Step 2: Validate Data](#).
• **3—STOP**: Select to return to the Import Wizard at a later time.

**Troubleshoot Import Issues**
Microsoft Excel text files may create issues when assigning fields at the Specify Form Field Mapping screen. If 1099 Pro software generates "0" records in the Available Input Fields column, this is because the import file is "locked" in memory by Microsoft Excel—or similar application—across a network LAN or WAN. The user must force Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

• If working locally on an individual computer (not on a network): Close all instances of Microsoft Excel used to generate your text file for import. Rename the import file. Begin a new import process, starting with Step 1 above.
• If working on a network with your import file residing on another computer (such as a workstation or server): Close all instances of Microsoft Excel used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. Rename the import file. Begin a new import process starting with Step 1 above. Verify with your Administrator you have the proper rights to carry out this task.

**Step 2: Validate Data**

*Welcome to Step 2 of the Import Wizard!* At this screen users validate and check their data for any potential errors or warnings.

**Import Wizard—Step 2: Validate Data**

The Edit, Post or Abandon Import Records screen allows users the opportunity to review individual import records PRIOR to posting them to the database. Users can edit or delete individual records OR abandon an entire import session. Eligible import records can also be edited—*post import*—at the Work With My Tax Forms screen. See TEST MODE* below.

1. The Edit, Post or Abandon Import Records screen displays immediately after completing Import Wizard—Step 1: Import Data. The screen is also accessible via the Completed and In-Process Import Session screen for any import session with a "Loaded" or "Updated" status. Simply highlight the import session and click the "Continue with Session" button.

2. All import records in the selected import session are listed at this screen. Errors messages, if any, are detailed for each record. Review import column descriptors.

<table>
<thead>
<tr>
<th>Primary Identifier</th>
<th>TIN. If TIN is not present then Recipient Account Number, otherwise field is blank.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Identifier</td>
<td>Recipient Account Number. If Account Number is not present then the field is blank UNLESS the Primary Identifier field is blank, in which case this field contains Last Name/Company Name.</td>
</tr>
<tr>
<td>Status/Validation</td>
<td>OK—Record complies with business rule validations (no obvious problems). Errors—Record is imported BUT contains serious data flaws that may result in the record being rejected by the IRS/SSA. Err+Warn—Record is imported BUT contains possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA. <em>Reject</em>—Record is not imported unless corrected. Triggered by Missing Last/Company Name or non-allowed negative amounts. <strong>EDIT</strong>—Record is flagged in TEST MODE; changes to record are not saved in TEST MODE.</td>
</tr>
<tr>
<td>Error Messages (blank means no errors)</td>
<td>May include Missing TIN, No TIN or Name, Missing Name, etc. Review Errors &amp; Warnings.</td>
</tr>
</tbody>
</table>

3. Double-click on any record to access the Update Records screen. Individual import record information is available here to view and edit.
**Data Field**
The tax form specific fields; whether populated or not.

<table>
<thead>
<tr>
<th><strong>Raw Value</strong></th>
<th>Precise data values from the import file. For example, a raw value of &quot;750&quot; for a dollar amount box.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import Value</strong></td>
<td>Software imported data values. For example, an imported value of &quot;750.00&quot; for a dollar amount box—notice the dollar amount is auto-formatted during the import process.</td>
</tr>
<tr>
<td><strong>Field Errors or Warnings</strong></td>
<td>Lists any Reject errors including Missing Last/Company Name or non-allowed negative amounts. If the incorrect or missing data is corrected, the associated warning disappears after clicking the &quot;Save&quot; button.</td>
</tr>
</tbody>
</table>

4. Make edits in the corresponding Raw Value fields (double-click to open the field) and then "Save" to return to the main Edit, Post or Abandon Import Records screen. Notice that after data is corrected at the Update Records screen, the Status/Validation and Error Messages columns automatically update to reflect new values.

![Update Records](image)

5. Users can continue to 1) "Change/Fix" selected records and/or 2) "Delete/Remove" selected records and then "Post the Session" to complete the import and bring eligible records into the software. **Eligible records may contain either No Errors, Warnings and/or Errors; however records with Reject Errors are not eligible for import.** Records imported and posted with errors have an asterisk (*) prefixed to their status at the **Work With My Tax Forms** screen. For example, *Pending or *Filed. Review **Errors and Warning**.

- Alternately users can opt to "Abandon This Session" and discard all records in the import, regardless of their Status/Validation.

6. A standard installation of CRS Pro software allows up to 1,000 transactions. If the combined total of existing records in the database and imported records exceeds 1,000, the import may abort. To handle more than 1,000 transactions purchase a Bump Code via Sales at (888) 776-1099.

7. Proceed to **Import Wizard—Step 3: Post Results**.

**TEST MODE—Edit, Post or Abandon Import**
The **Import Wizard—Step 1: Import Data** contains a TEST MODE version of the Edit, Post or Abandon Import Records screens. In TEST MODE, users can select the "Test My Import for Problems"
button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/Fix selected record" to view data. **Changes to import records are not saved in TEST MODE.** Use TEST MODE as an opportunity to quickly verify your data and determine if you want to continue or abandon with this import session.

**Update Import Record**

During the import process users can view loaded records and individually edit them prior to posting them into the CRS Pro software database. Posted records are available in the software for viewing, printing and filing. Loaded records are in a suspended state and can be edited prior to posting or deleted. It is ideal to edit errors/warnings now, prior to posting an import file; however records can also be edited at the Work With My Tax Forms screen while in a Pending status.

**Update Loaded Import Record**

1. At the Edit, Post or Abandon Imported Records screen highlight any record with an error and click the "Change/Fix Selected Record" button.

2. At the Update Records screen data is displayed as follows:
   - Raw Value—The exact data from your import file.
   - Import Value—The data as it has been imported and will display in your records. For example, a dollar amount raw value of "700" has an import value of "700.00".
   - Field Errors or Warnings—Flags some critical errors such as Missing TIN. Review Warnings & Errors.
   - The Overall Tax Form Validation Errors and/or Warnings box lists ALL items with errors or warnings.

3. Click on any field in the Raw Value column, make changes and click "Save" to save all changes and exit the screen.
   - To enter or change a TIN make certain to correctly place hyphens.
   - To mark a check box use "1, x, X or Y"; otherwise leave the box blank.

**Country Alias**

CRS Pro software supports custom country name and validation options during the import process. This is useful in situations where the code imported for a particular country differs from the FATCA's Country/Jurisdiction Listing. For example, if using "JPN" to denote Japan, an error would occur as FATCA's approved country code for Japan is "JP". To correct this error, the software allows users to create an alias for any country in the Country Code database.

**Create Country Alias**

These instructions make use of the above Japan, invalid "JPN" code, example.

1. On the initial import attempt, CRS Pro generates an "Invalid Country" warning at the Edit, Post or Abandon Import Records screen.

2. Double-click on the record to determine that the country code—in this example, "JPN"—is invalid.
3. Click the "Update Country Alias File" button at the bottom center of the Edit, Post or Abandon Import Records screen. The Browse Country Alias/Translations screen lists any existing country alias. To create a new alias, click "Add".

4. At the Adding a Country Alias Record screen, in the top box enter the alias (or incoming value) and in the bottom box enter the name of the country OR click the ellipses button for a complete list of FATCA approved country codes. After entering both the alias and the corresponding FATCA country code, click "OK" to continue.

5. After configuring the alias, click the "Close" button on the Browse Country Alias/Translation window to return to the Import Wizard.

6. Click the "Reapply Alias/Validation" button and the Administrator prompts the user to apply the alias/translations. The alias can be applied to ALL records or only problem records.

7. Once the aliases/validations are applied, CRS Pro software properly translates "JPN" to Japan or "JP" and the "Invalid Country" warning is removed.

Step 3: Final Import - Post Results

Welcome to Step 3 of the Import Wizard! At this screen users post their data into the software. Users importing very large import files should consider optimizing the post process.

Import Wizard—Step 3: Post Results

1. Access the Post Import Wizard:
   - Continue directly from the Import Wizard—Step 2: Validate Data and select "Post This Session", OR
   - On the task panel select Preparing My Forms > Import New CRS Forms. At the Completed and In-Process Import Session screen highlight any import session with a "Loaded" or "Partial" status and click the "Continue with Session" and then the "Post This Session" buttons.

2. At the Post Import Wizard click "Next" to continue, go "Back" at any time.

3. If any records in the session contain errors or warnings, the user must decide how to handle them. Options include:
   - Do not post records with errors: (Recommended!) Records without errors are posted and problem records are placed on "hold" to be fixed at a later time.
   - Post records with Warnings/Errors: Post all records now. Review individual records and manually update these fields at a later time at the Work With My Tax Forms screen.
4. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the Work With My Tax Forms screen.
   - See Import Session Summary Report.

**Optimize Post**

When posting very large import files, CRS Pro software may run out of RAM and terminate before the Post is complete. Users can modify their INI file to optimize the Post process according to the amount of RAM in the machine running the Post. By default, the Post pauses every 2,000 records to commit new records. Users can increase (or decrease) the number of records processed between commits to speed up the process. Only users importing large amounts of records should consider modifying the default value of 2,000 records.

**Optimize Posting**

1. Close CRS Pro software.

2. In File Explorer go to the Admin folder, e.g., for CRS Pro software go to C: \ 1099 Pro \ ProCRST18 \ Admin, and open the ProCRST18.INI file. See Data Files for exact data paths and INI file names.

3. In the [System] section modify the Post Commit entry (do not enter a comma in the numeric value). This sample entry has the Post set to pause every 2,000 records. Users should experiment with their own numeric values. The entry should look similar to this:

   ```ini
   [System]
   PostCommit=2000
   ```

4. Save changes and exit the INI file.

5. Open your CRS Pro software and post your import.

**Import Files**

* SAMPLE IMPORT FILES *

CRS Pro software includes sample import files. Successful users review our sample import files and incorporate our Header Records into their import files. This ensures an easy, map-by-name import. Please review our Import File Conventions.

**Sample Import File Locations**

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default Import File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRS Pro</td>
<td>C: \ 1099 Pro \ ProCRST18 \ Import \ Samples</td>
</tr>
</tbody>
</table>

* All Software Products *
Import files for ALL 1099 Pro software products are available online via the 1099 Pro WIKI which also includes field specific details for all tax forms.
For customers not interested in using our Header Records or for information on importing other file types, see Delimited or Excel Import Maps.

Instructions for an Easy Import
Review our sample import files PRIOR to creating yours and include our exact Header Records. Watch our Importing Using Standard Maps online video tutorial.

1. Open the C:\1099 Pro\ProCRST18\Import\Samples folder to view all available sample import files. Select and open the appropriate sample file, for example, "Import_CRS_MultipleTabs_Example.xlsx" or "Import_CRS_Example.xlsx".

2. Review the sample data and notice the formatting of the Parent vs Account Holder records, TINs, First and Last Names, Country Codes, etc. Review our Import File Conventions thoroughly before continuing. All Excel files contain additional worksheets with form specific guidance on the various fields and data requirements; only the first worksheet is imported from Excel into CRS Pro.
   - The Import_CRS_MultipleTabs_Example.xlsx sample import file contains the following worksheets:
     - **1 Line Import**: Simplest import. Each line represents a single CRS reportable account. This example has only 1 Payment, 1 Account Holder Name/Address, and no Controlling Persons.
     - **Multiple PMT Import**: Import multiple Payments (PMT) associated with a single CRS reportable account.
     - **Multiple Name Import**: Import multiple Account Holder (AH) names, addresses, TINs, and country codes associated with a single CRS reportable account.
     - **Controlling Person Import**: Import multiple Controlling Persons (CP) associated with a single CRS reportable account.
     - **Full Example ALL Fields**: Import ALL of the above examples in a single import file.
     - **Types**: A complete listing of valid CRS Type Codes and their related definitions.
     - **CC**: A complete listing of valid CRS Country Codes.
     - **Currency**: A complete listing of valid CRS Currency Codes.

3. Copy the "Header Records"—the top row of data containing the respective field names—onto a new Excel sheet. Then enter your live data into the appropriate fields.
   - **Do not place a blank row between the Header Records and the start of your data.**
   - **Do not edit the Header Record descriptions.**
   - **Do not freeze the top row in Excel.**
   - **It is okay to delete columns; however this triggers a "missing field" warning during the import process.**
   - **Only the first worksheet in an Excel document is imported.**

4. Save this excel sheet as a Text (Tab Delimited).TXT file to preserve formatting. Your file is ready to import into the software. Continue to Step 1: Import Data.

Import File Conventions
For a smooth import please thoroughly review these conventions PRIOR to creating your import file. We strongly encourage our users to review the sample import files that are included in our software and available, in a standard installation, at C:\1099 Pro\ProCRST18\Import\Samples. Users
who review the sample import files and include our Header Records have great success with their imports!

The order of data fields is not important and it is okay to have extra fields that won't be included in your import file (e.g., phone number or email address, etc.). For additional import file conventions please refer to the [1099 Pro Wiki site](https://1099pro.com/wiki).

Fields in **RED** are required.

<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
</table>
| **RecordType**        | - **P = Parent** — Each 'P' record represents a new CRS reportable account. The name, address, and birth information on a P record is associated with the Account Holder, not the Controlling Person.  
- **PMT = Payment** — Use "PMT" if more than one Payment is associated with a CRS reportable account. An import file can have unlimited amount payments related to a single CRS account. Each "PMT" record is associated with the nearest Account ("P" Record) that is above it. Each "PMT" Record should only contain payment information in the columns "Payment", "Payment—CurrCode" and "PaymentType" fields.  
- **AH = Account Holder** — Use "AH" if more than one Account Holder / Name / TIN / Address is associated with a CRS reportable account. An import file can have unlimited Account Holders related to a single CRS account. Each "AH" Record is associated with the nearest Account ("P" Record) that is above it.  
- **CP = Controlling Person** — Use "CP" if Account has one or more Controlling Persons. Unlimited CP records are allowed. A "CP" is always an individual/person. This element is not required by the CRS XML schema but some jurisdictions may require it. Each "CP" record is associated with the nearest Account ("P" Record) that is above it.  
- **CPC = Controlling Person (Child)** — Use "CPC" if Controlling Person has multiple names or addresses. Unlimited CPC records are allowed. Each CPC record is associated with the CP record above it. | 3 |

*RecordType sequences must be in either P > PMT > AH > CP > CPC or P > AH > CP > CPC > PMT formats.*

| CP_Type | Controlling Person Types:  
- CRS801 = CP of legal person - ownership  
- CRS802 = CP of legal person - other means  
- CRS803 = CP of legal person - senior managing official  
- CRS804 = CP of legal arrangement - trust - settlor | 6 |
<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
</table>
|                       | 1. CRS805 = CP of legal arrangement - trust - trustee  
|                       | 2. CRS806 = CP of legal arrangement - trust - protector  
|                       | 3. CRS807 = CP of legal arrangement - trust - beneficiary  
|                       | 4. CRS808 = CP of legal arrangement - trust - other  
|                       | 5. CRS809 = CP of legal arrangement - other - settlor-equivalent  
|                       | 6. CRS810 = CP of legal arrangement - other - trustee-equivalent  
|                       | 7. CRS811 = CP of legal arrangement - other - protector-equivalent  
|                       | 8. CRS812 = CP of legal arrangement - other - beneficiary-equivalent  
|                       | 9. CRS813 = CP of legal arrangement - other - other-equivalent  
|                       | This field is required ONLY when doing a Controlling Persons (CP) import. | |
| AccountNumber         |             | |
| Balance               | **Do not use commas or dollar signs**, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250. | |
| BalanceCurrCod        | Enter Currency Codes. Detailed country code information is available in CRS Pro’s sample import file in the Currency worksheet. For example:  
|                       | • **USD = US Dollar:** AMERICAN SAMOA; BONAIRE; SINT EUSTATIUS AND SABA; BRITISH INDIAN OCEAN TERRITORY; ECUADOR; EL SALVADOR; GUAM; HAITI; MARSHALL ISLANDS; MICRONESIA, FEDERATED STATES OF; NORTHERN MARIANA ISLANDS; PALAU; PANAMA; PUERTO RICO; TIMOR-LESTE; TURKS AND CAICOS ISLANDS, UNITED STATES; UNITED STATES MINOR OUTLYING ISLANDS; VIRGIN ISLANDS (BRITISH); VIRGIN ISLANDS (US)  
|                       | • **USN = US Dollar (Next day):** UNITED STATES  
|                       | • **USS = US Dollar (Same day):** UNITED STATES | |
| AH_Type* and AN_Type  | AcctHolderType indicates account is held by either:  
|                       | • CRS007 = Natural Person  
|                       | • CRS101 = Entity - Passive Non-Financial Entity with one or more controlling person that is a Reportable Person  
|                       | • CRS102 = Entity - CRS Reportable Person  
|                       | • CRS103 = Entity - Passive Non-Financial Entity that is a CRS Reportable Person  
|                       | **AND**  
|                       | AcctNumber is the Type of Account Number:  
|                       | • OECD601 = IBAN International Bank Account Number (follows a known structure)  
|                       | • OECD602 = OBAN Other Bank Account Number  
|                       | • OECD603 = ISIN International Securities Information Number (follows a known structure)  
|                       | • OECD604 = OSIN Other Securities Information Number | 7
<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>OECD605</td>
<td>Other Any other type of account number e.g. insurance</td>
<td></td>
</tr>
<tr>
<td><strong>Payment</strong></td>
<td>Do not use commas or dollar signs, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250.</td>
<td></td>
</tr>
<tr>
<td><strong>PaymentCurrCode</strong></td>
<td>Enter Currency Codes. Detailed codes are available in CRS Pro's sample import file in the Currency worksheet. See BalanceCurrCode.</td>
<td></td>
</tr>
<tr>
<td><strong>PaymentType</strong></td>
<td>Type of Payment:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· CRS501 = Dividends</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· CRS502 = Interest</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· CRS503 = Gross Proceeds/Redemptions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· CRS504 = Other CRS (Example: other income generated with respect to the assets held in the account)</td>
<td></td>
</tr>
<tr>
<td><strong>ResCountryCode</strong></td>
<td>Country Codes are available in CRS Pro's sample import file in the CC worksheet.</td>
<td></td>
</tr>
<tr>
<td><strong>TIN</strong></td>
<td>May include alphanumeric characters, dashes, periods and spacing.</td>
<td></td>
</tr>
<tr>
<td><strong>IssuedBy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ORG_INTType</strong></td>
<td>Type of Entity Tax Number (filled in at the FILER / Reporting FI field):</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>· EIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· TIN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· UNKNOWN</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· US GIIN</td>
<td></td>
</tr>
<tr>
<td><strong>NameType</strong></td>
<td>The NameType attribute is the same for Organisations and Persons. Possible values are:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD202 = indiv</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD203 = alias</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD204 = nick</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD205 = aka</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD206 = dba</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD207 = legal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD208 = atbirth</td>
<td></td>
</tr>
<tr>
<td></td>
<td>· OECD201 = SMFAliasOrOther (not used for CRS)</td>
<td></td>
</tr>
<tr>
<td><strong>FirstName</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MiddleName</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Name/Company</strong></td>
<td></td>
<td>40</td>
</tr>
<tr>
<td><strong>Birth_Date</strong></td>
<td>Use MM/DD/YYYY format only. Unacceptable formats include Jan 3, 2018 and January 3, 2018.</td>
<td></td>
</tr>
<tr>
<td>Field (Header Record)</td>
<td>Description</td>
<td>Maximum Characters</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Birth_City</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Birth_CountryCode</td>
<td>Country Codes are available in CRS Pro's sample import file in the CC worksheet.</td>
<td></td>
</tr>
</tbody>
</table>
| LegalAddressType      | Type of Address:  
- OECD301 = residential or business  
- OECD302 = residential  
- OECD303 = business  
- OECD304 = registered office  
- OECD305 = unspecified | 7 |
| Street                | Recipient address line 1 | 40 |
| Suite                 | Recipient address line 2 | 40 |
| City                  | Enter legal US state abbreviation or full country name. | 40 |
| CountrySubEntity      | Enter legal US state abbreviation or full country name. | 40 |
| PostCode              | Enter ZIP or postal codes. For Canada the required format is letter-number-letter, a space, then number-letter-number. For example, "C3H 4W9" is a valid Canadian postal code. | |
| CountryCode           | Enter Country Code. Codes are available in CRS Pro's sample import file in the CC worksheet. | 25 |

**Additional Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check boxes</td>
<td>Use X / Y / T / 1 to mark a checkbox. Leave field blank or use N / F / 0 (zero) to NOT mark checkbox. Values are not case sensitive.</td>
<td>1</td>
</tr>
</tbody>
</table>
| Type of Transmission | Internal CRS Pro Values:  
- OECD0 = Resend Data (not used for CRS reporting)  
- OECD1 = New Data  
- OECD2 = Corrected Data  
- OECD3 = Deletion of Data  
- OECD10 = Resend Test Data (not used for CRS reporting)  
- OECD11 = New Test Data  
- OECD12 = Corrected Test Data  
- OECD13 = Deletion of Corrected Test Data | |

**Delimiters**

A Delimiter is defined as a character used to indicate the beginning and end of a data string. Delimiters can be commas, periods, tabs, spaces or quotes. Users must specify the delimiter for their import file. Upon correctly setting delimiters, each field of your header record should appear on a different line at the Import Data Delimiter screen. If your data displays in one long row or contains strange characters the wrong delimiter was used. Select the appropriate delimiter to correct this problem.

**File Format Choices**

- **Standard Tab Delimited**: Works with all .TAB sample import files and standard .TAB files.
- **Standard Comma Delimited (CSV)**: Works with comma separated value (CSV) files.
• **Pipe**: Works with pipe delimited "|" values.

### Error & Validation Checking

CRS Pro software performs validation checks on your data. This helps users find and fix potential tax form errors (see [Disclaimer](#)) prior to submission to any government entities. Error and validation checks occur whether data is manually entered or imported. It also occurs when generating an XML file. If a problem is detected, the software flags the record with a Warning, Error or Reject Error. Users are encouraged—but not required—to fix warnings and errors prior to submitting their XML filings.

#### Quick Error Scan

Use to quickly scan all records in the CRS Pro software database; on the menu bar select Utilities > Check/Update Error Status For All Forms.

#### Warnings & Errors Defined

Whether importing or manually entering data, CRS software flags any records with Warnings, Errors or Reject Errors. Any record containing a warning or error has an asterisk (*) prefixed to its status at the Work with My Tax Forms screen (e.g., *Pending or *Filed).

<table>
<thead>
<tr>
<th>Type</th>
<th>Defined</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Warnings   | Possible inconsistency or omission in the data that may result in the record failing XML schema validation. | • Invalid or missing Country Code  
• Missing TIN  
• Invalid Box Code |
| Errors     | Serious flaws in the data which will most likely result in failing XML schema validation. | • Missing name for Controlling Person (CP) or Account Holder (AH).  
• Missing IN/TIN Information for CP or AH.  
• Missing address information for CP or AH.  
• Missing ResCountryCode for CP or AH. |
| Reject Errors | Data has not been entered correctly and will result in automatic XML schema failure. | • Missing data in the AH_Type field  
• Field contains non-allowed negative amounts |

#### Find Problem Records

CRS Pro software includes multiple means to locate problem records including:

- **Form Counts Report**: View a concise listing of all Filers including number of warnings and/or errors.
- **Control Totals Report**: View errors and/or warnings in detail by Account Holder and Controlling Person. Users must select the "Extended Version—Errors and Warnings Messages" to access this information.
- **Review Import Records**: Prior to posting import data into the software, users can edit or delete individual records, or abandon an entire import session, during the Import Wizard—Step 2: Validate Data.
• **Error Queries:** Sort records by "Errors Only" or "Errors & Warnings Only" at the Work With My Tax Forms screen.

### Run Error Queries

1. On the task panel select Preparing My Forms > Work With My Tax Forms.

2. At the Enter, Update and View screen use the Current Query drop menu to select "Errors and Warnings Only" or "Errors Only".

3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no problem records for the selected Filer and associated records.
   - Any record containing an error or warning can be fixed provided it has a Pending status.
   - After fixing a problem record it immediately disappears from this list.
   - After fixing all problem records reset the Current Query to "All Records".

### Business Rules/Validation Changes

CRS Pro software includes standard business rules—based on OECD Common Reporting Standard specifications—for detecting errors and/or warnings on tax forms. At their discretion, Administrators can change default validation rules. *Caution: Disabling a business rule does not guarantee acceptance of your XML files* See [Custom Tax Form Validation Rules](#).

### DISCLAIMER

CRS Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

### Feedback

Users who encounter a situation that should possibly generate an Error or Warning in the software are encourage to discuss the situation with 1099 Pro, Inc. at [compliance@1099pro.com](mailto:compliance@1099pro.com). Please indicate the form type, data set and IRS regulations in your correspondence.

### Manage Maps

A map defines the data fields and parameters of an import or export file. CRS Pro software includes [sample import files](#) with corresponding default maps to allow for easy, map-by-name imports. Users can also create their own, custom maps for the importing and/or exporting of tax form data.

### Map Naming Convention

Both import and export maps are saved as TPS data files.

### Import Maps

The Manage Import Maps screen allows users to view both default, built-in import maps and custom maps. This screen lists the type of mapping and the file format used for each map. Additional information includes Map Notes and Formatting Details. See [Import Map Report](#)
Access the Manage Import Maps screen via the Import Wizard > "Add/Update Import Maps" button.

**Add a New Map**
1. In the Import Wizard click the "Add/Update Import Maps" button.
2. To add a new map click the "Add" button. Select **Excel/Delimited** as the map type and follow the steps in the Import Map Wizard.

**Change Existing Map**
Users can highlight an existing import map and click "Change". Default, **built-in maps cannot be modified**; however users can copy them and then modify the copied map. Follow the onscreen steps as the wizard guides you through the process of changing an existing map. Any changes made overwrite the current mappings.

**Delete Existing Map**
1. Highlight the existing map to delete. The user is prompted to confirm their choice, click "OK".
2. An existing mapping cannot be deleted if it is tied to a current import/in-process import session. Any such imports must be completed or abandoned first and then the map can be deleted. Once deleted a map cannot be recovered.

**Export Maps**
An export map is identical to its corresponding import file. For example, the fields contained in the CRS sample import file are automatically included in the default, built-in CRS export file.

**Export a Map**
1. At the Manage Import Maps screen click the "Export Map" button.
2. At the Map Export screen select an export location, confirm onscreen settings and click "Finish" to generate the file.

**View/Print Map Reports**

**Delimited or Excel Import Map Wizard**
CRS Pro software offers custom Import Wizards to simplify the process of creating Delimited/Excel. CRS Pro’s standard Import Wizard and **sample import files** are sufficient for most users; however some users require the ability to add additional fields or apply special formatting to TINs, dates or decimals. See [Import Map Report](#)

**Create Delimited/Excel Import Map**
Import files can be imported in a variety of formats including; delimited, .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length, and Excel (.XLS or .XLSX).

1. On the task panel select Preparing My Forms > Import New CRS Forms.
2. At the Import Sessions screen click the "Import Records from Excel or a Delimited Text File" button.
3. In the Import Wizard continue to the Select the Type of Data and Format to Use screen. Click the "Add/Update CRS Import Maps" button.

4. At the Manage CRS Import Maps screen click the "Add" or "Change" button and select Excel or Delimited as import format.
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

5. The Excel Import Wizard opens. Continue as prompted to the Map the Import Fields/Columns to Data Fields. Options include:
   - **Map By Name**—Use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button. See Combined Address Mapping below.
   - **Drag & Drop Fields**—Manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. Repeat process until all needed fields are assigned. To cancel a match, drag from right to left or double-click on it. See Combined Address Mapping below.
   - **Assign Value**—Assign a fixed value to the selected unmapped field. For example, for the "Rcp TIN Type" field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported Recipients have an identical Recipient TIN type.
     - **Combined Address Mapping**: If your import file uses a Combined City/St/Zip import field instead of the individual City, State and ZIP fields, drag the import field to the Comb City/St/Zip input field—do NOT drag it to the individual City, State and Zip fields. If using the Address Delivery/St and Address Apt/Suite import fields, drag them to their respective input fields. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St input field only. The plus sign indicates Address Lines 1 and 2 have merged for a successful mapping. Drag or map by name all other fields as normal.

6. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
   - Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount, e.g., "10000" = "100.00" in implied decimals. The use of the implied decimal format in delimited file formats is rare.
   - Select date field format options - Various options are available. Indicate if date uses four years, i.e., XXXX, and if date includes separators.

7. At the Specify a Name and Usage Notes for the Import Map screen enter a descriptive title for this map. Users can also add usage notes for further clarification. Click "Next" to continue.

8. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
• Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
• Users can optionally specify a default file name.

9. Review summary settings and click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

Map by Name Method
The Map by Name method is ideal for those import files incorporating CRS Pro's unique import file Header Records and automatically maps all fields with matching names. Users are strongly encouraged to incorporate these Header Records from our sample import files. See Delimited or Excel Import Map.

Import files containing CRS Pro Header Records automatically map during the import process. Some users may prefer to manually map by name and can reference the below instructions.

Perform a Manual Map By Name
At the Map the Import Fields/Columns screen of the Import Wizard, use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button.

When Mapping Street Addresses:
• Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
• Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.
• Drag all other fields as normal.

Drag & Drop Method
The Drag & Drop method is ideal for those import files containing unique header records or no header records. Users are strongly encouraged to incorporate Header Records from our sample import files. See Delimited or Excel Import Map.

At the Map the Import Fields/Columns screen of the Import Wizard, click on any field from the left column (Input Field Name) and drag it across to the corresponding field in the right column (Mapped Field Destination). Repeat process until all needed fields are assigned. If the wrong field is accidentally assigned, double-click the mapped field and the information is removed.

When Mapping Street Addresses:
• Drag the Combined City/St/Zip Available Input Field to the Combined City/St/Zip Input Field. Do not drag it to the individual City, State and Zip fields. Performed correctly, (Combined City/St/Zip) appears at each of the individual City, State and Zip fields. The parentheses indicate a successful mapping.
• Drag the Address Delivery/St available Input Field to the Address Delivery/St Input Field. Then drag the Address Apt/Suite available Input Field to the Address Apt/Suite Input Field. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St Input Field only. The plus sign indicates Address Lines 1 & 2 have merged for a successful mapping.
• Drag all other fields as normal.

Customize Delimited Fields
During the import of Delimited files, Users have the option to customize the values of select mapped field. See Delimited Import Map.

Customize a Field during Delimited Import
1. In the Delimited Import Wizard, at the Map the Import Fields/Columns to Your Data Fields screen, highlight any mapped field. Onscreen button options include:
   • Assign Value — Use the "Assign Value" button if the selected field should have a fixed value assigned to every record in the import. For example, for the "Rcp TIN Type" field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported Recipients have an identical Recipient TIN type.
   • Rename Field — Some fields cannot be assigned a fixed value, such as Recipient TIN. Such fields must be unique to each record and can be renamed only. Use the "Rename Field" button to rename the import field.

Maps: Import/Export
Users can import and export customized import maps. Those users NOT running CRS Pro software in a multi-user environment—but requiring standardized import maps for multiple single-user installs—will benefit from the ability to share maps. Import maps are saved in a .TPS format and cannot be edited or viewed in applications outside of the Manage Import Maps utility in this software.

Note: Prior year import maps can be "rolled forward" during the software installation process; however if the 2018 tax form has changed, the 2017 map is thus outdated and will not roll forward.

Export Map
1. At the Manage Import Maps screen highlight any map and click the "Export Map" button.
2. At the Map Export screen select an export location, confirm onscreen settings and click "Finish" to generate the file.
   • By default, maps are exported to the Maps folder in the MAP IMPORT FFF (Form Type) IDnnn MM-DD-YY HH-MMxM.TPS format, e.g., "MAP IMPORT CRS ID364  7-20-2018  8-09AM.TPS".

Import Map
1. At the Manage Import Maps screen click the "Import Map" button.
2. At the Import Map screen browse for the .TPS import map and click "Finish".
   • By default, maps are saved to the Maps folder. Maps are automatically associated with the corresponding form type and immediately available for selection at the Select the Type of Tax Form screen in the Import Wizard.
Import Map Report
The Import Map Report is an invaluable tool for reviewing import map specific data including:
- Form type
- Creation Date and Time of the Import Map
- Account Holder's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Creation Date and Time of the Report including the Network Station ID
- Field Name, Field Type and Field Description

Run Import Map Report
1. On the menu bar select Utilities > Run the Import Wizard.
2. Select the "Import Records from Excel or a Delimited Text File" button to initiate the Import Wizard.
3. At the Select the Type of Data screen in the Wizard, click the "Add/Update (form type) Import Maps" button.
4. Highlight any import map and click the "View/Print Map" button
5. The user is prompted to preview the report.

Import Session Report
Also referred to as the Amount Totals Report, the Import Session Summary Report generates a log specific detail of an import file. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Undocumented Accounts, Closed/Deleted Accounts and Account Balance. See Reset/Void Import Session

Run Report
1. On the task panel select > Preparing My Forms > Import New CRS Forms.
2. At the Completed and In-Process Import Sessions screen highlight an import session and click the "Amount/Totals Report" button.
3. The "Amount/Totals Report" button is ghosted for any session with a status of Abandoned or Reset/Void.
4. The Report Options screen prompts to:
   - Select the Printer — Consider printing to PDF to save paper.
   - Select the Sort Order—By Last Name/First Name or by TIN.
   - Preview before printing.
   - Print Summary totals only.
5. Click "OK" to generate the report or "Cancel" to exit the report.

Reset/Void Import Session
What Happens When an Import Session Is Reset
When an import session is reset (voided), all CRS forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as Pending and then some are updated to Filed XML status, only the Pending records are deleted.
If this was a partial import and records have a Loaded status, users must first highlight the session, click the "Continue with Session" button and then "Abandon the Session" to remove the session.

**Reset/Void Import Session**
Once an import session is reset/void it cannot be reversed.

1. On the task panel select Preparing My Forms > Import New CRS Forms.
2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.
3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel.
   - The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

**Form Totals Report**
The Control Totals report is an invaluable tool for reviewing Account Holder records and pinpointing Errors and Warnings. Information contained in this report includes:

- Filer/Reporting FI's Name, TIN and PCode
- Account Holder's Name, TIN, Account Number and Address
- Individual record print status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

**Run Control Totals Report**
1. Use the "Select Another Filer" button to choose the Filer/Reporting FI to generate report for.

2. On the menu bar select Reports > Form Control Totals.

3. At the View/Print Control Totals Report screen select a printer. *Consider printing to PDF to save paper.*

4. Report Filter and Form Selection Options—Choose a method for selecting records:
   - All Pending Originals for this Filer
   - All forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)

5. Error and Warning Messages—Choose how to print warnings and/or errors. *This option is only available if Extended Version is selected* under Report Format Options, below.
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors

6. Report Record Ordering Options—Choose how to sort the records:
• By Last Name
• By TIN
• By Account Number, then Last Name

7. Report Format Options—Choose a report format:
• Summary Version (amounts only, no address, text or error/warning detail)
• Extended Version (all form details including address and errors/warnings)
• Additional options include:
  o Add custom notes for this report run
  o Print totals only (suppress individual form details)
  o Print preview

8. To generate report click "Print Now".
• At the preview screen go to the last page to view box-by-box totals.

Print Preview
The Preview screen allows users to view a report and check it for accuracy before printing.

Print Preview Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Print THIS page only.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>View the PREVIOUS page.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>View the NEXT page.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Toggle STAY after printing.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Search for characters within a report.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Access the &quot;Print Setup&quot; screen to print the entire report.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Exit the preview report WITHOUT printing.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>View the preview report in full WIDTH view.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>View the preview report in full HEIGHT view.</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Save report in PDF format.</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Set zoom percentage; range is 25 to 250%.</td>
</tr>
</tbody>
</table>

Duplex Printing
All 1099 Pro software products support duplex printing. Not all printers or print drivers offer this feature; review the printer manual for specifications.
**Duplex Print**
1. At the Print Preview screen initiate a print session via the "Printer" icon.
2. At the Select Printer Screen, click the "Properties" button for your printer.
3. Click the Finishing tab, then locate the area "Document Options" on this screen.
4. Place a check in the box to "Print on both sides".
5. Click "OK" and proceed to print the job.

**Create XML**

**XML Overview**

**What Is An XML File?**
Per the OECD, a schema is a data structure to transmit data and XML is the IT-based language used for this purpose. Each XML file contains specific data elements and descriptive attributes as detailed in the OECD's [Common Reporting Standard User Guide and Schema](#). CRS Pro formats data into the XML V1.0 per these specifications.

The Electronic Filing Session window contains the FATCA XML functionality available in CRS Pro software. Access the Electronic Filing Session window via the task panel > Create XML > XML OECD.

**Electronic Filing Wizard**
The eFile Wizard is designed to simplify the process of generating electronic (XML) files. Users are encouraged to generate their electronic files towards the end of the filing window. This allows users the maximum amount of time to correct any errors before filing with the IRS/SSA or other agency. Learn about the [XML File Session](#) screen.

Related Topics:
- [XML Wizard](#)
- [XML Failed Schema Validation](#)
- [XML to Excel](#) (to review Test or Production data)
- [XML Envelopes / Additional Specifications](#)
- [CRS Packager](#)

**XML File Session Window**
The Electronic Filing Session window contains the XML generation and NIL report functions available in CRS Pro software. Access this screen via the task panel > Create XML > XML V1.0 OECD.

**Electronic File Formats**

<table>
<thead>
<tr>
<th>eFile Format</th>
<th>Accessed Via</th>
</tr>
</thead>
<tbody>
<tr>
<td>XML File</td>
<td>&quot;Create an OECD XML File&quot; button.</td>
</tr>
<tr>
<td>NIL Report</td>
<td>&quot;Create a NIL Report&quot; button.</td>
</tr>
</tbody>
</table>

**Completed eFile Sessions List**
This screen is composed of logs detailing all electronic (XML) files generated via the XML wizard.
Column | Description
--- | ---
Log ID | A unique number assigned to each file generated by the XML Wizard.
Session | A number assigned to any group of files generated together by the XML Wizard. One session can include multiple logs.
# Forms | The number of forms generated for a specific log.
Receiving Country | The Jurisdiction being reported to is the receiving country. The XML reporting process is more organized when the Receiving Country Code is used as the first two characters of the Payer Code.
Session Type | The type of transaction for a particular log including "Originals", "Corrections" or "Deletions".
Format | Electronic (XML) or NIL Report
Session Date | The date the session file was created.
Session Time | The time the session was created.
Date Reset | Indicates the date/time a session was voided or reset.
Payer Code | Payer codes or PCodes are unique to each Filer and are visible in the software only.
File Name | Details the file name and location saved.

### Onscreen Options

| Button | Description |
--- | ---
"View/Print Session Report" | Generates an eFile Log Summary report on the currently selected session. |
"Reset (Void) eFile" | Use to Void/Reset the highlighted electronic (XML) filing session including all log IDs associated with that session. See [Reset eFile Session](#). |
"High Level Overview of CRS" | Direct access to the OECD's Automatic Exchange Portal (AEP). |

### XML Wizard

This wizard simplifies the process of creating Original, Corrected, Deleted and Test XML files.

**IMPORTANT:** Special characters are prohibited in XML file generation. The apostrophe (‘), double dash (--), quotation mark (“), and hash (#) symbols are prohibited as they can be used in security threats and will cause the transmission to be rejected with a failed threat detection error notification. Replacing the characters with an entity reference will still cause a rejection.

**Generate XML Files**

1. On the task panel select Create XML > XML OECD.
2. At the Create the OECD XML File screen click the "Create an OECD XML File" button.
3. At the XML Wizard screen review important onscreen information and click "Next" to continue. Click "Back" at any time to go back a step.

4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.

5. Select Filer/Reporting FIs to include via the "Tag" buttons or manually select the Filers to include in this XML file.

6. Specify the File Type and Transmission Medium:
   - New Data
   - New TEST Data: Select test data (not production data) under a dummy Filer. Test data is marked as "filed".
   - Corrected Data: Select records with a Corr/Pending status
   - Corrected TEST Data
   - Deletion of Data: Select records with a Del/Pending status
   - Deletion of TEST Data

7. Select the destination folder. Default location is C:\1099 Pro\ProCRST18\MagFiles.
   - File naming convention is TransmittingCC:YYYY:ReceivingCC:_PayerCode_TypeOfData_SessionID_TimeStamp.XML.
   - If the Filer/Reporting FI's PCode contains any of the following characters, \ / : * " < > |#, they are stripped from the XML file name.
   - Some Jurisdictions have specific naming conventions.

8. Set Reporting Period: The default period is the last day of the tax year being reported. Any date within the Tax Year installation of CRS Pro can be selected. For example, in a CRS Pro 2018 installation, only 2018 Reporting Periods are allowed. Click "Next" to continue.

9. At the Ready to Generate XML File(s) screen review settings and if satisfied click "Finish" to start the XML file generation.

10. The Progress screen tracks your Electronic File Generation Process and indicates total files created. Click "OK" to exit this screen.

11. Return to the Completed XML screen and view XML file specific information.
    - If the XML failed schema the file name is prefixed with "FailedSchema", see XML Failed Schema Validation Wizard.
    - If the Filer/Reporting FI’s PCode contains any of the following characters, \ / : * " < > |#, they are stripped from the XML file name.
    - Click the "Visit the OECD Site" button for direct access to the Automatic Exchange Portal (AEP).

**XML Record Limits**

CRS Pro allows users to limit the number of XML records in a file to effectively constrain the file size. Some receiving countries have a maximum file size they will accept; for example, Japan has a 19 MB limit. **Each record typically requires 0.006 MB.** Thus if Japan has a 19 MB limit, set the Record Limit for Japan to 3,000 records (wherein 19 MB / .006 MB = ~ 3,000 records). It is the user’s responsibility to verify that an XML file created does not exceed the limits imposed by the Receiving Country. In some instances it may be necessary to further lower the Record Limit if files contains multiple Payments, Account Holders, Controlling Persons or Children.

Edit file size limits via the menu bar > File > Security & Administration > Program Options > Set XML Record Limits.
XML to Excel
Use Microsoft Excel® to analyze Test or Production XML files created in CRS Pro. See Generate XML Files.

Review ALL Information
To view ALL of the information in your XML file in an Excel® spreadsheet, open a blank spreadsheet in Excel and drag the .XML file onto the blank spreadsheet. Wait a few seconds until the Open XML popup displays (as shown below) and choose to open the file "As an XML Table".

The spreadsheet with your XML data will include a lot of duplicate information; consider deleting all of the columns to the left of Column AD (DocRefid3) EXCEPT Columns C, D and N which (i.e., TransmittingCountry, ReceivingCountry and FilerName). In the Column AccountNumber are many blank rows. All of the data associated with this AccountNumber is located to the right of the AccountNumber column on this row and the following blank rows. Data for the next account number starts when you see a new AccountNumber similar to the below image.

Review Balance and Payment Information
Customized Excel file for opening an XML file to review balance and payment information.
1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST18\Maps) open **CRS_Pro_TY2018_Payments_And_Balance.xlsx**.
2. From the Excel menu bar click Developer > Import. If the Developer tab is not visible see Show Developer Tab below.
3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST18\MagFiles). Double-click on the .XML file.
4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.

**Comprehensive XML Review**

Customized Excel file for opening an XML file to review detailed, comprehensive information.

1. From your CRS Pro installation (typically located at C:\1099 Pro\ProCRST18\Maps) open **CRS_Pro_TY2018_Comprehensive.xlsx**.
2. From the Excel menu bar click Developer > Import. If the Developer tab is not visible see Show Developer Tab below.
3. Browse to locate your .XML file with the data to import (typically located at C:\1099 Pro\ProCRST18\MagFiles). Double-click on the .XML file.
4. Review your data on the "Import from XML" worksheet of the Excel file. The XML data auto-fills the columns. Save your data to a different file name using the "File" and "Save As" options.

**Show Excel Developer Tab (If Not Visible)**

If the Developer tab is not displayed in the top ribbon of Excel, use the following instructions from the Microsoft Support website.

**In Excel 2010, 2013 and 2016:**
1. Click File > Options.
2. Click the Customize Ribbon category.
3. Under Main Tabs, check the Developer box, and click "OK".

**In Excel 2007:**
1. Click the Microsoft Office Button > Excel Options.
2. Click the Popular category.
3. Under Top options for working with Excel, check the Show Developer tab in the Ribbon box, and click "OK".

**XML Envelopes & Additional Specs**

**Overview of Common Reporting Standard (CRS)**

The XML sent from a Sending Country to the Receiving Country is composed of groups and subgroups similar to the below:

- **MessageSpec** Sending and Receiving Countries, contact information (from the Filer/ReportingFI)
- **CrsBody**
- **Reporting FI** Information on the organization reporting (from the Filer/ReportingFI)
- **Reporting Group**
- **AccountReport**
- **DocSpec** - is this original, correction or deletion with unique identifiers
The information below is normally imported but small volumes can be manually keyed in:
- AccountNumber and other attributes
- AccountHolder name, birth and address information
- ControllingPerson if an organization or trust who controls
- AccountBalance
- Payment

The Message Spec and Reporting FI information comes from each Filer / Reporting FI that is created. A Filer reports from one sending country to one receiving country (jurisdictions). Filers are manually entered into CRS Pro.

The Account Report information is normally imported from an excel spreadsheet; see Sample Import Files. We recommend users save a copy of their spreadsheet in a text (tab) delimited format if their spreadsheet has more than 1,000 rows.

**CRS Variations by Country**

*Note: The following conventions are triggered by the Receiving Country of the Filer.*

<table>
<thead>
<tr>
<th>Receiving Country</th>
<th>Variations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hong Kong</td>
<td>HK is supported including the AEOI ID and the <a href="http://www.dsf.gov.mo/download/AEOI/sysDocs/XMLSchemaUserGuide_v1.2.pdf">hk_xmlschema_v1.0</a></td>
</tr>
<tr>
<td>Japan</td>
<td>JP is supported including the special formatting of the MessageRefID where the Filer INtype=JPCN and the receiving country is JP as well as guidelines to limit the file size to 19MB.</td>
</tr>
<tr>
<td>Germany</td>
<td>DE support is being finalized for the ELMA and the ELMACS XML Envelope.</td>
</tr>
<tr>
<td>Luxembourg</td>
<td>LU support is being finalized for the Luxembourg XML Envelope &lt;AEOI_LUX&gt;.</td>
</tr>
</tbody>
</table>

Some jurisdictions have additional specifications which require a customized AEOI XML envelope. 1099 Pro Technical Support handles these on a case-by-case basis at support@1099pro.com. Please provide the jurisdiction variation AND a hyperlink to the specification for support with such envelopes.

**CDOT**

CRS Pro does not support CDOT; also referred to as "UK FATCA". UK FATCA is being phased out and will ultimately be replaced by the Common Reporting Standard. HMRC UK AEOI Submission v2.0 schema is not supported.
Reset XML Session

To reset/void an XML session automatically resets all records in that session to their pre-XML Filed status. For example, a record that prior to XML filing had a Pending status will return to Pending status and is thus available for edits and/or inclusion in a new XML file session.

Reset Session

1. On the task panel select Create XML > XML V1.0 OECD.
2. At the Completed XML List screen highlight a session and click the "Reset (Void) Session" button.
3. The Administrator prompts, "Are you sure that you want to RESET/VOID this XML session?" Click "Yes" to proceed or "No" to cancel.
   - The "Trans Type" column indicates that the session has been voided.
   - The Reset/Voided column indicates the date the session was voided.

CRS Packager

The CRS Packager allows users to encrypt XML files per the guidelines of the Receiving Country of a Filer. This feature is presently required only when reporting to Macau (MO). The CRS Packager is available to registered users of CRS Pro; it is not available in DEMO mode.

Package XML File

Users must create their Macau (MO) XML file prior to this process.

1. On the task panel select Create XML > CRS Packager.
2. At the top of the CRS Packager screen select the "Package/Encrypt" radio button.
3. Step 1: Browse for the CRS XML File, the XML file must have **MO as the Receiving Country of the Filer**. Typically the XML file is located at C:\1099 Pro\ProCRST18\MagFiles.
4. Step 2: Browse for your Digital Certificate or private key, regardless of which is selected the other is chosen as well, provided the associated file has the same naming convention and is located in the same folder. For example, selecting XYZ123.crt prompts the software to look for XYZ123.key. Enter the digital certificate passphrase if required.
5. Step 3: Select a recipient certificate. The default recipient certificate issued by Macau and included in CRS Pro, "cert.p7c", was current as of March 9, 2018. It is the user's responsibility to verify there is not a more recent certificate available.
7. Step 5: Click the "Create" button to create the package. The digital certificate is verified. If a passphrase is required it is validated.
8. This process combines your XML and certificate information into a .ZIP file which is then signed by the key.
9. The resulting .ZIP file for Macau consists of two encrypted files which must be uploaded to the Macau Filing Authority.
Note: The Unpackage / Decrypt button is dimmed and reserved for future use.

NIL Reports

Who Must File NIL Reports? What Is The Submission Procedure?

Filing of nil returns. A jurisdiction may require the filing of a nil return by a Reporting Financial Institution to indicate that it did not maintain any Reportable Accounts during the calendar year or other reporting period. The Model FATCA IGAs do not require nil returns but this could be required by local law.

Generate NIL Report

Prior to generating a NIL Report please view the online video, How to Create a NIL Report with CRS Pro Professional. CRS Pro only allows a NIL Filer to create a NIL Report; see Create a NIL Filer below.
1. On the Create XML task panel select "XML V1.0 OECD".
2. At the Create XML File or NIL Report screen click the "Create a NIL Report" button.
3. In the NIL Report Wizard review important onscreen information. Click "Next" to continue or "Back" at any time to go back a step.
4. for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Tag Filers to include in the report. Click "Next".
6. Select the Type of File to create. Click "Next".
7. Review the default destination folder for the NIL report; in a standard installation this is C:\1099 Pro\ProCRST18\MagFiles. Click "Next" to continue.
8. Review Contact and Company information and update as necessary. The default Reporting Period for the NIL Report is year-end, i.e., 12/31/2018, but may be edited as needed. Click "Next".
9. Review onscreen settings then click "Finish" to generate the report.

Create a NIL Filer
CRS Pro only allows a NIL Filer to create a NIL Report.

1. On the Reporting F1 task panel select "My Filers List".
2. At the Filer Master List screen add a new Filer or edit an existing Filer.
   • The "Filer Is Used ONLY for NIL Reporting" checkbox must be marked. This box is not available if editing a Filer with existing data.
   • A Payer Code (PCODE) is required, but the Filer/Agent EIN is not.
3. Click "Save".

Country Specific Formats
Andorra Reporting Format
Per the Andorra domestic reporting format:
1. **Element Tags** are revised from "<crs:" to "<crsad:".
2. **DocRefId** for FI is Format:
   
   
   
   
   
   AR when the DocRefId is an AccountReport and FI when it is a ReportingFI.

3. Where the **National TIN (NRT)** comes from the Filer Record, blue highlighted row.

4. And the **Presentation Code** is prompted for at the end of the XML generation.
5. As required in the reporting message see below:

**British Virgin Islands Reporting Format**

The BVI requires a separate XML file for each ResidentialCountryCode for the Account Holder. With the latest software update, CRS Pro splits the XML file into separate XML files for each reportable jurisdiction. Additional formatting is required for VG CRS Code for "Virgin Islands, British" as detailed below.

**British Virgin Islands (VG) Special Adaptation**

If the FI has VG as the Receiving, Transmitting and ResCountry, then

In each report the `<crs:ReportingFI>` would have `<crs:ResCountryCode>VG</crs:ResCountryCode>`. The `<crs:MessageSpec>` would show VG as the Transmitting Country with CA or CN being the Receiving Country. Within an XML file all of the Account Holders would be either CA or CN.

CRS Pro does not make any adjustments for Controlling Persons.
Filing via OECD

OECD Overview

What Is the Organisation for Economic Co-operation and Development (OECD)?
"The mission of the Organisation for Economic Co-operation and Development (OECD) is to promote policies that will improve the economic and social well-being of people around the world." The OECD is comprised of a Council composed of one representative per member country, plus a representative of the European Commission, various Committees and led by a Secretariat. Please see About the OECD.

Filing Status—Am I Done?

Users often ask; Am I Done? 1099 Pro, Inc. cannot definitively answer this question for you. You are responsible for tracking and monitoring the status of your XML filing(s).

View XML List

Open your software and on the task panel select Create XML > XML OECD. At the Completed XML List screen all generated XML files are listed. It is your responsibility to package your XML files (if necessary) and successfully post and monitor your files on the appropriate jurisdiction or agency site.

IMPORTANT: When creating an XML file, all associated records display a "Filed Mag" status at the Work With My Tax Forms screen EVEN IF the actual XML file has NOT been posted on any agency site! It is your responsibility to ensure that you successfully transmit your XML files in a timely manner and receive confirmation that your files have been accepted by the appropriate jurisdiction or agency.

XML Failed Schema Validation

XML V1.0 OECD Failed Schema Validation

Users receive the following message if an XML file fails Schema Validation during XML generation. To determine why the file failed validation, both an .XML file and a .TXT log file are generated which flag the line number(s) where the file failed schema. In almost all cases the error is because of missing or incorrect data.
XML files that fail validation have the prefix "FailedSchema" added to the beginning of the normal file name which is composed as below where **TransmittingCC** is the Transmitting Country Code and **ReceivingCC** is the Receiving Country Code of the Filer (Reporting FI). These files are located, in a standard installation, at C:\1099 Pro\ProCRST18\MagFiles.

**Typical File Naming Convention:**
TransmittingCC:YYYY:ReceivingCC:_PayerCode_TypeOfData_SessionID_TimeStamp.XML

**Example Failed XML Name:**
FailedSchema_AD2016AD_AH_NAME_TestNew_24_2017-06-23 9-53AM.xml

**Example Failed Log File with Line Numbers in it:**

**Log Files look similar to the following:**
File failed validation check:

**What Does This Mean?**
- The above tells us that an error in the XML file was encountered at line 41.
- The error occurred when the element Address was encountered.
- The program expected either a TIN or Name element instead. Carefully the review the below XML and notice that there is a TIN element, but no Name element. The Name element is missing!
- Typically schema errors come from one or more missing values for the Header Fields (denoted for illustration purposes below in red). For example a Country Code, Birth Date, First & Last Name, etc Review [Import File Conventions](#) to review required data fields.

```xml
<crs:AccountHolder>
  <crs:Individual>
    <crs:TIN issuedBy="TR">TINTIN1</crs:TIN>
    <cfc:Address legalAddressType="OECD303">
    </cfc:Address>
  </crs:Individual>
</crs:AccountHolder>
```

© 2018 1099 Pro, Inc.
Examples

Where a box has a solid line or a notation is made, the data is required and is ordered as shown. For example, in the Individual listed above, the XML starts with **ResCountryCode**, then with the optional TIN and then Address. However, as displayed below in Image 1, the XML requires the Name element before the Address element. Thus, the error at Address in line 41 is triggered because the required Name information—which should have been preceding the Address—is missing!

AccountHolder_Type/Individual

![Image 1](image_url)

Here are other elements and how they are sequenced.
ControllingPerson_Type/Individual

AccountHolder_Type/Organisation

Balance is required.
Both are required if you have payments.

The account number is required.
complexType NamePerson_Type

description
The user must spread the data about the name of a party over up to six elements. The container element for this will be 'NamePxy'.

attributes

- nameType
  - title
    - PrecedingTitle
      His Excellency, Estate of the Late ...
    - Title
      0..∞
      Greeting title. Example: Mr, Dr, Ms, Her, etc. Can have multiple titles.
  - FirstName
  - MiddleName
    - 0..∞
    Middle name (essential part of the name for many nationalities). Example: Sakh in "Nivetha Sakh Shanha", Can have multiple middle names.
  - NamePrefix
    - de, van, van de, von, etc. Example: Derick de Clarke
  - Surname
    - 0..∞
    Represents the position of the name in a name string. Can be Given Name, Forename, Christian Name, Surname, Family Name, etc. Use the attribute "NameType" to define what type this name is. In case of a company, this field can be used for the company name.
  - GenerationIdentifier
    - Jnr, Thr Third, III
  - Suffix
    - 0..∞
    Could be compressed initials - PhD, VC, QC
  - GeneralSuffix
Ch. 5 Error Messages

Error messages appear as pop-ups within the software due to user error or a software bug. Many of these errors have simple solutions that can be easily applied by the user, the user’s IT department or 1099 Pro Tech Support. Prior to applying any solution, backup data to avoid any possible data loss.

Most error messages result from one or more of the following issues:
- Inadequate user rights to read/write/modify data files and/or folders; please contact your internal IT support to verify your user rights.
- Incorrectly mapped data file.
- Third party AV programs (anti-virus) removing critical software files.
- Incomplete software updates.
- Minimum TLS 1.1 browser requirement not met.

Common Error Messages & Solutions
- Error Code 0002:0005
- Invalid Record Declaration Error 47
- Unable to Open Required File (ProTips): 2 — File Not Found
- Unable to Open Required File (ProTips): 3 — Path Not Found
- Unable to Open SystemID: 2 — File Not Found
- Unable to Open SystemID: 3 — Path Not Found
- Unable to Open SystemID: 5 — Access Denied
- Unable to Open SystemID: 53 — Invalid Clarion File
- Clarion Trappable Runtime Errors
- EC002 — Unable to Open Files
- Error Code #0008 — Can’t Find Stub Loader
- Could Not Load DLL Library \USER32.DLL
- Single User Version Error
- File Not Found: Information Request
- Software Not Responding

Authorization Code Error
If an Authorization Code does not work it is almost always because an incorrect version of the software was installed. For example, a CRS Pro 2017 Authorization Code is incompatible with a CRS Pro 2018 installation. Users should verify that the version installed matches the version purchased.

Antivirus Exceptions
CRS Pro software requires full rights to certain folders and subfolders plus a carve-out from any antivirus programs (e.g., Norton, McAfee, Sophos, Kaspersky, Webroot, etc.). This includes full rights and permissions to where the software is installed—which is typically C:\1099Pro—and all subfolders. In the case that your data folder is on a network, users will also need full rights to the Data folder where the .TPS files reside.
Antivirus (AV) programs often prevent installations, software updates and corrupt data files. The following assumes that the software is installed in the default installation locations. Be sure to create exceptions which correspond to where the software is launched from and where your data (.TPS) files reside.

For detailed instructions on setting up a carve-out for 1099 Pro software products please refer to the 1099 Pro WIKI at https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions.

Can't Open Help Files
HTML Help .CHM files are prohibited from opening on network drives due to a Microsoft security patch. All CRS Pro software help files must be installed on the user's local C: drive.

Error Code 0002:0005
Issue
Error Code#: 0002:0005

Solution
Perform a fresh download and install with AV programs disabled.

The first part of the error code (0002) tells us that the LoadLibraryA Windows API call to load the "unpacked" high-performance decompression library (located in the temporary Windows folder) failed. The return value is NULL. The second part of the error code (0005) is the return value from the GetLastError Windows API. It returns a typical ERROR_ACCESS_DENIED = 5 (0x5) = Access is denied error.

This most likely means that the system "blocks" your setup (anti-virus system, anti-spyware system, Windows Defender, etc.) and is caused by a bug in the protection system.

Invalid Record Declaration (47)
Issue
File Access Error: Invalid Record Declaration (47)

Solution
This error occurs when either system latency or anti-virus software interrupts the record-numbering process. Please contact Technical Support to further assist in renumbering records.

Unable to Open Required File (ProTips): 2—File Not Found
Issue
Unable to Open Required File (ProTips): 2—File Not Found

Solution
This error most often occurs if there was an error during installation or an error when mapping the file path to your data folder. First, verify the software is not running from a network location; the software must be run locally, or from a client installation linked to a hosted data file.

The software may be redirected to the correct data file by editing the .INI file:
• Navigate to C:\1099 Pro\ProCRST18\Admin.
• Open the file ProCRST18.INI.
• Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
• Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRST18\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

**Unable to Open Required File (ProTips): 3—Path Not Found**

**Issue**
Unable to Open Required File (ProTips): 3—Path Not Found

**Solution**
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

• Navigate to C:\1099 Pro\ProCRST18\Admin.
• Open the file ProCRST18.INI.
• Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
• Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRST18\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

**Unable to Open SystemID: 2—File Not Found**

**Issue**
Unable to Open SystemID: 2—File Not Found

**Solution**
This error most often occurs if there was an error during installation, or if a third party virus protection software removed CRS Pro program files. Verify the file "Systemid.TPS" exists; located in file path C:\1099 Pro\ProCRST18\Resource. If this file has been removed, or was blocked from installation, you may need to backup your data, then uninstall and reinstall the software. Be sure to list CRS Pro as trusted software in your anti-virus software to avoid having files removed.

If "Systemid.TPS" is present, it's possible that the file path to your data contains unacceptable characters. This can be changed by editing your .INI file:

• Navigate to C:\1099 Pro\ProCRST18\Admin.
• Open the file ProCRST18.INI.
• Locate the file path associated with "SAV:GlobalDataPath".
• Make sure the data file path does not contain a backslash at the end of the path, or any periods if using a UNC. For example: \stationx.1099pro.com\c\xxxx\.
• Save and run the software again.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRST18\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Please contact Technical Support to further assist in renumbering your records.

**Unable to Open SystemID: 3—Path Not Found**

**Issue:**
Unable to Open SystemID: 3—Path Not Found

**Solution:**
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

1. Navigate to C:\1099 Pro\ProCRST18\Admin.
2. Open the file ProCRST18.INI.
3. Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
4. Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRST18\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

**Unable to Open SystemID: 5—Access Denied**

**Issue:**
Unable to Open SystemID: 5 Access Denied

**Solution:**
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your IT department to verify the rights are proper in both the shared location and the folders security settings. If your IT department has confirmed that your security settings are set properly, contact Technical Support for additional assistance.

**Unable to Open SystemID File: 53—Invalid Clarion File**

**Issue**
Unable to Open SystemID: 53 – Invalid Clarion File, Driver Type Topspeed

**Solution**
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternately, the software may be redirected to the correct data file by editing the .INI file:
1. Navigate to C:\1099 Pro\ProCRST18\Admin.
2. Open the file ProCRST18.INI.
3. Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
4. Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\ProCRST18\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

**EC002—Unable to Open Files!**

**Issue:**
EC002—Unable to Open Files!

**Solution:**
This error most often occurs when attempting to restore data from the wrong year (e.g., data from 2017 into CRS Pro for 2018). Users cannot restore data into a different year's software. This is a security measure to ensure that users do not accidentally file the wrong data.

Filer information may be rolled forward during or immediately after installing. For more information, see [Roll Forward Data](#).

**Error Code 0008—Can't Find Stub Locator**

**Issue**
Error Code #0008 - Can't Find Stub Loader / Uninstall Error

This error has been noted when software is uninstalled and then re-installed in Windows 7/8 for those users running Customer Experience Improvement Program (CEIP).

**Solution**
To Modify Windows CEIP Settings on Windows 7:
1. Click Start, select Control Panel, and click the Action Center.
2. In the left pane, click Change Action Center settings.
4. To turn off the Windows CEIP, select "No, I don't want to participate in the program", and then "Save Changes".

**File Not Found: Information Request**

**Solution:**
This error may occur when performing a [Roll Forward](#) procedure if some of the user selected items such as "Prior Year Security Settings" or "Prior Year Import Maps" do not contain data. For example, in the 2017 software security was not used or custom import maps were not created.

The user should click "OK" and continue with the installation.
Could Not Load DLL Library \USER32.DLL

Issue:
Could not load the DLL library C:\Windows\USER32.DLL.
The specified module could not be found.

Solution:
This error occurs when a user does not have full read/write/edit privileges to the location where the
data folder is hosted. Contact your IT department to verify the rights are proper in both the shared
location and the folders security settings. If your IT department has confirmed that your security
settings are set properly, contact Technical Support for additional assistance.

Clarion Trappable Runtime Errors
The following errors can be trapped in code with the ERRORCODE and ERROR procedures. Each error
has a code number (returned by the ERRORCODE procedure) and an associated text message
(returned by the ERROR procedure) indicates the issue.

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 — File Not Found</td>
<td>The requested file does not exist in the specified directory.</td>
</tr>
<tr>
<td>3 — Path Not Found</td>
<td>The directory name specified as part of the path does not exist.</td>
</tr>
<tr>
<td>4 — Too Many Open Files</td>
<td>The total number of file handles available has been used. Check the FILES= setting in the CONFIG.SYS file, or the user’s or network’s simultaneous open files setting in a network environment.</td>
</tr>
<tr>
<td>5 — Access Denied</td>
<td>The file has already been opened by another user for exclusive access, has been left in a locked state, or you do not have network rights to open the file. This error can also occur when no disk space is available.</td>
</tr>
<tr>
<td>7 — Memory Corrupted</td>
<td>Some unknown memory corruption has occurred.</td>
</tr>
<tr>
<td>8 — Insufficient Memory</td>
<td>There is not enough unallocated memory left to perform the operation. Closing other applications may free up enough memory.</td>
</tr>
<tr>
<td>15 — Invalid Drive</td>
<td>An attempt to read a non-existent disk drive has failed.</td>
</tr>
<tr>
<td>27 — Invalid Table Declaration</td>
<td>An attempt to open a table that has an invalid table structure has failed. This is normally found when a Dynamic File has been created incorrectly. Also seen in IP Driver based applications.</td>
</tr>
<tr>
<td>30 — Entry Not Found</td>
<td>A GET to QUEUE has failed. For GET(Q,key), the matching key value was not found, and for GET(Q,pointer), the pointer is out of range.</td>
</tr>
<tr>
<td>32 — File Is Already Locked</td>
<td>An attempt to LOCK a file has failed because another user has already locked it.</td>
</tr>
<tr>
<td>33 — Record Not Available</td>
<td>Usually an attempt to read past the end or beginning of file with NEXT or PREVIOUS. May also be posted by PUT or DELETE when no record was read before the attempted PUT or DELETE.</td>
</tr>
<tr>
<td>35 — Record Not Found</td>
<td>For a GET(File,key), the matching key field value was not found.</td>
</tr>
<tr>
<td>36 — Invalid Data File</td>
<td>Some unknown data file corruption has occurred, or the OWNER attribute does not match the password used to encrypt the file.</td>
</tr>
<tr>
<td>37 — File Not Open</td>
<td>An attempt to perform some operation that requires the file be already open has failed because the file is not open.</td>
</tr>
<tr>
<td>38 — Invalid Key File</td>
<td>Some unknown key file corruption has occurred.</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>40—</td>
<td>Creates Duplicate Key An attempt to ADD or PUT a record with key field values that duplicate another existing record in the file has been made to a file with a key that does not allow duplicate entries.</td>
</tr>
<tr>
<td>43—</td>
<td>Record Is Already Held An attempt to HOLD a record has failed because another user has already held it.</td>
</tr>
<tr>
<td>45—</td>
<td>Invalid Filename The filename does not meet the definition of a valid DOS filename.</td>
</tr>
<tr>
<td>46—</td>
<td>Key File Must Be Rebuilt Some unknown key corruption has occurred that requires the BUILD statement to re-build the key.</td>
</tr>
<tr>
<td>47—</td>
<td>Invalid Record Declaration The data file on disk does not match the file's declaration in the .EXE, usually because you have changed the file's definition in the Data Dictionary and have not yet converted the existing data file to the new format. See Error 47</td>
</tr>
<tr>
<td>48—</td>
<td>Unable to Log Transaction A transaction logout or pre-image file cannot be written to disk. This usually occurs because no disk space is available, or the user does not have the proper network rights.</td>
</tr>
<tr>
<td>52—</td>
<td>File Already Open An attempt to OPEN a file that has already been opened by this user.</td>
</tr>
<tr>
<td>54—</td>
<td>No Create Attribute An attempt to execute the CREATE procedure on a file whose declaration does not include the CREATE attribute.</td>
</tr>
<tr>
<td>55—</td>
<td>File Must Be Shared An attempt to open a file for exclusive access that must be shared. (Legacy error, no longer used)</td>
</tr>
<tr>
<td>56—</td>
<td>LOGOUT Already Active An attempt to issue a second LOGOUT statement while a transaction is already in progress.</td>
</tr>
<tr>
<td>57—</td>
<td>Invalid Memo File Some unknown memo file corruption has occurred. For Clarion data files, this could come from a corrupt .MEM file &quot;signature&quot; or pointers to the memo file in the data file that are &quot;out of sync&quot; (usually due to copying files from one location to another and copying the wrong .MEM file).</td>
</tr>
<tr>
<td>63—</td>
<td>Exclusive Access Required An attempt to perform a BUILD(file), BUILD(key), EMPTY(file) or PACK(file) was made when the file had not been opened with exclusive access.</td>
</tr>
<tr>
<td>64—</td>
<td>Sharing Violation An attempt to perform some action on a file which requires that the file be opened for shared access.</td>
</tr>
<tr>
<td>65—</td>
<td>Unable to ROLLBACK Transaction An attempt to ROLLBACK a transaction has failed for some unknown reason.</td>
</tr>
<tr>
<td>73—</td>
<td>Memo File Missing An attempt to OPEN a file that has been declared with a MEMO field and the file containing that memo data does not exist.</td>
</tr>
<tr>
<td>75—</td>
<td>Invalid Field Type Descriptor Either the type descriptor is corrupt, you have used a name that does not exist in GET(Q,name), or the file definition is not valid for the file driver. For example, trying to define a LONG field in an xBase file without a matching MEMO field.</td>
</tr>
<tr>
<td>76—</td>
<td>Invalid Index String The index string passed to BUILD(DynIndex,string) was invalid.</td>
</tr>
<tr>
<td>77—</td>
<td>Unable To Access Index An attempt to retrieve records using a dynamic index failed because the dynamic index could not be found.</td>
</tr>
<tr>
<td>78—</td>
<td>Invalid Number Of Parameters You did not pass the correct number of parameters to a procedure called in an EVALUATE statement. Note: As of Clarion Version 6.2 (9047), the SQL Drivers now add more information to the trace log file, explaining why the ERRORCODE 78 was generated.</td>
</tr>
<tr>
<td>79—</td>
<td>Unsupported Data Type In File The file driver has detected a field in the file declared with a data type that is not supported by the file system the driver is designed to access.</td>
</tr>
<tr>
<td>80—</td>
<td>Unsupported File Driver Function The file driver has detected a file access statement that is not supported. This is frequently an unsupported form (different parameters) of a statement that is supported.</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>81—Unknown Error</td>
<td>The file driver has detected some error from the backend file system that it cannot get further information about.</td>
</tr>
<tr>
<td>Posted</td>
<td></td>
</tr>
<tr>
<td>88—Invalid Key</td>
<td>An attempt to CREATE a Clarion file driver KEY or INDEX with more than 245 characters. Other file drivers can also return this error when their file system key length limits are exceeded.</td>
</tr>
<tr>
<td>Length</td>
<td></td>
</tr>
<tr>
<td>89—Record Changed By</td>
<td>The WATCH statement has detected a record on disk that does not match the original version of the record about to be updated in a network situation.</td>
</tr>
<tr>
<td>Another Station</td>
<td></td>
</tr>
<tr>
<td>90—File Driver Error</td>
<td>The file driver has detected some other error reported by the file system. You can use the FILEERRORCODE and FILEERROR procedures to determine exactly what native error the file system is reporting.</td>
</tr>
<tr>
<td>91—No Logout Active</td>
<td>The COMMIT or ROLLBACK statement has been issued outside of a transaction frame (no LOGOUT statement has been executed).</td>
</tr>
<tr>
<td>92—BUILD in Progress</td>
<td>A BUILD statement has been issued and PROP:ProgressEvents has been set to generate events. The statement generating this error is not appropriate to execute during a BUILD process.</td>
</tr>
<tr>
<td>93—BUILD Cancelled</td>
<td>The user cancelled the BUILD. This error is set when EVENT:BuildDone is posted.</td>
</tr>
<tr>
<td>94—Record Limit Exceeded</td>
<td>The target file has exceeded the record limit. This value is file driver dependent, and can be returned during any attempt to modify a file where the record limit is exceeded.</td>
</tr>
<tr>
<td>97—Stream Error</td>
<td>Used during RTF processing.</td>
</tr>
<tr>
<td>100—Trigger Error</td>
<td>This error is set whenever a registered file callback method returns FALSE. See CALLBACK.</td>
</tr>
<tr>
<td>1010—Illegal Expression</td>
<td>The EVALUATE procedure has detected an error in the syntax of the expression it is attempting to evaluate.</td>
</tr>
<tr>
<td>1011—Variable Not Found</td>
<td>The EVALUATE procedure has not found a variable used in the expression it is attempting to evaluate. You must first BIND all variables used in the expression for them to be visible to EVALUATE.</td>
</tr>
</tbody>
</table>

**Single User Version Error**

**Issue:**
Single User Version Error

**Solution:**
This error occurs when a user does not have full read/write/edit privileges to the location where the software is installed. Contact your IT department to verify the rights are proper in both the shared location and the folders security settings. If your IT department has confirmed that your security settings are set properly, contact Technical Support for additional assistance.

**Software Not Responding**

**Issue:**
User attempts to open CRS Pro software and it is non-responsive even after user restarts both software and computer. Issue is most likely due to the software attempting, unsuccessfully, to launch the web update during start up.

**Solution:**
In the user's ProCRST18.INI file, typically located at C:\1099 Pro\ProCRST18\Admin, edit the LS=1 line to LS=0 and add LSX=0 and CheckWebUpdate=0. These lines must be edited in the [Preferences] sections of the INI file. Save changes and re-open CRS Pro software.
User should periodically run a manual check for software updates via the CRS Pro menu bar > Help > Check for Updates to CRS Pro.

Ch. 6 Additional Services

Managed Services
The 1099 Pro Managed Services team, IRSCompliance, can maintain your payee and payment database in our secure SOC I Type II environment, or on your secure servers. Managed Services can support current and prior years of tax data for forms 1098, 1099, 5498, W-2G, W-2, 1042-S, 3921, 3922, as well as Puerto Rico payment information. This service includes regulatory support, compliance training, and year-end recipient statements. Users can access the 1099 Pro Corporate Suite software to securely view and print their payee and payment information and perform data queries, either online or through a secure network.

With more than 25 years of experience, IRSCompliance members have real world experience in a variety of industries, and as a result, are experts in federal law, state tax, local tax, and payment types that are subject to reporting. IRSCompliances expertise and efficiency will improve your compliance and minimize financial risk to your company.

CUSTOM AND SCALABLE FEATURES
Federal & state filing for originals and corrections
Quarterly wage reporting
Independent Contractor Reporting
TIN Compliance Management: B-Notices, TIN matching, W-8 and W-9 processing
Balancing and reconciliation
Transaction detail history and audit trails
Penalty abatement
Form 1099-K processing and reporting

OPTIONAL SERVICES
Withholding & deposit services
Policy and procedure development
Regulatory publications, webinars, and events
Standard and custom printing services
Consulting, risk assessment services, and curing
Penalty appeals
Electronic filing services
Electronic payee statement presentment
Electronic solicitation and validation of W-8s & W-9s

1099 Pro, Inc. Sales and Technical Support
(888) 776-1099
sales@1099pro.com
Index

- . -
  .TPS Files  20

- 0 -
  0.006 MB Record Size  101

- 1 -
  1099 Pro Website Security  10

- A -
  Abandon Import Session  96
  About 1099 Pro
    Inc.  3
  About 1099 Pro, Inc.  3
  About Corrections & Deletions  54, 69
  Access Denied  120
  Access Group  35
  Access Groups, Assign Rights  36
  Account Holder Report  48
  Account Holders, Add  62
  Activate Software  6
  Activation Code  6
  Activity Report  40
  Add a Filer  25
  Add a Form  68
  Add a User  38
  Add or Create Records  51, 60
  Adding a Filer  25
  Address Free Element  27
  Address Type  85
  Administration  32
  AEOI XML Envelopes  103
  AH_Type Field  85
  Amount Totals Report  55, 76
  Andorra Changes  1
  Andorra Reporting Format  107
  Antivirus Exceptions  115
  Assign User Profiles  37
  Audit Trail Browser  41
  Audit Trail Report Filters  42
  Audit Trails  64
  Audit Trails Activity Report  40
  Audit Trails, Purge  42
  Authorization Code  6
  Authorization Code Error  115
  Auto Capitalize  43
  AV Errors  115
  AV Install Error  116
  Avoidance Schemes  1

- B -
  Backup Data  21
  Backup Settings  43
  Backup Wizard  21
  BalanceCurrCode  85
  Batch ID Field  66
  British Virgin Islands Reporting Format  108
  Browse CRS Reference Materials  52
  Browse Filers  24, 59
  Browse Map List  91
  Browse Notes  31, 64
  Browse Records  51, 60
  Browser Requirements  10
  Browsing & Working with Entry Forms  62
  Browsing by Form  62
  Bump Code  6
  Business Rule Validations  44
  Business Rules/Validation Changes  45
  BVI Changes  1
  BVI Reporting Format  108

- C -
  Can't Find Stub Loader Error  119
  Carve-Out  115
  Cascading Changes  74
  Category Field  66
  CDOT  103
  CEIP Error  119
  cert.p7c  105
  Change a Filer  26
  Change a Form  68
  Change a Record  51, 60
  Check/Update Error Status  45
<table>
<thead>
<tr>
<th>E</th>
<th>EC002 - Unable to open files!</th>
<th>119</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Data Files</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Data Entry</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Data Entry Preferences</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Data Backup</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Data Input Issues</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Data Path,INI File</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Data Restore</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Deactivate Business Rules</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Decimal Symbol</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Delete a Filer</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>Delete a Form</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Delete a Record</td>
<td>51, 54, 60, 69</td>
</tr>
<tr>
<td></td>
<td>Delete Audit Trails</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>Deletions</td>
<td>54, 69</td>
</tr>
<tr>
<td></td>
<td>Delimited Import Map Wizard</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Delimiters</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Demo</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Demo Mode</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Developer Tab</td>
<td>49, 102</td>
</tr>
<tr>
<td></td>
<td>Different User</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Digit Group Symbol</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Disclaimer</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Display DELETED Records</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Display Issues</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Dollar Amounts</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Done, Uploads</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Duplicate Filer</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Current Sort/View</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Custom Query</td>
<td>51, 60</td>
</tr>
<tr>
<td></td>
<td>Custom Screen View</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Custom Tax Form Validation</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Customer Experience Improvement Program (CEIP) Error</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Customize Delimited Fields</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Customized Import Maps</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Data Files</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Data Entry</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Data Entry Preferences</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Data Backup</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>Data Input Issues</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Data Path,INI File</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Data Restore</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Deactivate Business Rules</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Decimal Symbol</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Delete a Filer</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>Delete a Form</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Delete a Record</td>
<td>51, 54, 60, 69</td>
</tr>
<tr>
<td></td>
<td>Delete Audit Trails</td>
<td>42</td>
</tr>
<tr>
<td></td>
<td>Deletions</td>
<td>54, 69</td>
</tr>
<tr>
<td></td>
<td>Delimited Import Map Wizard</td>
<td>92</td>
</tr>
<tr>
<td></td>
<td>Delimiters</td>
<td>89</td>
</tr>
<tr>
<td></td>
<td>Demo</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Demo Mode</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Developer Tab</td>
<td>49, 102</td>
</tr>
<tr>
<td></td>
<td>Different User</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Digit Group Symbol</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Disclaimer</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Display DELETED Records</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Display Issues</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Dollar Amounts</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Done, Uploads</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Duplicate Filer</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>Current Sort/View</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Custom Query</td>
<td>51, 60</td>
</tr>
<tr>
<td></td>
<td>Custom Screen View</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Custom Tax Form Validation</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Customer Experience Improvement Program (CEIP) Error</td>
<td>119</td>
</tr>
<tr>
<td></td>
<td>Customize Delimited Fields</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Customized Import Maps</td>
<td>95</td>
</tr>
</tbody>
</table>

© 2018 1099 Pro, Inc.
Errors and Warnings by Recipient 47, 97
Errors and Warnings Scan 58
Errors - Import Checking 56, 90
Errors, Clarion 120
European Money Formats 9
Excel, Review XML Files 49, 102
Exclusive Access Required 120
Expiration and Reuse Options 33
Export Data 49, 102

- F -
Failed Schema 109
FATCA Country Codes 82
FFI 29, 72
File Access Error 116
File Already Open 120
File Driver Error 120
File Is Already Locked 120
File Must Be Shared 120
File Not Found 115, 120
File Not Found Information Request 119
File Not Open 120
File Size 101
Filer 25
Filer Listing Report 50
Filer Master List Screen 24, 59
Filer Name / Name Line 2 27
Filer Notes 31, 64
Filer Record Details 27
Files already in use 122
Filing Problems 58
Filing Status 109
Filing via XML 99
Finding & Fixing Problem Records 56, 90
First Time Password 34
Font Settings 8
Foreign Address - Filer 27
Foreign OS Installation 8
Form Control Totals Report 47, 97
Form Counts by Filer Report 48
Form Counts Report 48
Forms Issued By Filer Report 48

- G -
Germany Schema 103

Getting Started 1
GIIN Composition 29, 72
GIIN Format 29, 72
GIIN Validation 72
Global Administrative Options 32
Global Intermediary Identification Number 29, 72
Global Notes 31, 64
Group 35
Group Actions 51, 60, 70
Group - Deleting Pending Tax Forms 70

- H -
Halt 115
Header Records 85
Help File Error 115
HMRC US AEOI Submissions 103
Hong Kong Considerations 1
Hong Kong Schema 103

- I -
Illegal Expression 120
Implied Decimal Formatting 92
Import 32
Import Data 78
Import Errors 56, 90
Import Export Maps 95
Import File Conventions 85
Import Filers 78
Import Files - Sample Files 84
Import Large Files 84
Import Locking: Multi-User Install 17
Import Map Reports 96
Import Overview 55, 76
Import Session Summary Report 96
IMPORT WIZARD - Step 1: Importing Data 78
IMPORT WIZARD - Step 2: Validate Data 80
IMPORT WIZARD Overview 77
Import Files - Sample Files 84
IMPORT WIZARD - Step 1: Importing Data 78
IMPORT WIZARD - Step 3: Post Results 83
Increased User Security 10
Incremental Index 75
INI File 20
INI File, Data Path 16
Install Multi-User Software 16
Install Single-User Software     15
Insufficient Memory     120
Internet     10
Invalid Clarion File     115
Invalid Data File     120
Invalid Drive     120
Invalid Field Type Descriptor     120
Invalid Filename     120
Invalid Index String     120
Invalid Key File     120
Invalid Key Length     120
Invalid Memo File     120
Invalid Number Of Parameters     120
Invalid Record Declaration     120
Invalid Table Declaration     120

- J -
Japan Considerations     1
JPCN     1
Jurisdiction XML Specs     27

- K -
Kaspersky     115
Key File Must Be Rebuilt     120
Keyboard Shortcuts     14

- L -
Language Settings     8
LegalAddressType Header     85
Location Code     27
Logon as Different User     18
LOGOUT Already Active     120
Luxembourg Schema     103

- M -
Macau     105
Macau Schema     103
manage     123
Manage Custom Codes and Text     32
Manage Import Maps     91
Manage Profiles     37
Managed Services     123

Manual Update     18
Map by Name Imports     94
Map Street Addresses     94
Mapping     92
Master Audit Trail Browser     41
McAfee     115
Memo File Missing     120
Memory Corrupted     120
MessageRefID     27
Minimum Password Length     33
MO
     Macau     105
MO Schema     103
MO, Macau     105
Modify Access Rights     35, 36
Multi-User Considerations     17
Multi-User Installations     16

- N -
Navigate Entry Screen     62
Network Import Error     78
Network Install     16
New     1
New User Password Settings     34
NFFE Nil Report     106
NIL Filer     106
NIL Report     99
NIL Reporting     27
Nil Reports     106
No Create Attribute     120
No Logout Active     120
Norton     115
Not Responding     122
Notes     31, 64
Number Settings     9

- O -
OECD Gateway     99
OECD Help     109
OECD Overview     109
OECD XML Schema     53, 100
OECD1 - OECD3     85
OECD1 - OECD3     85
OECD11 - OECD13     85
OECD11 - OECD13     85

© 2018 1099 Pro, Inc.
Index

OECD201 - OECD208 85
OECD201 - OECD208 85
OECD301 - OECD305 85
OECD301 - OECD305 85
OECD601 - OECD605 85
OECD601 - OECD605 85
Optimize Post 84
Optional Field Filters 66
Options for Tax Form Data Entry 65
Override Business Rules 45
Overstated Payments, Error 9

- P -

P Record 85
Packager 105
Password Expiration Options 33
Password Format Options 33
Password Lockout Reset 33
Password Options 33
Password Requirements 33
Password, Administrator Logon 16
Passwords 34
Patches 18
Path Not Found 115, 120
Payer Code 27
PaymentType Header 85
PCode 27
Pending, Uploads 109
PFFI 29, 72
Plus Sign, Mapping 92
PMT Record 85
Post Results 83
Preferences 43
Prefix Override 27
Print an Import Map Report 96
Print Preview 46, 98
Print Users By Name Report 39
Print/View Record Reports 75
Pro Tips 115
ProCRST17.ini 20
Professional to Enterprise Upgrade 15
Profiles 37
Program already in use 122
Program Areas/Functions Report 39
Protected Forms 66
Public Key 105
Purge Access Log-On Records 40
Purge Audit Trail Log Records 42
Purge Access Log-On Records 40

- Q -

Query Wizard 71
Quick Error Scan 56, 90
Quick Tour 11

- R -

Reactivate 45
Record Changed By Another Station 120
Record History 64
Record Is Already Held 120
Record Limit 6
Record Limit Exceeded 120
Record Locking 17
Record Not Available 120
Record Not Found 120
Record Type Sequence 85
RecordType Header 85
Reference Materials 52
Regional Settings 8, 9
Registration & Upgrades 6
Reject Errors 56, 90
Remove Audit Trails 42
Report, Account Holders / Recipients 48
Report, Import Session Summary 55, 76
ResCountryCode Header 85
Reset (Void) Import Session 96
Reset Magmedia Session 105
Reset XML Session 105
Restore Data 22
Review Import Data 80
Rights Summary Report 39
Roll Forward Error 119
Roll Forward Utility 23
Roll Over Filers/Reporting FIs 23
Rule Will Be Changed 45
Runtime Errors 120

- S -

Sample Import Files 84

© 2018 1099 Pro, Inc.
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Button Unavailable</td>
<td>63</td>
</tr>
<tr>
<td>Schema Validation Failed</td>
<td>109</td>
</tr>
<tr>
<td>Search</td>
<td>75</td>
</tr>
<tr>
<td>Search Field, Not Working</td>
<td>67</td>
</tr>
<tr>
<td>Security</td>
<td>32</td>
</tr>
<tr>
<td>Security - Add Users to a Profile: Step 5</td>
<td>39</td>
</tr>
<tr>
<td>Security - Add/Update Individual Users: Step 4</td>
<td>38</td>
</tr>
<tr>
<td>Security - Manage Profiles: Step 3</td>
<td>37</td>
</tr>
<tr>
<td>Security Access Log</td>
<td>40</td>
</tr>
<tr>
<td>Security Audit</td>
<td>8</td>
</tr>
<tr>
<td>Security Password Options</td>
<td>33</td>
</tr>
<tr>
<td>Security Reports</td>
<td>39</td>
</tr>
<tr>
<td>Security Settings</td>
<td>33</td>
</tr>
<tr>
<td>Security - Add Users to a Profile: Step 5</td>
<td>39</td>
</tr>
<tr>
<td>Security - Add/Update Individual Users: Step 4</td>
<td>38</td>
</tr>
<tr>
<td>Security - Manage Profiles: Step 3</td>
<td>37</td>
</tr>
<tr>
<td>Security, TLS 1.1</td>
<td>10</td>
</tr>
<tr>
<td>Select Filer</td>
<td>59</td>
</tr>
<tr>
<td>services</td>
<td>123</td>
</tr>
<tr>
<td>Set Password Requirements</td>
<td>33</td>
</tr>
<tr>
<td>Setup Builder Error</td>
<td>116</td>
</tr>
<tr>
<td>Sharing Violation</td>
<td>120</td>
</tr>
<tr>
<td>Show Excel Developer Tab</td>
<td>49, 102</td>
</tr>
<tr>
<td>Single User Version Error</td>
<td>122</td>
</tr>
<tr>
<td>SOC I Type II</td>
<td>8</td>
</tr>
<tr>
<td>Software Not Responding</td>
<td>122</td>
</tr>
<tr>
<td>Software Updates</td>
<td>18</td>
</tr>
<tr>
<td>Sophos</td>
<td>115</td>
</tr>
<tr>
<td>Source Field</td>
<td>66</td>
</tr>
<tr>
<td>Special Characters in XML</td>
<td>53, 100</td>
</tr>
<tr>
<td>Special Help Button</td>
<td>12</td>
</tr>
<tr>
<td>Status Overview</td>
<td>66</td>
</tr>
<tr>
<td>Step 3: Final Import / Post Results</td>
<td>83</td>
</tr>
<tr>
<td>Step 2 - Validate your Data</td>
<td>80</td>
</tr>
<tr>
<td>Stream Error</td>
<td>120</td>
</tr>
<tr>
<td>Switch user</td>
<td>18</td>
</tr>
<tr>
<td>System Requirements</td>
<td>8</td>
</tr>
<tr>
<td>System Security Settings/Password Requirements: Step 1</td>
<td>33</td>
</tr>
<tr>
<td>SystemID.TPS Error</td>
<td>117</td>
</tr>
<tr>
<td>Tag Access Groups</td>
<td>36</td>
</tr>
<tr>
<td>Tag Records</td>
<td>14</td>
</tr>
<tr>
<td>Tagging Records</td>
<td>75</td>
</tr>
<tr>
<td>Tax Form Notes</td>
<td>31, 64</td>
</tr>
<tr>
<td>Technical Support</td>
<td>13</td>
</tr>
<tr>
<td>the specified module could not be found.</td>
<td>120</td>
</tr>
<tr>
<td>TLS 1.1</td>
<td>10</td>
</tr>
<tr>
<td>Too Many Open Files</td>
<td>120</td>
</tr>
<tr>
<td>TOP SPEED</td>
<td>115</td>
</tr>
<tr>
<td>Tour</td>
<td>103</td>
</tr>
<tr>
<td>TPS Files</td>
<td>20</td>
</tr>
<tr>
<td>Transaction Limit</td>
<td>6</td>
</tr>
<tr>
<td>Transfer Data</td>
<td>23</td>
</tr>
<tr>
<td>Trappable Runtime Errors</td>
<td>120</td>
</tr>
<tr>
<td>Trigger Error</td>
<td>120</td>
</tr>
<tr>
<td>Troubleshoot Import Issues</td>
<td>78</td>
</tr>
<tr>
<td>Troubleshooting Control Totals</td>
<td>48</td>
</tr>
<tr>
<td>Turn On/Off Security</td>
<td>39</td>
</tr>
</tbody>
</table>

- **U** -

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>UK FATCA</td>
<td>103</td>
</tr>
<tr>
<td>Unable To Access Index</td>
<td>120</td>
</tr>
<tr>
<td>Unable To Log Transaction</td>
<td>120</td>
</tr>
<tr>
<td>Unable to Open Required File (ProTips): 2 - File Not Found</td>
<td>116</td>
</tr>
<tr>
<td>Unable to Open Required File (ProTips): 3 - Path Not Found</td>
<td>117</td>
</tr>
<tr>
<td>Unable to Open SystemID file: 53 - Invalid Clarion File</td>
<td>118</td>
</tr>
<tr>
<td>Unable to Open SystemID: 2 - File Not Found</td>
<td>117</td>
</tr>
<tr>
<td>Unable to Open SystemID: 3 - Path Not Found</td>
<td>118</td>
</tr>
<tr>
<td>Unable to Open SystemID: 5 - Access Denied</td>
<td>118</td>
</tr>
<tr>
<td>Unable To ROLLBACK Transaction</td>
<td>120</td>
</tr>
<tr>
<td>UNC Mapping</td>
<td>16</td>
</tr>
<tr>
<td>Unfiled Forms Summary Report</td>
<td>45</td>
</tr>
<tr>
<td>Uninstall Software</td>
<td>20</td>
</tr>
<tr>
<td>Unknown Error Posted</td>
<td>120</td>
</tr>
<tr>
<td>Unlock Records: Multi-User Install</td>
<td>17</td>
</tr>
<tr>
<td>Unsupported Data Type In File</td>
<td>120</td>
</tr>
<tr>
<td>Unsupported File Driver Function</td>
<td>120</td>
</tr>
<tr>
<td>Update a Record</td>
<td>62</td>
</tr>
<tr>
<td>Update Software</td>
<td>18</td>
</tr>
<tr>
<td>Update Users</td>
<td>38</td>
</tr>
<tr>
<td>Updates, Workstations</td>
<td>18</td>
</tr>
<tr>
<td>Upgrade</td>
<td>6</td>
</tr>
<tr>
<td>Upgrade Professional to Enterprise</td>
<td>15</td>
</tr>
<tr>
<td>Upgrade Single-User/DEMO to Multi-User</td>
<td>16</td>
</tr>
<tr>
<td>User Detail Report</td>
<td>39</td>
</tr>
<tr>
<td>User Group Detail Report</td>
<td>39</td>
</tr>
</tbody>
</table>

© 2018 1099 Pro, Inc.
USER32.DLL        120

- V -

Validation        72
Validation Checking        56, 90
Validation Failed XML        109
Validations, Business Rules        45
Variable Not Found        120
VG Special Adaptation        108
Video Display Issues        8
View a Map Report        96
View Deleted Forms        68
View Only Access Rule        36
Virgin Islands        108
Virtual Mapping        94
Virus Checkers        15
Void a Record        51, 60
Void Import Session        96

- W -

Warnings        56, 90
WIKI        13
WIKI Download Site        18
Windows Operating Systems        8
Work With My Tax Forms        51, 60

- X -

XLS Data Shells        84
XML Data, Review in Excel        49, 102
XML Envelope        103
XML Failed Schema        109
XML File Wizard        53, 100
XML Filing        99
XML Filing Upload Status        109
XML Overview        99
XML Record Limits        101
XML Reset/Void        105
XML Session Window        99
XML Special Characters        53, 100